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1. Introduction 
 
It is not easy to dimension and protect electrical equipment in a correct and at the same time optimum manner. 
This is because it is necessary every time to harmonise a number of requirements, lead in the first place by the 
need to ensure the safety of the equipment which is operated in the best manner possible and simultaneously to 
ensure the overall efficiency of its design. Both of these points of view are in principle contradictory.  The 
equipment and supply lines must not endanger our environment and on the other hand, financial requirements, 
even under the most adverse operating and fault conditions. The safety of electrical equipment is governed by 
electrical regulations which prescribe that the device must not become excessively hot on overload, the voltage 
drops on supply must not exceed the permissible limit under any operating conditions, protection of automatic 
disconnection from source must respond in a sufficiently short time in the event of failure and so on. From the list 
specified above, it may appear that safety requirements will be met provided the equipment and the supply lines 
are dimensioned sufficiently. A fault generates significant short-circuit currents which the devices must withstand in 
all their parts.  
  
We should also not omit the aspect of reliability of operation. A fault caused by one part of the equipment must not 
lead to the entire facility being out of operation. Instead, the protective device should disconnect the respective 
failed part only. Even though the aspect of selective rating as described above is mentioned directly in several 
standards, in practice this issue is unfortunately not given adequate attention in many cases. Various requirements 
can be met through correct selection of equipment, lines and protective devices. A wide range of these is currently 
available and one must take into account their properties when selecting them. 

1.1 Why is it good to use computers for dimensioning and protection? 
 
First of all, the primary aim should not be to only mechanise and automate the designer’s work with electrical 
equipment, circuits and installations. Designing cannot and must not be distorted simply to some series production 
of designs. Before starting to process a project itself at all, the designer must determine a number of figures, values 
and parameters. He/she must know what must be supplied with what power, under what conditions and all the 
situations that certain electrical equipment must withstand during operation etc. On the other hand, there is a range 
of routine tasks included in or associated with designing. These tasks include correct dimensioning of the line and 
correct selection of the protective device when the line as well as the protective device must be verified from many 
different aspects. In some cases, the designer must perform a variety of tasks several times. For instance, if he/she 
receives an incorrect cross-section due to voltage drop, which is verification that should be performed as one of the 
very last checks, he/she should review the previous design verifications from all aspects once again.  
 
The designer must know what the computer is in fact doing and why it is doing it. He/she must be aware of the fact 
that a computer can be a useful aid, but all important decisions must be made by the designer himself/herself. 

1.2 xSpider software - what is it intended for? 
 
xSpider software is intended for design of low-voltage installations and their protection in TN, TT and IT systems, 
the rated voltage of which can be selected from the range of typical voltages or entered manually for any different 
voltage up to 1,000V. The preferred programme feature is the possibility to design circular (ringed) and mesh 
networks. The programme will allow fast verification of the proposed network arrangement and optimisation of 
various network configurations. 
 
When sizing low voltage networks with the aid of computers, we work with two types of components in general: 

 Inserted components, i.e. introduced components, the parameters of which are given and cannot be 
configured within the programme (power sources, transformers, loads, motors, compensation condensers); 

 User-defined components, i.e. such components, the parameters of which are subject to investigation and 
optimisation (lines - cables, busbar systems; protective devices - circuit breakers, fuses). 

 
In the following description we will deal with dimensioning of user-defined components. 
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1.3 How to proceed when designing a low-voltage network 
 
The process of designing a low-voltage network in the particular steps described in the following chapters is only a 
recommendation and the designer can select the sequence of the individual steps himself/herself. Typically, he/she 
designs the distribution as a whole and then at a later point in time it is discovered that something must be added 
still. What has once been designed or already installed cannot be changed anymore. As a matter of fact, the option 
of including additional electrical equipment during the facility’s service life according to the electrical regulations 
should be counted on and this is also quite common in practice. Another similar situation occurs when changing the 
power supply for a certain equipment part. Part of the equipment is disconnected in emergency mode, for instance, 
and the remaining parts of the installation are supplied from a backup supply. In such case, the designer works with 
preset line parameters and carries out only the appropriate checks and adjustments. The ideal case occurs when 
the entire electrical distribution is designed at once and this is the focus of this user manual. 
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2. Network behaviour in operating state and under overload 

2.1 Line current IB, rated current of the protective device In 
 
The designer determines the highest current in the line to the known equipment of the consumption point (building, 
facility, workshop, plant), which must be supplied to this point in order to ensure operation of the electrical 
equipment. But it is not a simple sum of rated currents of all devices. It is the maximum current of all devices which 
are believed to be operated simultaneously. So it is not the maximum, but the used output performance. In the 
case of power supply of devices of the same character, the sum of rated currents is multiplied by the simultaneous 
factor and utilisation factor.  
 

 simultaneous factor (Ks) is the ratio between the number of devices in operation, and the total number of 
devices;  

 utilisation factor (Ku) expresses the percentage at which the device is used).  
 
The utilisation factor (Ku) is always taken into account; the simultaneous factor (Ks) is taken into account in radial 
networks. Here, it is necessary to point out certain pitfalls present when assessing the used (actual) and installed 
power since prudent procedure is required. For instance, when the user enters the currents of all powered loads, 
we will use the sum of these currents for calculations. This method, however, is incorrect. If someone entered one 
socket outlet as one load, he would obtain the design current of IB = 10×16 = 160 A for one socket circuit with ten 
sockets, which is false of course. In reality, he must already insert the above-mentioned restriction in its task and 
determine the factor (for example, Ks = 0.1 requires the 16 A circuit-breaker). 
 
The xSpider application offers a very useful option of disconnection of individual loads. This allows you to model 
real conditions during operation of electrical equipment and consider in particular heavier loads. Complex 
connections are optimised by means of operation states manager, which is able to model all possible 
combinations of the switched on and switched off devices and save these combinations for future use. On the basis 
of information on loads, the designer obtains the highest current in the line, which is called design current IB. For 
this current, the designer selects the rated current of the protective device In. Its value must always be greater 
than the design current IB. The following must therefore apply: 
 

IB  In 
 
where: IB ..... design current (current for which the circuit is designed) [A] 
  In ..... rated current of the protective device [A] 
 
The condition stipulated above results from the requirement to avoid switching off by the protective device during 
normal functioning of the equipment. 
 
At this moment, the designer will not reflect too much on other features of the protective device. He/she will only 
determine its rated size. This is nowadays identical for circuit-breakers and fuses and can be selected from the 
series of 2; 4; 6; 10; 16; 20; 25; 32; 40; 50; 63; 80; 100; 125; 160; 200; 225; 250; 315; 400; 630 A etc.  (Only the 
rated values of 12A or 35A for fuses and 13A for circuit-breakers are different). 

2.2 Line dimensioning  
 
The magnitude of the design current IB and subsequently the magnitude of the rated current In for the protective 
device also imply the admissible current load Iz. The following condition must be met: 
 

In  Iz 
 
where: In  .... rated current of the protective device [A] 
  Iz  ..... admissible continuous line current load (continuous current carrying capacity) [A] 
 
In addition, the requirement must be satisfied that the line may not be overloaded under either abnormal equipment 
operation or its overloading; otherwise the line must be disconnected from the power supply. Therefore, the 
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permissible line current load must be not only greater than the rated current of the protective device, but the 
protective device must provide tripping even during short-term overload with high currents, which could heat-up the 
line above the permissible limit. However, at the same time it is required of the protective device that it not switch 
off in case of overcurrents, which may occur on a short-term basis during operation. This also implies assignment 
of line characteristics (the maximum admissible load), protection and equipment (load required for equipment 
functioning) as shown in the figure below. 
 
 

  
 
 

Overload protection - principle 
 

 
 

Overload protection – parameters: 
 

In …. Rated operational current of the protective device; for adjustable protective devices In corresponds 
to the value set 

I2 …. Tripping current - the current which causes tripping of protective device under the conditions 
specified in the equipment regulations 

IB …. Anticipated operating current of the circuit 
IZ …. Current carrying capacity of conductor or cable 

 

Magnitude of current  I  

t 
 

Passage 
time of 

current I 

Time/current characteristic of the maximum 
admissible load of the protected equipment - 
current carrying capacity of a conductor (I

z
). 

Time/current characteristic of 
the protective device (I2).  

Time/current characteristic of the 
minimum load required for proper 
functioning of the equipment. 
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Similarly to the case of protection assigned to the design current, the idea of allocating the same or higher value for 
the conductor or cable permitted constant current to the rated current of the protective device suggests itself here. 
So why cannot we simply take a conductor or a cable with the most favourable price for us, the permissible 
constant line current load Iz of which is immediately next higher to the rated current of the protective device In? The 
manufacturers indicate the rated currents of the cables. Why this is not so simple was indicated above and is more 
fully explained in the text below.  

2.2.1 Heat generation in the conductor 
 
Heat is generated when electric current passes through the conductor. If such generated heat was not carried 
away to the ambient environment, the conductor would heat up until it melts down. Only then would the passage of 
the current be interrupted. After the passage of any current lower than the one leading to the conductor melting 
down, the temperature settles down at a certain value in the end. Nevertheless, the higher the conductor 
temperature, the more heat is transmitted by the conductor to its ambient environment. The heat generated by the 
passage of current in the conductor is proportional to the conductor’s resistance and increases with the square of 
the current. In addition to this, it must be kept in mind that the conductor’s resistance increases with rising 
temperature, which leads to even higher heat output exceeding the value corresponding to its square (2.492 
precisely).  
 
 

                                                
 

                                                                                                            
 
 
 

2.2.2 Steady conductor temperature and maximum temperatures allowed  
         during operation and overload 
 
When a steady temperature is reached, there is a balance between the heat generated in the conductor by the 
passing current and the heat transmitted by this conductor into its ambient environment. The more obstacles there 
are for the heat to be transmitted into the ambient environment (insulation, installation method, …), the less current 
is needed to heat it up to a steady temperature. The highest core temperature allowed is thus determined by the 
insulation used for cable sheathing. A slightly higher temperature of the conductor core is allowed for overloading 
and short circuit since these overcurrents are presumed to be interrupted by the protective device in a sufficiently 
short period of time. The maximum allowed temperatures for standard operation and overload situation are 
different for various insulation types. For common PVC insulation, the maximum temperature allowed is 70°C 
during standard operation, 120°C in case of overload and 160°C in case of short circuit. For bare aluminium and 
copper conductor (Al, Cu), these temperatures are 80°C, 180°C and 300°C, respectively. 

2.2.3 Maximum currents allowed - what do they depend on? 
 
The magnitude of the currents allowed is determined by the maximum temperature of the conductor on the one 
hand and by the ambient temperature of the environment, to which the heat is transmitted, on the other. The crucial 
factor is the difference between the maximum temperature allowed for the conductor (whether the operating or the 
overload temperature) and the ambient temperature. Therefore, the lines can be stressed more at lower ambient 
temperatures than at their basic temperature and, conversely, less stressed at higher ambient temperatures. 

Temperature 
rise 

Distance from the 
cable centre 

Current carrying core 
of the conductor 

Conductor 
insulation 

Power loss flowing 
from the conductor 
core to the ambient 
environment  

Distance from the cable centre, in which 
the ambient temperature is not significantly 
increased due to the current influence 
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Another important property which has an impact on the conductor’s current load will be shown in an example. The 
rated current of a copper single-core cable with PVC insulation with a cross-section of 0.35 mm2 is 10.5A. We 
would expect the rated current of the same copper conductor having a cross-section of 35 mm2, i.e. a hundred 
times larger, to be also a hundred times higher, i.e. approximately 1,000A. However, this is by far not the case. The 
rated current of a copper conductor with PVC insulation with a cross-section of 35 mm2 is only 181A. Why so little? 
The load can rise only up to such an extent as that in which heat transmission is increased from the conductor into 
the ambient environment. However, the heat transmitted to the ambient environment did not increase 
proportionately to the cross-section, but proportionately to the conductor surface. Thus, if we take into account the 
core cross-sections, the surface did not increase 100 times as the cross-section did, but only 10 times. This implies 
that the allowed current should be 105 A. The fact that the actual rated current is higher results from several other 
factors, which were not taken into account in our estimate (insulation thickness etc.). In this case, we have shown 
that the better heat transmission of the conductor into its ambient environment, the higher possible load of the 
conductor. It is therefore possible in general to apply a higher load per cross-section unit on conductors with small 
cross-section than on large-cross-section conductors. Load-carrying capacity decreases in a similar manner for 
bundled conductors. Simply put (and with the appropriate margin), the load-carrying capacity will not increase 
proportionately to the number of conductors in the bundle, but proportionately to the square root of this number. 
 
It must be constantly kept in mind that the current loads of lines cannot be generally compared to the rated current-
carrying capacity - rated current. This is because the rated current-carrying capacity of a conductor or cable is 
determined by its manufacturer for rated (standard) conditions, which include:  
 

 for installation in air (basic installation method) - the rated air temperature (30°C) and installation in 
horizontal position in still air;  

 for installation in ground - rated ground temperature (20°C) and the determined thermal resistance of 
ambient ground.  

 
The actual conditions usually differ from the rated ones. In addition to the basic installation, conductors and cables 
can be (and typically are) designed for various other methods of installation and a recalculation must be carried out 
depending on the actual situation. 
 
The following basic methods of installation are distinguished according to IEC/HD 60364-5-52 ed. 2: 
 

A Insulated conductors or multi-core cables in conduit 
placed in a thermally insulated wall, or 
multi-core cables directly in a thermally insulated 
wall  

B Insulated conductors or multi-core cables in conduit 
on a wooden wall 

 
C Cable on a wooden wall 

 
D Cable either directly in the soil or in ducts in the 

ground 

 
E  Two-core or three-core cables in air 

     
F Single-core cables grouped tightly in air 
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G Single-core cables in air, spaced, cable to cable 
clearance equal at least to the cable diameter 

 
 
The standard also distinguishes modifications of these methods of installation of cables.  The difference between 
installation method A1 and A2 and between B1 and B2 lies in the fact that A1 and B1 concern insulated conductors 
or single-core cables in pipe, while A2 and B2 concern multi-core cables in pipe.  
 
Note: The previously used installation methods H, J, K, L etc., which distinguished between perforated and 
unperforated cable trays, installation on hooks, ladders or racks, are now included under the E, F or G methods of 
installation. 
 
Besides that, the ambient temperature need not always comply with values taken into account according to the 
standard. In most cases, the 30°C ambient air temperature and 20°C ambient ground temperature are usually 
sufficient. The ambient temperature typically ranges below these values. If, for instance, the ambient air 
temperature does not exceed e.g. 25°C and you calculate with the temperature of 30°C, this means you have a 
certain reserve in the line loading. At the same time, it is not presumed that anyone would apply a load to the line 
depending on changes in the ambient temperatures (such as day - night, or summer - winter). The design 
considers maximum ambient temperature and the load of the line is calculated for this maximum temperature. 
Small short-term temperature fluctuations are not taken into account. If the maximum temperatures differ from the 
specified values over the long term, whether in the upward or downward direction, these different temperatures 
must be taken into consideration. 
 
In the case of installation method in the ground (D), the specific thermal resistance of the soil, taking into account 
the heat dissipation from the conductor to the surrounding environment, is applied. A great role here is played by 
the type of soil (material) and moisture. Depending on the soil conditions, the coefficient of soil resistance is 
determined. The following table shows a typical soil specific heat resistance for different materials: 
 

Specific thermal resistance of soil 
[K.m/W]  

Installation conditions 

 
0,40  immersion in water 

0,50  very damp soil 

0,70  wet soil, clay, limestone 

0,85  drier soil, clay, limestone 

1,00  dry soil, clay, limestone 

1,20    

1,50  very dry soil, sand, ash, cinder 

2,00    

2,50    

3,00    
 
Line loading also depends on the grouping of conductors and cables. Several conductors in the bundle reduce 
the allowed load. Cables can be grouped together in different ways. Therefore, a number of various alternatives 
arise in connection with the installation possibilities. For practical reasons, the programme allows you to solve only 
basic situations described in IEC, HD (Harmonisation documents) or EN (European standards). However, it is also 
a very useful tool in those cases which are not specifically stated in the standard, because it is possible to find a 
close alternative and, on its basis, estimate the situation we need to solve (see Chap. 2.2.4).  

2.2.4 Practical note regarding entering values in the xSpider application 
 
The programme addresses only situations described in IEC/HD 60364 5-52. It is not anticipated, for instance, that 
lines with a cross-section exceeding 120 mm2 would be placed in conduits and cable trunkings. Most of the time, 
however, it pays off to lay two or even more cables parallel for such high currents than just one cable with an 
enormous cross-section, which is allowed in xSpider. All other effects that are not described can be taken into 
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account by means of the user coefficient, through which it is possible to reduce or increase the final cable current-
carrying capacity in any way. The use of this coefficient is the sole responsibility of the user. 

2.3 Determination and verification of protective devices 
 
Both circuit breakers and fuses can be used to protect electric lines. At present, circuit breakers are used to protect 
lines with a small cross-section up to 10 mm2, namely circuit breakers with types B, C or D line characteristics (see 
Chapter 5), as the case may be, due to the possibility of easy reconnection. Fuses are typically used at the line 
entry into a building. Circuit breakers as well as fuses are used for cross-sections of 16 mm2 and 25 mm2, and 
fuses with gG characteristics usually protect larger cross-section lines. Those circuit breakers can be used for high 
admissible currents, for which it is possible to set the rated current as well as the release currents and 
disconnection times in the particular characteristic sections. In this manner, it is possible to adjust the circuit 
breakers so that their characteristics correspond optimally to the characteristics of the protected line. 
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1) These circuit-breakers are called miniature circuit breakers (MCB, according to IEC/EN 60898, see Chap. 5.2) or 
installation circuit breakers. They have a thermal trigger that causes tripping of small overcurrents in case of 
overload, identical for all types characteristics. They differ in setting of the instantaneous (short-circuit, 
electromagnetic) release, which ensures disconnection of high overcurrents - short circuits. This release operates 
only for currents above a certain size. For circuit breakers with characteristics: 

- type B - for currents exceeding the nominal current more than 3 to 5 times,  
- type C - for currents exceeding the nominal current more than 5 to 10 times, 
- type D - for currents exceeding the nominal current more than 10 to 20 times. 

 
Circuit breakers are designed according to the IEC/EN 60947-2 standard: Circuit-breakers. Modern types with 
thermomagnetic or electronic releases have the option of setting various parameters in both overload and short-
circuit currents. With one type of circuit breaker and with appropriate setting of parameters it is possible to ensure 
the protection of various types of installations and equipment. This is certainly a benefit. On the other hand, 
however, there is a risk that a circuit breaker with incorrect settings will not perform a protective function.   
 
The principle of proper allocation of the protective device to line is based on the fact that the line has to be loaded 
by its design current IB and the rated current of the protective device In must be greater than or at least equal to the 

design current IB (i.e. IB  In). Compliance with this condition does not however guarantee proper allocation of the 

protective device to the line. Not even satisfaction of the condition In  Iz can guarantee that. This is because the 
rated current of the protective device, without knowing the tripping characteristics, does not tell us anything about 
its capability to protect the line properly. The current which ensures that the protective device is disconnected can 

Tripping characteristics of gG fuses 
 

Tripping characteristics of circuit breakers; 
B, C, D type 1) 

Int = 1.13 In 

It   = 1.45 In 
o = 30°C 
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be 20 percent higher than its rated current, but it might as well (in case of older types of circuit breakers) be 80 
percent higher. In the former case, it is quite certain that the line will not be heated over the admissible overload 
temperature while in the latter case, this inadmissible line heating will occur for certain one day (cables with PVC 
insulation can be heated up to 200 °C). This leads to serious consequences (overheating, fire). Apart from this 
finding, whether the protective device trips at all, we need to know when it trips. There is a maximum admissible 
operating temperature and a maximum admissible overload temperature for every conductor. However, in order for 
this conductor to not reach this temperature, the overcurrent must be tripped in time by a protective device. 
Required verification can be performed using the xSpider application.  
 

 
 

Tripping characteristics of power circuit breakers (MCCBs, ACBs) allowing the releases to be adjusted (see also 
catalogues for MCCB or ACB circuit breakers). 

 
 
The first figure shows the heating characteristics of the line (i.e. dependencies of temperature on time) at 
overcurrents from 1.4; 1.5; 1.6; 1.7; 1.8 times the rated current. The times, during which disconnection should 
occur under the respective overcurrent values without exceeding the temperature of 100 °C under overload, were 
deducted from these characteristics. The dependency of these times on the cable current (indicated in multiples of 
its rated current) is plotted below (on the second figure). Under the specified currents, the protective device should 
disconnect no later than within these periods of time. 
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L – Long time delay  
  (overload protection) 
S – Short time delay 
  (setting of selective coordination) 
I – Instantaneous 
  (setting of protection against short circuit current) 
G – Ground fault protection 
  (sensitive protection in case of asymmetrical faults, 

fire protection); 
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Examples of graphical outputs from xSpider (module of Tripping Characteristics) 

 
Note: the thin line in the time - current characteristic indicates the threshold, at which the conductor core or cable 
core will be heated to the admissible overload temperature. If the heating characteristic of the circuit-breaker is 
located to the right of the tripping characteristic of the circuit-breaker, the circuit breaker will trip before the cable 
gets overheated. 
 
The procedure described above is more complicated than the one indicated in the technical standards (e.g. IEC 
60364-4-43:2003). This standard provides a simple rule that the current that secures effective operation of the 
protective device within the agreed time must be smaller than or equal to 145% of the current load allowed for a 
protected line. The term agreed time means either one hour for rated currents (up to 63A) or two hours for rated 
current values over 63A. By this time a small circuit breaker must trip 1.45 times its rated current. Consequently, 
the allocation itself of these miniature circuit breakers to lines is very easy. The allowed load of the line must be 
higher than the rated current of the circuit-breakers.  
 
In case of fuses, this assignment is less unambiguous. For common fuse cartridges, the blowing current within the 
agreed time (typically one hour, but also 2, 3 and 4 hours) corresponds to the multiple of 1.6 of its rated current. 

Time – current 
cable 
characteristic for 
maximal 
permissible 
temperature 

Cable protection 
against overload is 
ensured for all 
currents  

Course of the ideal line 
characteristics (relative 
values used for general 
representation). 
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The allocation of a line cross-section to the rated current of the fuse is then carried out in such a manner that the 
allowed line current load must be higher than approximately 110 % of the fuse cartridge rated current 
(1.6/1.45 = 1.103). Expressed mathematically: 
 

I2  1.45  Iz 
 

where: I2 …. current ensuring effective operation of the protective device within the agreed period of time [A]  
             Iz …. current load allowed for the protected line [A]  
 
 The following applies for miniature circuit breakers (MCBs):   
 

I2 = 1.45  In 
 
 where: In  ..........  rated l current of the circuit breaker [A], then: 
 

1.45  In     1.45  Iz 
 

this implies that In    Iz and, thus, that the allowed cable load must be HIGHER than the rated current of the 
circuit breaker.  

 
 The following applies for fuses up to 25 A with gG characteristics:    
 

I2 = 1.6  In 
 
 where: In  .......... rated current of the fuse [A], then: 
 

1.6  In     1.45  Iz 
 

this implies that 1.1  In    Iz and, thus, that the allowed cable load must be greater than 110% of the fuse 
rated current.  

 
xSpider automatically performs a check according to these formulas that apply only to a certain number, although 
the majority, of cases. But the standard is based on some simplifications. The first of them is the anticipated 
ambient temperature at which the line is loaded with its maximum operating current; the second one is the 
maximum allowed insulation temperature at overload, and the third one is the anticipated course of line heating that 
should correspond approximately to the characteristic of the protective device (see the previous figures). Therefore, 
the standard itself states that protection pursuant to the standard does not ensure perfect protection under all 
circumstances and need not be the most cost-efficient one in every case. Although protection pursuant to the 
xSpider application does not provide absolutely accurate results either, its final assignment of protective devices 
(checked by comparing cable heating characteristic and protective device tripping characteristic) is not only more 
accurate, but it also allows you to assign the protective devices for significantly different initial conditions than those 
considered in the standard (different ambient temperatures, different maximum insulation temperature allowed). 

2.4 Other devices with which it is necessary to calculate within an electrical system 

2.4.1 Surge Protective Devices (SPDs) 
 
According to IEC/EN 62305-4 ed. 2 the electrical power lines passing through the interface between two lightning 
protection zones (LPZ) are fitted with surge arresters.  
 
Note: According to IEC 60364-5-53:2001/A1:2002 (mod HD 60364-5-534:2008) cl. 534.2.3.6 the installation must 
consider the necessary coordination of SPD in compliance with EN 62305-4. The SPD manufacturers must in their 
documentation provide sufficient information on how to coordinate them.  
 
In most cases, surge protection is exercised in such a way that at the entrance to the building (upstream from the 
electrometer or downstream from the electrometer (in agreement with the electricity distributor) a type 1 surge 
protector is mounted, in switchboards upstream from the electrometer (usually the prescribed distance is more than 
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10 m from type 1 protection) type 2 surge protection  is installed and in the terminal circuits (again, usually more 
than 5-10 meters from type 2 protection) either additional type 2 overvoltage protection or type 3 surge protector is 
installed. 
 
In terms of installing protective devices, it is important that overcurrent protection of type 1 and type 2 are preceded 
by protection (OCPD – Over Current Protective Device). Short circuit resistance of the combination of SPD (surge 
protection) and OCPD, as specified by the SPD manufacturer must be greater than or equal to the maximum short 
circuit current expected at the site of installation of protection. OCPD can be installed both internally (part of SPD) 
and externally to the SPD. If the rated value of interruption of subsequent of current (after SPD action) is 
guaranteed by the SPD manufacturer, this value must be greater than or equal to short circuit current between the 
phase and neutral in the SPD installation site. The cross-sections of the conductors connecting the overcurrent 
protective devices to line conductors (phase conductors) must be calculated to the maximum short circuit current 
(cl. 534.2.4). 
 
The following applies to the connecting conductors, which are the conductors led from the line wire to a surge 
protector and from the surge protector to the main earthing terminal or protective conductor: 
These conductors should be as short as possible (in order to avoid current loops, the total length of the line 
conductor to the overvoltage protection and from the surge protection to the main earthing terminal or protective 
conductor) should not exceed 0.5 meters, but under no circumstances may it exceed 1.0 m. 
 
 

        
 

Conditions for earthing conductors use 
  
If the cross section of the line conductors of the protected circuit is greater than or equal to 4 mm2 of copper (or its 
equivalent, e.g. 6 mm2 Al) the cross section of the earthing conductors of the surge protection devices (SPD) must 
be at least 4 mm2 in copper or if made of another metal, it should be equivalent to such a cross section. If the cross 
section of the line conductors of the protected circuit is less than 4 mm2 in copper, the cross-section of earthing 
conductors of the surge protection devices must not be less than the cross section of the line conductors. If the 
building is protected by a lightning protection system, the surge protection devices (SPDs) of type 1 according to 
IEC/EN 61643-11 require a cross section of 16 mm2 in copper or equivalent (use of a stranded conductor is 
recommended). 
 

Main earthing 
terminal or busbar    
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Division of lightning current in the TN-C network between 4 working wires network. The incoming lightning current 
arrester can be designed to ¼ of the maximum prospective lightning current (IEC/EN 62305-4). 
 
Example: family house, expected Ip=100kA of lightning current, division 100/2=50kA, design of lightning arresters: 
50/4=12.5kA. 

2.4.2 Residual Current Devices (RCDs) 
 
International abbreviations after Residual Current Devices are: 
 

 RCD: residual current device: general term for all types  
 RCCB: residual current device without integral overcurrent protection; according to IEC/EN 61008: Residual 

current devices without overcurrent protection for household and similar uses 
 RCBO: residual current device with overcurrent protection (residual current device + circuit-breaker); 

according to IEC/EN 61009: Residual current devices with integral overcurrent protection for household and 
similar uses 

2.4.2.1 Dimensioning and protection of residual current devices 
 
The rated current In of a residual current device must be at least equal to the current IB used for the line. A residual 
current device without integral overcurrent protection must be preceded by protection with a rated current less than 
the current used in the line, or the current of which providing for disconnection within one hour, respectively within 
two hours, is lower than the rated current of the residual current device. In terms of circuit-breakers for protection of 
household and similar installations (corresponding to the file of IEC/EN 60898, i.e. type B, C or D circuit-breakers), 
this requirement is satisfied if their rated current is less than the rated current of the residual current device. Details 
are given in the product catalogue. 
 
Another requirement is that the residual current device can withstand the short-circuit current in the place of its 
installation, i.e. it must have an adequate switching and breaking capacity. For this reason, unless it is a residual 
current device with overcurrent protection (RCBO), the manufacturer usually indicates a fuse element, which due to 
short-circuit resistance precedes residual current device (e.g. the residual current devices for terminal circuits are 
prescribed to be preceded by a fuse with gG characteristic with the maximum rated current of 63 A). 

 

Earthing system (50 %) 

Direct strike  

Cables, lines 
Metal pipes (50 %) 

External lightning protection 

Lead-in 

Division of lightning current  
(IEC/EN 62305-1, Annex E) 
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2.4.2.2 Selectivity of residual current devices 
 
To achieve selectivity:  
 

1. The rated tripping residual current of the device placed on the side of the source of power supply should be 
at least twice the rated tripping residual current of the device mounted on the load side (the tolerance zone of 
0.5 - 1 I△n). This rule applies to types for qualified operators, with the possibility of setting parameters. 
 

2. The delay of the equipment of a device located on the side of the power supply should exceed the tripping 
time of a devices mounted on the load side for all the fault current values. Total selectivity can be achieved 
for example by using a device with a time lag on the side of the source of power supply (type S residual 
current device), with a rated residual operating current at least 3 times higher than the rated residual 
operating current of the device located on the load side.  

 

 
 

 
 

To be specified by the 
manufacturer of RCD  

Coordination between RCD and OCPD: 

Selectivity of residual 
current devices: 

Tripping characteristics 
and selectivity of residual 
current devices: 



xSpider, User’s manual   
____________________________________________________________________________________________________  

 

 ______________________________________________________________________________________________________________________  
 

 I / 15 

Requirements for safety provided by residual current devices 
 
It is necessary to verify that:  

 If the residual current device is installed in order to ensure protection against electric shock, the maximum 
total tripping time of each device meets the protection requirements, as defined by the IEC/ HD 60364-4-41 
3rd edition; 

 If the residual current device is installed in order to ensure fire protection, that it meets the requirements of 
the relevant standards (IEC/ HD 60364-4-42, etc.). 

 
A residual current device with a sensitivity of 30 mA used for additional protection must be used: 

 for outlets, with a rated current not exceeding 32 A, which are used by inexpert personnel (people 
without electrical qualifications) and are intended for general use (with the exception of outlets used under 
supervision or surveillance of skilled or instructed personnel and special outlets intended for connection of a 
special type of equipment, such as e.g. outlets for office equipment and computer technology or sockets to 
supply power to devices - e.g. refrigerators, unwanted switch-off of which could cause significant damage),  

 for mobile devices designed for outdoor use with a rated current not exceeding 32 A.   
 
If the residual current device serves to provide protection against failure by automatic disconnection (TN, TT or IT), 
it is not usually necessary to check whether automatic disconnection occurs in a sufficiently short time 
corresponding to table 41.1 IEC / mod HD 60364-4-41 3rd edition.  
 
With regards to automatic disconnection in a TN network, it is sufficient if any RCD fulfils the condition that the fault 
current Ip is more than five times the rated tripping current of the residual current device - ie. Ip  5 × I△n, which is an 
easily achievable condition (if we recall that Ip = Uo/Zs). The situation is similar in the case of an IT network, which 
incorporates a protective ground conductor installed together with the phase conductor. General technical 
standards (this is primarily the IEC/HD 60364-4-41 and other standards in the IEC/HD 60364 file) do not prescribe 
that automatic disconnection at fault in the TN must be ensured by a residual current device. So far, there is 
nothing to prevent this automatic disconnection being ensured by components protecting against overcurrent - only 
when the use of these components (circuit-breakers and possibly fuses) does not ensure compliance with the 
above condition Ip = Uo/Zs. Other times, the RCD also serves as an element for protecting against fire caused by 
electric shock, and then it trips earlier, at fault currents lower than overcurrent protection. 
 
In the TT network, automatic fault disconnection requires that the residual current devices are used in virtually all 
cases. Details are given in the chapter 3.7. 
 
In areas with increased fire risk, the standard prescribes the use of a residual current device with a sensitivity of up 
to 300 mA.  This requirement stems from the fact that when electric current passes outside the working current 
circuit, its passage is undesirable and may cause a fire hazard. The places through which it passes, are subject to 
electrical arcing due to leakage currents from broken insulation. Intermittent high temperature arcing is capable of 
causing ignition of nearby combustible materials. The value of undesirably released energy is considered to be 60 
W. This is the energy released by the flow of a current of 260 mA through a combustible environment at a voltage 
of 230 V. Upon occurrence of this leakage, current already commonly trips the affected circuit breakers with current 
I△n = 300 mA. Hence the requirement for the use of residual current device with I△n  300 mA.  
 
This applies for example to: 

 end circuits in TN and TT networks supplying power to areas with a risk of fire of processed or stored 
materials (according to IEC/HD 60364-4-42, resp. IEC/HD 60364-4-42 ed. 2) –  requiring a residual current 
device with s I△n = 300 mA, 

 for socket circuits with a rated current of 32 A at construction sites and demolition sites, a RCD with      
I△n = 500 mA (according to IEC/HD 60364-7-704 ed. 2). 

 
In some cases, the value required for protection against fire risk and is reduced to I△n  100 mA or even 30 mA. 
This applies to overhead heating with thin heating layers according to IEC/HD60364-4-42 ed. 2.  
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Examples of application of residual current devices: 
 

Application of residual current devices  
of the maximum 
rated residual 
current 

as protection against electric shock 
A (Additional protection) at fault - by automatic disconnection from the source of 

power supply - AD (Automatic Disconnection) 
as fire protection - F (Fire Protection) 

I△n [mA]  30  100  300  500 
According to IEC/ 
mod HD  

 

60364-4-41 
Protection against 
electric shock 

A - sockets for inexpert 
personnel  32A; outdoor 
sockets  32A 

AD - can be used for AD next to devices for protection 
against overcurrent (OCPD); must be used for AD, if 
they do not comply with AD OCPD (circuit breakers or 
fuses) 

60364-4-42 
60364-4-41 
Protection against 
heat 

F - overhead heating 
circuits 

 F - TN and TT end 
circuits for areas 
with fire hazards 

 

60364-7-701 
Areas with a bath 
tub or a shower 

A - the entire low-voltage 
installation in a room with 
a bath tub or a shower 

   

60364-7-702 
Swimming pools and 
other tanks 

AD - for fountains A - for 
pools in zone 2 and for the 
lines delimiting the zone 0, 
1, 2 

   

60364-7-704 
Construction and 
demolition sites 

A - Socket circuits  32 A   Socket circuits 
 32 A 

60364-7-705 
Agriculture and 
horticulture 
 
 

A - Socket circuits  32 A Socket circuits 
 32 A 

AD and F - Circuits 
other than socket 
circuits ( 32 A and 
 32 A) 

 

60364-7-706 
Limited conductive 
areas 

A - supply to a mounted 
class II device  

   

60364-7-708 
Mobile home parking 
lot 

Single circuit breaker per 
one socket outlet 

   

60364-7-709 
ports etc. 

Each socket outlet, each 
end circuit to connect a 
houseboat 

   

60364-7-710 
Medical facilities 

 32 A socket circuits - for 
medical facilities: group 1;  
in group 2 for circuits: 
‐ to move the operating 

table,  
‐ supplying X-ray devices, 
‐ to supply power to 

devices over 5 kVA 
‐ for powering devices 

with non-critical 
functions 

   

60364-7-711 
Exhibitions, shows 
and stands 
 
 
 

 32 A socket circuits and 
terminal circuits (except 
for emergency lighting) 

 Power supply 
cables of temporary 
wiring systems 
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60364-7-714 
Outdoor lighting 
installations 

Built-in lighting in phone 
booths, bus stops, etc. 

   

60364-7-717 
Mobile or 
transportable units 

When connected to a fixed 
electrical installation and 
as a complementary 
measure to the electrical 
department and for 
sockets for appliances 
outside the unit 

   

60364-7-721 
Caravans, and 
mobile homes 

A - to be used as a 
supplementary measure 
for AD - see the HD 
60364-4-41 

   

60364-7-722 
Power supply of 
electric vehicles 

Each connection point    

60364-7-740 
Stands in 
amusement parks  

End circuits for lighting, 
sockets  32 A, power 
cord devices  32 A 

 Electrical installation 
of each temporary 
structure 

 

60364-7-753 
Heating cables and 
systems 

Circuits supplying heating 
units 
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3. Network behaviour at short circuits 

3.1 Types of short-circuit faults 
 

If two conductors with different voltage are connected, we call it short circuit. Therefore, a network short circuit 
means a transient electromagnetic process, which is caused by a sudden decrease in impedance between phase 
conductors, or between the phase and the neutral (central) or the protective conductor, as the case may be. The 
faulty conductive connection can be caused by improper handling, mechanical damage to the insulation, damage 
to the cable during earth work etc., its natural deterioration e.g. due to humidity, or it can be the result of increased 
stress to which it is exposed during switching processes. A short circuit causing a decrease of impedance leads 
immediately to an increase of the current to a multiple of the usual operating current, the value of which depends 
on voltage and impedance. The values of the short-circuit current range within thousands and tens of thousands of 
amperes and its dynamic (power) and thermal impacts jeopardise all wiring components and components in the 
electrification network through which it flows. 
 
Depending on the mode of loading of particular conductors of the three-phase system at short circuits (or its 
supply, as the case may be), we distinguish between symmetric or balanced short circuits (three-phase, or three-
phase short circuit to earth), and asymmetric short circuits (two-phase, two-phase short circuit to earth, single-
phase), as indicated in the figures. 
 

                 
 
3-phase symmetric    2-phase asymmetric       2-phase ground circuit      1-phase ground circuit 
short circuit  short-circuit   
 
 
The 3-phase symmetric short circuit leading to the highest short-circuit current is of great importance from the 
point of view of electric network dimensioning according to IEC standards. The 1-phase short circuit to earth is 
the opposite example. It has large impedance in the fault current loop where the fault disconnection time can be 
considerably long due to the small short-circuit current and dangerous voltage is found on the exposed conductive 
parts throughout this time. 

3.2 Short-circuit current flow 
 

A sudden impedance change in the event of a short circuit leads to a transient process. Due to the high current, the 
balance between the magnetic and the electric field is disrupted in the electrification system area and the system 
comes to a new balanced state through transient current and voltage components. The short-circuit waveform 
depends on the moment when the short-circuit fault occurs. This flow curve can show a certain asymmetry in 
relation to the time axis with the presence of a direct-current component. The short-circuit current is shown in the 
following figure. 
 
The following characteristic values marked with the symbols below are used with short-circuit current for 
dimensioning of electrical equipment and settings of protective devices. 
 

Ik’’ Initial impulse short-circuit current: i.e. the r.m.s. value of symmetrical short-circuit current 
without the direct-current component at the time of short-circuit formation.  

ip Peak short-circuit current: i.e. the first amplitude (peak value) of the asymmetric short-circuit 
current with the direct-current component. This is the crucial criterion monitored when checking the 
dynamic stress of network equipment.  
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Ike Thermal equivalent short-circuit current: i.e. the r.m.s. value equivalent or imaginary symmetric 
(balanced) short-circuit current value, which results in the same heat effects after the tk period of the 
short-circuit duration as the actual asymmetric short-circuit current with the direct-current 
component. It serves as a criterion to assess the thermal load of the electrification network 
equipment. 

Ik Steady-state short-circuit current: i.e. the effective (symmetric) short-circuit current value after all 
the transient components disappear. With electrically remote short-circuits (the majority of cases in 
practice), it is equal to the initial impulse short-circuit current Ik’’. With electrically near short circuits, 
i.e. in circuits near the power supplies with large synchronous generators, it applies that Ik < Ik’’ due 
to the increasing internal reactance of the synchronous machine throughout the short-circuit 
duration. 

 
 
 
 
 
 
 
 
 
 
 
 

  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3 Network configuration 
 
In practice we encounter various network configurations, which place various demands on the computational 
methods. In general, we distinguish between the following network types: 
 

 
 
           Power supply lines from one side 
 

(ia) 

Current  [A] 
Top envelope (max values) 

Bottom envelope 

DC component of short-circuit current *) 

*) The final magnitude of the DC component is dependent on the X/R  ratio of 
network and also on the exact moment, when the short-circuit current is created.  

Time [s] 

Ik =  Ik“ = Icw     (r.m.s. values) 



 xSpider, User’s manual 
 __________________________________________________________________________________________________ 
 

 ______________________________________________________________________________________________________________________  
 

 I / 20 

             
 
             radial network                              circular network               meshed network (with multiple nodes) 
 
Whereas more simple computational methods and computational means (such as nomograms) are sufficient for 
the networks supplied from one side or for radial networks, we must use a computer to solve the meshed network 
efficiently. The advantage of xSpider lies in the possibility to perform calculations in meshed networks with general 
(virtually arbitrary) definition of power supplies, lines and loads. 

3.4 Short-circuit current calculation 
 
The calculation of conditions prevailing at short circuits in three-phase systems are regulated mainly by the IEC 
60909 standard. The calculation can be performed with relative (percentage) impedance values or with the actual 
values. The calculation using the actual impedance values proceeds as follows: 
 

1. At first you depict the network, in which the short-circuit conditions are to be determined, through the so-
called initial diagram showing all operating states. 

2. Mark the locations, in which the short-circuit conditions are to be calculated. 
3. Determine (calculate) the impedances for the individual system components. Then relate the impedances of 

the individual system components to the reference voltage, typically corresponding to the rated voltage at the 
short-circuit point. A uniform reference voltage is selected for the entire system. 

4. The positive-phase sequence impedance must be determined in order to be able to calculate the symmetric 
(three-phase) short circuits. In order to calculate the asymmetric (two-phase, single phase) short circuits you 
also need to know the negative-phase sequence impedance and the zero-phase sequence impedance for 
the electrification system components. 

5. Set up a substitution diagram for the positive-phase, negative-phase and zero-phase sequence systems. 
6. Determine the final short-circuit impedance in the given short-circuit point - by the application of 

computational methods for more simple network configurations through gradual simplification, and by means 
of a computer in case of more complex network with a higher number of nodes. 

7. Calculate the short-circuit current, being the current of the equivalent voltage supply and short-circuit 
impedance. 

  
 

F - Fault point 
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For users who are interested in more details about the computational methods applied in the xSpider software 
algorithms, we specify the following formulas that comply with the requirements of IEC 60909: 
 
Design (calculation) impedance for the:  

 supply part (hatched rectangle): 
QtQtQt jXRZ   is calculated from the short-circuit 

power at the supply node 

 Transformer: 
TTT jXRZ   is calculated from the short-circuit 

voltage and from the transformer 
short-circuit losses 

 Cable line: 
LLL jXRZ   is calculated from catalogue values 

for cable resistance and inductance 
 

Short-circuit impedance:                           kkk jXRZ             

where:  LTQtk RRRR   

                        LTQtk XXXX           

The design impedances are of a complex nature (they include both real and imaginary components) and we apply 
the same calculation rules for them as for complex numbers. 

Absolute value of short-circuit impedance:      22
kkk XRZ   

Initial impulse short-circuit current under a three-phase short circuit:     
k

n
k

Z

Uc
I

3

.''       

whereas 
3

. nUc
 is the phase voltage of the equivalent power supply; c is the voltage coefficient determined 

according to IEC 60909 (its value depends on the voltage of the applied LV, HV or EHV systems): 
 

Rated voltage  Voltage coefficient c 

 cmax cmin 

From 100 V to 1 000 V 1,1 0,95 

 
The cmax factor is used for calculating the maximum short-circuit currents (including all contributions) and the cmin 
factor for calculating the minimum short-circuit currents (taking into account voltage drops).  
 
In the case of 1-phase and 2-phase short circuits, the situation is rather more complicated because you must 
calculate the positive-phase sequence Z(1), negative-phase sequence Z(2) and zero-phase sequence Z(0) 
impedance. 
 

          
 
 
 
 
 
 
 
In practice it applies that Z(1) = Z(2) and therefore the initial impulse short-circuit current under a 1-phase short circuit 
(relevant for calculation of the fault disconnection time from source) is then defined by the relation: 

Definition of the zero-phase 
sequence component of short-
circuit impedance: 
Z(0) = U(0) / I(0) 

Definition of the negative-phase 
sequence component of short-
circuit impedance: 
Z(2) = U(2) / I(2) 

Definition of the positive-phase 
sequence component of short-
circuit impedance: 
Z(1) = U(1) / I(1) 
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The fault loop impedance (for the needs of HD 60364-4-41) can be determined as follows: 
 

Zsv = (2 Z(1) + Z(0)) / 3 
 
Since xSpider calculates the fault disconnection time from source directly, the user does not have to deal with the 
impedance calculation. The calculated impedances Z(0), Z(1) a Zsv can be displayed either as absolute values or as 
complex numbers. 
 
Note: Inspection technicians often require the Zs impedance (or the Zsv impedance according to HD 60364-4-41, as 
the case may be) to be shown in the form of a single number. In spite of a certain inconsistency in the interpretation 
of measurements obtained by means of inspection measuring devices, it is possible to compare such results with 
the calculated Zsv values obtained from xSpider (typically, the inspection measuring devices do not measure 
impedance, but the active loop resistance - see Rschl, which is an acceptable simplification with respect to the 
measurement error). 

3.5 Calculation procedures 
 
xSpider was developed for calculations concerning generally defined networks, including complexly configured 
power networks with a high number of nodes. The network can be analysed under normal operating states as well 
as under short-circuit faults. Calculation is resolved using matrix methods, i.e. by creating an admittance matrix for 
the drawn network configuration and inverting it to the impedance matrix. The impedances obtained in this manner 
are then used in the computational methods specified in IEC 60909 to determine the characteristic values of short-
circuit currents, i.e. the initial impulse current Ik’’, the surge short-circuit current ip (previously Ikm), the breaking 
current Itr and the equivalent heating current Ike. The short-circuit current flow is displayed as calculated using the 
differential equation method. Throughout the calculations, you still work with the fully designed power network 
diagram, in which you can - at any moment during the calculations - build various network configuration modes in 
the graphical form, such as changes in the power sources and loads by connecting or disconnecting certain 
branches etc. 

3.6 Line dimensioning from the short-circuit point of view 
 
Lines (conductors and cables) as well as devices included in the circuit must withstand the maximum short-circuit 
current, which may occur in the lines. This is the current developed due to a short circuit in the beginning of the 
line, which was not loaded before and therefore its minimum electric resistance should be taken into account. Both 
the lines as well as the devices must be checked for these maximum possible short-circuit currents, which vary 
depending on the place within the network where you calculate them. In addition, you must verify whether the 
protective devices are capable of operating even at the smallest short-circuit currents arising in the circuit. Here you 
should realise that: 
 

 the function of the protective devices is activated by the short-circuit current and if the short circuit-current is 
too small, it will not cause the protective device to release, and 

 these “small” short-circuit currents can - in case of its longer duration - also cause damage to the devices, 
conductors, cables and electrical equipment integrated in the short-circuited circuit. 

 
The lines are checked in view of the maximum short-circuit currents. The value of the short-time withstand current 
for the period of 0.1 s, i.e. Icw(0.1 s), is specified for every cable in the xSpider database. This represents the size of 
the short-circuit current which can pass through the cable for the period of 0.1 s without causing the cable to heat 
to a temperature higher than the maximum allowed temperature at short circuit. And why is this value indicated for 
the short-circuit duration of 0.1 s? Because this is the longest period specified in the product regulations for circuit 
breakers (such as IEC/EN 60947-2), during which the circuit breakers must disconnect any short circuits and is 
thus the longest period possible for the passage of the anticipated short-circuit current through the cable. However, 
the short-circuit duration periods are usually shorter. Common circuit breakers disconnect the short circuit 
significantly earlier than in 0.1 s (the miniature circuit breakers within the order of few milliseconds, the power circuit 
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breakers within tens of milliseconds). The aforesaid variable is derived from the assumption that all heat developed 
due to the passage of the short-circuit current is also absorbed by the given conductor, which is then warmed up. 
This will not induce substantial transfer of heat to the surroundings. But in any case, the error arising due to 
negligence of heat transfer into the environment lies on the part of safety. Therefore, the actual current could be 
even slightly higher than the current calculated based on the aforesaid assumption. The programme recalculates 
the actual short-circuit current Ik’’ (initial) to the equivalent heating current flowing through the conductor for 0.1 s 
with Ike(0.1s). This is the current, which would pass through the conductor for the period of 0.1 s and would have 
identical thermal effects as the real short-circuit current passing through the conductor for the period of Ttr (from the 
beginning of the short circuit until disconnection). This current is compared with Icw(0.1s) and must be lower than 

Icw(0.1s), i.e. Ike(0.1s)  Icw(0.1s). The important aspect is that the Icw value for the time of 0.1 s can be easily calculated 
from the conductor material and cross-section.  
 
 
The clause 434.3.2 of HD 60364-4-43 implies the relation: I2 × t  k2 × S2 where I is the effective value of the short-
circuit current (i.e.  Ik), S is the cross-section of the cable core in  [mm2] and k is the coefficient respecting the 
physical properties of the conductor material and conductor temperature at the beginning and at the end of the 
short circuit. This relationship indicates that the product of the square of current and time must be smaller than the 
square of the cross section of cable core S multiplied by coefficient k.  
This reflects the fact that the energy heating the conductive core of the cable of unit length by passing a current for 
the duration of its passage t, which is approximately (/S)×I2t, must be less than the energy that would heat a cable 
core above the allowed limit (usually above the temperature which would damage the cable insulation). This energy 
is proportional to the cross section S, which can be written K × S - and hence ( /S)×I2t  K × S, so I2t  k × S2, 
where you can simply consider k = K /.  
 
If you substitute the value of 0.1 s for the t time in this relation, you obtain Icw(0,1 s). Consequently, this implies the 

inequality: Ik2 × Ttr  Icw(0,1)
2 × 0,1 and hence Ik  Icw(0,1) × 

trT

10,
. 

For a series of cases, i.e. products and equipment (e.g. appliances, switchboard cabinets and the like. The 
manufacturers however directly indicate the value I2 × t.  

This is an integral of the square of the current at the given time interval of 
1

d22
t

to

titI , the so-called Joule 

integral. The Joule integral characterises the energy of electric current which is released by a fuse or circuit-breaker 
(see Chapter 5.4) and may also characterise the energy of an electric current, the passage of which can be 
withstood for a short time by a protective or another component of an electrical installation. 
In this case, we compare this value I2t with the values of conductor material and the difference between the 
temperatures at the beginning and end of a short circuit. Hence, we establish the satisfactory minimum cross 
section S of the wire protected by the given protective component. For the same, from the relevant characteristics 

for the calculated estimated current lk of the given circuit, we establish the value I2t and hence 
k

tI
S

2

 .  

3.7 Dimensioning of protective devices from the short-circuit point of view 
 
In this field, verification is on one hand required from the point of view of the maximum short-circuit currents, i.e. 
whether the protective devices are able to withstand them, and also from the point of view of the minimum short-
circuit currents on the other hand, i.e. whether these devices disconnect them. More detailed information about 
devices is provided in the chapter entitled “Properties of protective devices“ (Part I. Chap. 5). 

3.7.1 Verification in view of the maximum short-circuit currents 
 
Devices, which are included in the circuit where the short circuit occurred must be able to withstand this short 
circuit. As for circuit breakers, it is important on the one hand that they respond to the short-circuit current, and on 
the other hand it is also essential for them to be able to disconnect this short circuit. Therefore, the devices are 
checked for the passage of the short-circuit current. One parameter is usually indicated for MCBs (miniature circuit 
breakers) - the rated breaking capacity Icn (sometimes complemented with operational breaking capacity Ics) two 
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Fault 

TN system 

Exposed conductive part 

breaking capacities are always indicated for power circuit breakers, namely the rated limit breaking capacity Icu and 
the rated operating breaking capacity Ics. It is guaranteed that the circuit breaker can withstand the passage of 
current Icu and that it can safely trip it. Then, however, there is no guarantee that the circuit breaker will comply with 
all requirements as expected. In other words - it is not guaranteed anymore that it will disconnect such current the 
second time. As far as the Ics current is concerned, it is guaranteed that the circuit breaker will not only disconnect 
the current equivalent to Ics, but that it will also remain functional in the future and meet the appropriate parameters 
even after this disconnection. Therefore, it is not necessary to replace it after the short circuit. 

3.7.2 Verification in terms of the minimum short-circuit currents - fault protection  
 
One of the most frequently used methods of protection against indirect contact with exposed conductive parts (or - 
more correctly – fault protection) is protection by automatic disconnection of supply. In the event of a fault 
(insulation breakdown between the live and the exposed conductive part), disconnection of the fault is effected by a 
suitable protective device.  
 
xSpider allows for resolution of protection by automatic disconnection in all typical low-voltage alternating current 
networks i.e. in TN, TT and IT systems. Conditions for protection in TN, TT and IT systems are specified in 
HD 60364-4-41:2007 - Protection against electric shock, and we will mention only the most important information 
here because these facts are generally known. 
 
TN systems are the most frequently used in 
Europe, therefore we will describe their 
properties in more detail. The automatic 
disconnection principle in TN systems consists 
in the short-circuit current arising due to an 
insulation fault, causing the protective device to 
respond and thus to disconnect the failed 
circuit. To make the functioning of this principle 
possible, the accessible conductive parts are 
connected to the earth and to the neutral of the 
supply by means of a PE, i.e. protective 
conductor (see the figure). If the protection is to 
work and the disconnection is to occur in a 
sufficiently short period of time, the fault current 

must be higher than the minimum operating 
current of the protective device. But what does 
it mean “in a sufficiently short period of time”? This means the maximum time, during which a person can safely 
touch an exposed conductive part, which is live during the given fault. It has been determined that the maximum 
voltage on exposed conductive parts is 90V during a fault in correctly earthed TN systems with 230V phase 
voltage, and that humans are able to withstand such voltage without any harm for the period of 0.45s. Therefore, 
the maximum disconnection time of 0.4s is prescribed for socket outlet circuits. For circuits supplying larger and 
fixed equipment with no risk that a person could hold them in their hand, a disconnection time of up to 5s is 
allowed. The permanent touch voltage UL for common areas is 50V. In extremely dangerous areas and in 
specifically defined cases (such as in medical locations), the UL value can be reduced – e.g. to 25V. Sensitive 
residual-current devices with In  30mA are used for disconnection in such situations.  
 
The fault current (i.e. the minimum short-circuit current) in a circuit comprising a power supply, phase conductor to 
the fault point and protective conductor from the fault point to the power supply (in the so-called fault current loop) 
must be higher than the minimum short-circuit current (in HD 60364-4-41 referred to as Ia) that ensures the proper 
function of the protective device within the prescribed period of time. This implies the known condition for fault-
current loop impedance Zs: 

Zs  Uo/Ia  
 
where: Zs  .........  fault-current loop impedance []  
   Uo  ........ phase voltage [V] 
   Ia  ......... current for the operation of the protective device within the prescribed period of time [A] 
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The prescribed disconnection times in TN systems are longer than those in TT systems, where conventional 
protective devices (circuit breakers or fuses) are used for disconnection. For Uo = 230V, this is 0.4s in the case of 
terminal circuits up to 32A inclusive and 5s in the case of distribution circuits and circuits above 32A. 
 
The conditions for automatic disconnection and the minimum short-circuit current in real installations imply that, on 
one hand, impedance is considered at the operating temperatures (i.e. higher than the cold state) and, on the other 
hand, the short-circuit current leads to a decrease in the phase voltage.  
 
In standard installations where the short-circuit current values are significantly higher in case of failure than the 
release setting of protective devices (I”k1p >> Ia), there are no problems with meeting the timely disconnect 
conditions. Complications occur at terminal circuits with greater lead lengths where the relatively high impedance 
value of the short circuit may not provide a sufficiently high short-circuit current for a reliable tripping of the 
protective device. The basic formula for calculating the fault current loop impedance (IEC / HD 60364-4-41 ed. 3) is 
based on the rated mains voltage and the tripping current. But the real situation is somewhat different. In the case 
of a short circuit, the voltage drops and at the same time the increased line resistance must be taken into account 
due to the increased temperature of the line. Both factors reduce the value of the short-circuit current, and in some 
cases it may not be necessary to trip the protective device in the prescribed time. Details are provided in IEC / HD 
60364-4-41 and TR 50480 (IEC 60200-53).  
 
The Spider application allows you to take account these stringent conditions by using a safety factor: 

a) If the influence of the temperature rise from 20 °C to the line operating temperature (based on the basic 
formula) is taken into account, the line resistance increase is 20%; i.e. the safety factor of 1.2 is used. 

b) If the voltage drop is taken into account at 80% of the rated voltage, a factor of 1,25 (100/80) shall be used.    
c) If both coefficients are considered simultaneously (the most unfavourable case), the safety factor is 1.5 (1.2 x 

1.25 = 1.5).  
 

Note: When using the safety factor value of 1.5, the same conditions as those set out in IEC 60364-6 (Low-voltage 
electrical installations - Part 6: Verification) are set.  
 
For the currently edited project, the safety factor can be set using the Information about project function, the 
Calculations tab. The default value for a new project can be set using the Options function in the Calculation tab. 
 
Since the programme calculates the disconnection time directly (under specified conditions), it is not necessary to 
deal with the impedance calculation (for more details see also Part I Chap.3.4. The figures show that the point 
determined by the coordinates of the calculated short-circuit current and the prescribed disconnection times must 
lie – in relation to the fuse or the circuit breaker characteristics – to the right of the right boundary line for the 
tripping characteristics (or above this characteristic, as the case may be). 
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A TT system is characterised by line conductors (L1, L2, L3, 
N) being led from the earthed power supply to the appliance 
(load), but the protection against indirect contact is ensured by 
connecting the exposed conductive parts of appliance to the 
installation earth electrode. If a fault earth current occurs 
(short-circuit between the phase and the appliance’s frame), 
the fault current IF flows through the ground to the power 
source and its strength is determined by the high earth 
resistance of the load (RA) and of the earthed power supply 
(RB). Touch voltage is present on the exposed conductive 
parts throughout the duration of the fault, i.e. until the moment 
of disconnection, but it – in the event of longer duration – may 
not exceed the permanent touch voltage value UL (50, 25 V).  
 
This requirement implies the condition for ensuring such protection if the device responsible for the automatic 
disconnection in a TT system is a residual-current device. At present, residual-current devices are practically the 
only devices that are able to disconnect the fault – insulation breakdown to the exposed conductive part – in 
powerful installations in TT systems. Accordingly, if a residual-current device is used in a TT system for automatic 
disconnection, the following condition must be met for the earth resistance of the load: 
 

 RA  UL /In   
 
where: RA  ........  earthing resistance of the protected load’s earth electrode [],  
  UL  ......... permanent touch voltage limit of 50 V,  
  In   ......... rated residual current of the residual-current device [A]. 
 
In order to achieve disconnection within a sufficiently short period of time, it is required that a significantly higher 
current is taken into account in the above-specified condition instead of I�n. The value of 5 In is indicated as a 
typical value, so the earthing resistance of the load should certainly meet the condition of RA  UL / (5In) when 
calculating this safety increase. 
 
In some situations, particularly in the case of small equipment with small consumption currents, it is possible to 
continue using conventional protective devices, i.e. fuses or circuit breakers. Fuses and circuit breakers are subject 
to a different condition than residual-current devices. Similarly to the condition for automatic disconnection in a TN 
system, this condition is based on the concept of a current loop, which is closed by the fault current when a fault 
occurs (short-circuit between the phase and the appliance’s frame). This fault current must be disconnected in time 
so that the voltage at the exposed conductive parts upon fault, which can be as high as the phase voltage in the TT 
system, is disconnected in time. This condition can be formulated in a similar manner to the known condition for 
automatic disconnection in TN systems: 
 

Zs  Uo/Ia  
 
where: Zs .......... fault-current loop impedance []  
   Uo  ........ phase voltage [V] 
    Ia  ........ current for the operation of the protective device within the prescribed period of time [A] 
 
Apart from the power supply, the conductor up to the fault point, the protective conductor to the exposed 
conductive parts and the earthing lead, the fault current loop in particular includes the earth conductor for the 
electrical installation and the supply earth conductor. In a simplified calculation, it is sufficient to take into account 
the resistance of these earth connections, with a certain reserve. However, the operating current of the protective 
device in a TT system is in principle not the same as the operating current in a TN system. In view of the fact that a 
fault at the exposed conductive parts results in a higher touch voltage than a fault in a TN system, the 
disconnection times prescribed for a TT system are shorter than those for a TN system. For Uo = 230 V, this is 0.2 
s in the case of terminal circuits up to 32 A inclusive and 1s in the case of distribution circuits and circuits above 32 
A. Unlike with the TN systems, on the other hand, the increase in the loop impedance due to the temperature 
increase in the wires (occurring in TN systems) is not taken into account here because the electrical resistance of 
the wires accounts only for a fundamentally negligible part of the resistance in the loop impedance. 
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IT systems are used in situations where the 
maximum safety for the operator and high reliability in 
power supply are required even in the event of a fault 
which would lead to the release of the protective 
device in earthed TN and TT systems. Protection of 
exposed conductive parts is – similarly to TT systems 
– protected by connecting the exposed conductive 
parts of the loads to the earth. A typical feature of an 
IT system is that the protective device is not released 
at the moment of the fault (first fault) to earth 
because the fault current is limited only to leakage 
and capacity currents of the installation. Under these 
circumstances, the system with the first fault can be 
seen as a TN or TT system (depending on the extent 
and design of the earthing of the loads – whether the 
exposed conductive parts of all appliances in the 
system are connected to a common protective 
conductor, or whether they are connected to earth in groups or individually per appliance). If the exposed 
conductive parts are properly connected to earth, no danger of electrical accident arises during the first fault yet 
and, therefore, the faulted circuit is not disconnected upon this first fault; however, a check on the insulation 
condition is prescribed by means of insulation monitoring devices or other devices.  
 
Release of the protective device due to high overcurrent can take place only in the event of a second fault which 
occurred in another phase and usually in a different electrical device. If the exposed conductive parts of loads in 
the system are connected to a common protective conductor, a short-circuit current determined by the fault loop 
impedance flows through the conductors during the second fault.  
 
The aforesaid situation can be seen as a certain analogy to the TN system; however, the difference is that the first 
and the second fault can be – in the most unfavourable case – located at the farthermost, opposite ends of the 
installation. Thus, it is necessary to reckon a double length of the line (see cipher 2 in the denominator). 
 
The following condition must be met for an IT system where the neutral is not distributed: 
 

Zs  U / (2 Ia) 
 
The following condition must be met for an IT system where the neutral is distributed: 
 

Z΄s  U0 / (2 Ia) 
 
where:  Zs  ........  fault loop impedance consisting of the phase conductor and the protective conductor, 
    Z´s  ....... fault loop impedance consisting of the neutral (central) conductor and the protective conductor 
    U0  ....... rated voltage between the phase and the neutral (central) conductor, 
    U  ........ rated voltage between phases, 

   Ia.......... breaking current of the protective device, which disconnects within the specified period of time (for 
230/400V, the disconnection time is 0.4s for a system where neutral is not distributed and 0.8s for 
a system where neutral is distributed. The disconnection times are shorter for extra dangerous 
areas. 

 
In addition to this, due to an increase in the impedance of the conductors at the operating temperature and other 
conditions the 2/3 coefficient applies, similarly to TN systems so under normal circumstances (unless a more 
precise calculation is performed), the following applies: 
 
The following condition must be met for an IT system where the neutral is not distributed: 
 

Zs  U / (3 Ia) 
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The following condition must be met for an IT system where the neutral is distributed: 
 

Z΄s  U0 / (3 Ia) 
 
If the exposed conductive parts of loads in an IT system are connected to earth individually or in groups, the 
following condition applies for automatic disconnection regardless of whether residual-current devices or 
overcurrent protective devices are used for the automatic disconnection: 
 

RA  UL  / Ia  
 
where: RA  ........  earthing resistance of the protected load’s earth electrode, including the resistance of the 

protective conductor to exposed conductive parts [],  
   UL  ........ permanent touch voltage limit [V],  
   Ia  .......... operating current of the overcurrent protective device of the protected equipment [A].  
 
Because of their properties, IT systems are used in heavy-duty facilities requiring non-stop operation (mines, 
metallurgical works, special plants, etc.) where they usually work with 500 V voltage at present. A special type of IT 
systems used in hospitals and medical locations is the isolated medical system (IMS), which you can find in 
particular in operating theatres (voltage 230V). The requirements for IMS are specified in a separate IEC 60364-7-
710 – Electrical installation in medical locations. IMS is quite unique from a certain point of view because special 
isolation transformers are used in order to create the isolated system. These transformers must meet, inter alia, the 
requirements of VDE 0107 applicable to electrical devices in medical locations (their types offered by Eaton are 
included in the database) and are connected to a TN system by primary winding. The input impedance components 
for the isolating transformer (typical transformation ratio 230V / 230V) can easily be obtained directly from the TN 
system in the given connection point. 
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4. Voltage drops and load distribution  

4.1 Allowed voltage drops 
 
Electric current is formed during any consumption from the electric network. The passage of this current leads to 
voltage drops in the respective lines and, thus, the voltage supplied all the way to the load is not equal to the 
voltage on the power source terminals, it is rather lower. Indeed, various voltage drops are prescribed for the 
particular parts of an electrical circuit. For a voltage drop from source up to the supply point, it is possible to derive 

from the specified voltage deviations of  10% from the rated network voltage. This means that in the worst case, 
the total voltage drop from the source up to the supply point may be up to 16%. 
 
Within the electrical installation itself in a building (i.e. inside the facility), it is recommended according to IEC/ HD 
60364-5-52 that the voltage drop between the beginning of the installation and the user’s operating equipment 
should not exceed 4 percent of the installation rated voltage. The maximum voltage drop between the start of the 
installation and any sampling point should not be greater than the values given in the following table (with respect 
to the nominal voltage values in the installation). 
 
Maximum voltage drops: 
 

   Installation type               Lighting          Other uses 
A - installation of low voltage powered directly from the public distribution network  3 %          5 % 
B - low-voltage installation powered by a private low-voltage source a)    6 %           8 % 
 

a)  It is recommended that the voltage drop in the terminal circuits does not exceed, if possible, the values given for 
Type A installations. 
 
The calculations exclude temporary effects such as transient voltages and voltage changes due to abnormal 
operation. 
 
If the main installation line is longer than 100 m, the drops may be increased by 0.005 % for each meter of line over 
100 m, and this additional loss should not be greater than 0.5 %. The voltage drop is determined from the required 
consumption of electrical appliances, using the coefficient of simultaneity (where applicable) or the voltage drop is 
determined from the design currents of the circuits.  
 
Greater voltage drop can be accepted for motors during their start-up and for other devices with high starting 
current, provided that it is ensured that the voltage changes comply with the limits specified by the relevant 
standards for these devices.  
 
More detailed requirements for maximum voltage drop are listed in other standards for installation. For example: 
 
1. From the distribution board behind the electric meter (indoor distribution box) to appliances: 

 for lighting outlets 2 % 

 for boiler and heater outlets (including washing machines) 3 % 

 for sockets and other outlets 5 % 

 
2. Lines between the electric meter distribution box and compact indoor distribution box 

 for lighting and composite consumption 2 % 

 for consumption other than concerning lighting 3 % 

 
When dimensioning lines, higher losses than those described above may arise in some section, but then it is 
forbidden to exceed the values of the total voltage drops in the line from the interconnection switchboard 
cabinet up to the load:  

 for lighting outlets 4 % 

 for boiler and heater outlets (including washing machines) 6 % 

 for sockets and other outlets 8 % 
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As you can see, you can get up to the actual functional limit of some devices and equipment when you add all the 
allowed voltage drops in the distribution network and the electrical installation together. For example, the relays 
and contactors, for instance, must reliably switch from 85 percent of their rated voltage and above, in the case of 
electric motors this is guaranteed from 90 percent of their rated voltage. Therefore, it is essential to follow the 
aforesaid recommendation (drop up to 4 percent) as stipulated in IEC/HD 60364-5-52. 
 
More stringent requirements for voltage drops in industrial distributions are laid down in the national standard e.g.: 

 the voltage drop at the motor load terminals caused by its rated current shall not exceed 5 percent of the 
rated voltage of the installation (i.e. the voltage shall not drop below 95 percent of the rated voltage), 

 the voltage drop at the light source point caused by the design load shall not exceed 3 percent of the rated 
voltage of the installation (i.e. the voltage shall not drop below 97 percent of the rated voltage), 

 the voltage drop at the heating appliance point caused by the design load shall not exceed 5 percent of the 
rated voltage of the installation (i.e. the voltage shall not drop below 95 percent of the rated voltage). 

 
We would like to point out that the requirements of national industrial standards do not usually concern voltage 
drops in a certain part of the line. The regulation concerns the requirement for the possible voltage drop allowed in 
relation to the rated voltage. For instance, transformer terminals may have a voltage equivalent to 110 percent of 
the rated voltage, from which the voltage drops may then be 15 percent and 13 percent, respectively. The designer 
thus has a certain freedom when designing voltage drops in these cases from the source to the appliance.  
 
The xSpider application allows you to set the limit voltage drops for individual nodes and branches of the network. 
Drops are calculated in an operating condition with an increased line temperature (line resistivity is increased by 
20 %, i.e. the hot-condition factor of 1.2).   

4.2 Comments on the voltage drop calculation 
 
It must also be explained how voltage drops are calculated or how they are added together, as the case may be. 
As far as purely active consumptions such as electrical heating appliances and small cross-section lines are 
concerned, the situation is quite simple. Voltage drops are products of line currents and resistances, which can be 
easily added together. As far as loads such as motors are concerned, the nature of consumption of which is active 
and inductive, and as far as impedances of the line Z composed of the real component R (resistance) and the 
imaginary component X (inductance) are concerned, these complex variables are multiplied. The result of this 
multiplication is a complex variable again, i.e. a complex voltage drop. This variable describes the voltage drops in 
the real and the imaginary axis of the coordinates. Therefore, the absolute values of these drops in the particular 
line segments from the power source to the load may not be added together in the ordinary manner, instead they 
must be added together only as complex numbers (i.e. the real and the imaginary components separately). The 
programme user should thus not be surprised that the sums of absolute values of the voltage drops are often not 
an accurate sum of their absolute values in the particular lines linked to each other. The same situation applies to 
the sum of impedances and currents. According to Kirchhoff’s law, the sum of currents in the nodes must be equal 
to zero. However, this may not be the case for the sum of absolute values.  

4.3 Load calculation for the particular network branches 
 
xSpider allows you to also calculate the load in the particular network branches (represented by cables and 
conductors) under various load distribution within the network. In this case, the programme always performs the 
calculation using complex values of currents and impedances. It is not therefore possible - just like in the previous 
case - to simply add the current loads in the particular branches together as an arithmetical sum of all absolute 
current values, but separately for the real and the imaginary components. Provided these rules are observed, you 
can determine the respective load with any network configuration. Similar rules are also respected in calculation of 
short-circuit currents. Even at short circuit, the system calculates with network impedance expressed in a complex 
form.  
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5. Properties of protective devices 

 
In order to ensure that a protective device is used properly in electric circuits, it is necessary to know both the basic 
parameters of the circuit (short-circuit conditions, load type etc.) and also the properties of the protective device 
(type of the tripping characteristic, breaking capacity etc.). Parameters of the protective device, which are 
guaranteed by the manufacturer in the catalogue documentation, determine whether the respective device is 
suitable for use in the given circuit.  At the same time, you need to know which parameter of the protective device 
(such as Icn, Icu, Ics, Icw) can be assigned to which parameter of the short-circuit current (such as Ik’’, ip) in the given 
circuit.  
 
Note: all currents exceeding the rated current in the circuit are called “overcurrent”. The term “overcurrent” includes 
“overload” situations (low overcurrents, several multiples of In) and “short-circuit” situations (large overcurrents).  

5.1 Fuses 
 
Fuses are currently regulated by the IEC/EN 60269 set of standards. Fuses can be classified according to different 
aspects such as design (power fuses - fuse links with blade contact, plug, cylindrical etc. type), type of the tripping 
characteristic (gG/gL:  for general use - for predominant part of applications; aM: for motor circuit protection - only 
for short-circuit protection; gR, aR: for semiconductor protection et al.), according to the current type (AC, DC) or 
rated voltage etc.  The types and designs also vary depending on national practice.  
 
Overload: In the overload field, i.e. at low overcurrents, it is necessary to take into account that the disconnection 
times of fuses will be relatively longer than those of circuit breakers. The definition of the fuse tripping 
characteristics implies for instance that the fuse can disconnect no sooner than after 1 hour when a current of 1.6 In 
passes through, while the agreed breaking currents for circuit breakers are lower. 
 
Short-circuit currents: The most important feature of fuses is the high breaking capacity at short circuit, which 
predetermines fuses - considering their very small size - to be used as the main or the backup protection of circuits 
and devices against short circuits. The rated breaking capacity of fuses is specified as a single number Icn and 
usually ranges from 50 kA up to 120 kA (depending on the fuse type, power factor, voltage etc.). For overcurrents 
starting from approx. 20 In above, you can expect the fuses to show their limiting characteristics when the short-
circuit current is limited before it reaches its maximum value (thus, disconnection must take place within 5 ms at the 
latest with a frequency of 50 Hz).  
 
The limited current (commonly marked Ic) is expressed in the maximum value. A typical course of the limiting 
characteristics is obvious from the figure provided in Chapter 5.4. Two parallel lines are shown in this figure: 

 the bottom line expresses the peak (limited) value of the symmetric short-circuit current (anticipated), 

 the top line expresses the peak (limited) value of the asymmetric short-circuit current, i.e. the most 
unfavourable state.  

The decision on which of the lines should be used, depends on the state of the circuit, which we examine for the 
short circuit. 
 
The value of energy released into the circuit (i.e. the energy lines causing warming) is expressed by the parameter 
I2t (Joule integral). Typical waveforms of these characteristics for fuses and circuit breakers are also shown in 
Chapter 5.4. They are deducted from the restrictive characteristics that are available in the catalogue 
documentation. Limitation of the short-circuit current has a positive impact on the line temperature rise and on the 
reduction of the dynamic load of conductors and switchboards. 
 
Fuse selection criterion in a circuit with known short-circuit conditions: 
 

I1  ≥ Ik“ 
 
Where: I1  ......... rated short-circuit breaking capacity of the fuse 
 Ik“ ......... initial impulse short-circuit current 
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5.2 Circuit-breakers 
 
Depending on the purpose of use, we must take into account two basic regulations for circuit breakers which are 
specified most frequently in the catalogues IEC/EN 60898 and IEC/EN 60947-2.  
 

a) IEC/EN 60898 Circuit breakers for overcurrent protection for household and similar installations  
 
IEC/EN 60898 is intended for circuit breakers used for building installations (also called installation circuit breakers) 
where you can expect their operation by inexpert personnel. Rated currents nowadays range up to 125 A. The 
tripping characteristic is shown in the figure in Chapter 2.3. 
 
Overload due to low overcurrents: Specific limits are determined for low overcurrents, in which the release must 
not respond or must respond to the overload. The agreed non-breaking current (Int) applies for 1.13 In, the agreed 
breaking current (It) is 1.45 In. This means that the circuit breaker must not disconnect in the agreed period of time 
if a current under the value of 1.13 In is passing through, and the circuit breaker must disconnect in the agreed 

period of time if the current exceeds 1.45 In. The agreed period time is either 1 hour (for In  63 A) or 2 hours (for 
In > 63 A). These limits are prescribed in general regardless of the type of the tripping characteristic. The data 
specified above apply for the reference ambient temperature of 30 °C, with the circuit breakers having no 
temperature compensation.  
 
Short-circuit currents: In the field of short-circuit release response, the standard IEC/EN 60898 prescribes a total 
of three types of tripping characteristics with different setting limits - from 3 to 5 In for B type, from 5 to 10 In for C 
type and from 10 to 20 In for D type, respectively. The area of short-circuit release action has a direct impact on the 
correct circuit breaker selection in the circuit in those cases when we want to meet the conditions for fault 
disconnection within the prescribed time. It is also directly related to meeting the condition of the maximum loop 
impedance value in TN system. Thus, in this connection we are solving the problem of ensuring such a loop 
impedance which would guarantee at least the minimum short-circuit current being formed in a fault circuit that 
ensures the response of the short circuit release. Every higher current would then guarantee a fast disconnection 
of the fault circuit within milliseconds. The rated short-circuit breaking capacity (Icn) of the circuit breaker must be 
taken in account in the area of high short-circuit currents. This circuit breaker capacity reaches values of 6, 10, 15, 
20 and 25 kA. If the short-circuit current exceeds the rated breaking capacity of the circuit breaker, the circuit 
breaker will be damaged. One of the options to prevent such a situation is to use an upstream fuse (the fuse value 
is 100 A for FAZ circuit breakers or 200 A for PLHT/AZ circuit breakers). In this case we talk about circuit breaker 
backup protection. The limiting factor present when using an upstream fuse in front of the circuit breaker in order to 
secure backup protection is a certain constraint of the discrimination. Specific values of the maximum selectivity 
current, for which the circuit breaker/fuse combination is still selective, are specified by the circuit breaker 
manufacturers in their catalogues in the form of tables (the table data are verified by measurements). 
 
Selection criterion for installation circuit breakers (MCB) in a circuit with known short-circuit conditions: 
 

Icn  ≥ Ik“  
 
where: Icn ..........  rated short-circuit breaking capacity of the circuit breaker  
   Ik“ .......... initial impulse short-circuit current 
 
Note: Residual current devices with inbuilt overcurrent protection (according to IEC/EN 61009) are used for 
overcurrent protection by means of combined residual current devices with circuit breakers.  

 
b) IEC/EN 60947 Low voltage switchgear and controlgear. Part 2: Circuit-breakers.  

 
Circuit-breakers assessed according to IEC/EN 60947-2 are designed in particular for industrial use and it is 
presumed that these devices will always be operated only by persons with electrical qualifications (qualified 
operator). The standard applies both to line circuit breakers and also to motor circuit breakers for any currents and 
design methods and for any recommended application, and it applies also to circuit breakers with adjustable 
releases. 
 
Overload with low overcurrents: The tripping characteristics is determined by two binding values only, namely 
the value of the conventional non tripping current of 1.05 In and the conventional tripping current of 1.3 In.  The 
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agreed time period is either 1 hour for In  63 A or 2 hours for In > 63 A. Unless provided otherwise, the reference 
ambient temperature is preferably 40 °C. 
 
Short-circuit currents: The standard does not stipulate any limits for adjustment of the short-circuit releases and 
their labelling of tripping characteristics. Therefore, the manufacturer itself can define the labelling and setting for its 
circuit breakers (such the R, S characteristics, etc.). One of the most important properties of circuit breakers is their 
ability to safely disconnect short circuit currents on repeated occasions. Circuit breakers considered according to 
IEC/EN 60947-2 are mostly called “power circuit breakers” and are characterised by several values of breaking 
capacities:  
 

 Rated ultimate short-circuit breaking capacity (Icu) – value of the short-circuit current specified on the circuit 
breaker for the respective rated voltage, which the circuit breaker must safely disconnect. After such 
disconnection, however, its characteristics may change. In other words, disconnection of the short-circuit current 
with the value of I = Icu is guaranteed for one single time only. Although it may seem like technical nonsense at 
first sight to dimension the circuit breakers for the Icu value (one-time disposable circuit breaker?), it has been 
proven in practice that faults do not occur immediately on the output terminals of the circuit breakers and that 
even a relatively small line impedance behind the circuit breaker is sufficient to reduce the short-circuit current 
efficiently under Icu.. 

 Rated service short-circuit breaking capacity (Ics) – value of the short-circuit current specified on the circuit 
breaker for the respective rated voltage. This is expressed by the prospective breaking current (in kA) 
corresponding to one of the values laid down by the standard. It is most frequently expressed in percentage rate 
(25, 50, 75 and 100% Icu) relative to the Icu value, i.e. for a circuit breaker with Ics = 75% Icu and Icu = 100 kA, for 
instance, Ics = 75 kA. Ics must be disconnected by the circuit breakers repeatedly and, therefore, it is a matter for 
the designer alone to decide what extent of long-term operating reliability he/she wants to use for the 
calculations - whether the circuit breakers will be designed with respect to Ics, or to Icu. It also relates to the price 
of the circuit breakers.  

 Rated service short-circuit making capacity (Icm) – value of the short-circuit current specified on the circuit 
breaker for the respective rated voltage, rated frequency and the given power factor. The rated short-circuit 
switching capacity (Icm) is always higher than the rated short-circuit breaking capacity (Icu or Ics, as the case may 
be) and their minimum ratio is prescribed by the regulations to range from 1.5 up to 2.2. 

 
Protection functions of trip units are described by abbreviations (L, S, I, G), and in summary they determine the 
tripping characteristic of the circuit breaker, which defines how fast the circuit breaker will trip the passing current:  
 

L – Long time delay (overload protection); 
S – Short time delay (setting of selective coordination); 
I –  Instantaneous (setting of protection against short circuit current); 
G –  Ground fault protection (sensitive protection in case of asymmetrical faults, fire protection; 
ARMS – Arc Reduction Maintenance System; provides reduction of tripping time of circuit breaker, what 

reduces an incident energy value by approx. 30%. It is used for improved personal protection in 
case of internal arcs in the switchboards (see chap. 8 for details). 

     

 
 

Examples of tripping characteristics of power circuit breakers 
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Selection criteria for power circuit breakers in a circuit with known short-circuit conditions: 
 
a) according to the rated short-circuit breaking capacity of the circuit breaker 
 

Icu  ≥ Ik’’ 
 
where: Icu ..........  rated ultimate short-circuit breaking capacity of the circuit breaker  
   Ik“ .......... initial impulse short-circuit current 

 
Note: In the event of more demanding operating requirements where you need to work with a sufficient reserve of 
parameters, it is possible to dimension the circuit breakers for the Ics parameter (rated service short-circuit breaking 
capacity of the circuit breaker), which is supported by xSpider. 
 
b) according to the rated short-circuit switching capacity of the circuit breaker (exceptionally): 
 

Icm ≥ ip 
 
where: Icm .........  rated short-circuit switching capacity of the circuit breaker 
   ip  .......... peak short-circuit current (before also labelled Ikm) 

 

5.3 Circuit-breakers for the protection of motors  
 
Overload protection of motors requires a special approach and is subject to slightly different rules than protection of 
lines. When designing outlets with motors, it is necessary to distinguish the actual protection of the motor and 
protection of motor cables. The basic parameter of the motor is the rated current In, to which the overload 
protection must be set.  
For a trouble-free start of asynchronous motors, one must take into account their impulse current acting on the 
protections during start-up. Depending on the type of the motor (bipolar, quadrupolar, multipolar), it is also 
necessary set short-circuit releases to prevent power failures. The start-up currents depend on the motor design, 
the latest designs with high efficiency (IE3, IE4, ..) show higher starting currents due to the high reactance, which 
must be already taken into account in the design.  
 
According to the requirements of operation and also with respect to local practice, some of the following protection 
methods are used:   

 fuses: today only for small motors, not used for higher output values; 
 overcurrent relays in combination with type aM fuses: optimum solution also for higher output values, very 

common in the industry; 
 motor starters: the most frequent protection method (PKE product range up to 65 A) 
 circuit-breakers with motor characteristics 
 Frequency converters, soft starters, frequency starters: protection is provided electronically by motor type. 

 
The basic standard for the motor protective devices is IEC/EN 60947-3: Motor starters.  
 
The difference between the line circuit breaker and the motor circuit breaker consists in the waveform of the 
tripping characteristics. Motor starters have a narrower tolerance of tripping characteristics than the line circuit 
breakers. The actual waveform of the tripping characteristic follows the warming curve of the motor to be protected. 
Thereby, in an indirect manner, via controlling the current drawn, the system monitors the expected warming and in 
the event of motor overload, the motor is disconnected from the power supply.  
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5.4 Limiting capacity of protective devices 
 
The oldest protective device is the fuse. Despite its simplicity, it offers high breaking capacity values. This is 
achieved by high speed of disconnection of the short-circuit current, which is a result of melting of the wire inside 
the fuse. This current is not interrupted immediately, but during fractions of a millisecond, the short-circuit current is 
gradually reduced until complete interruption. It is believed that a great advantage of fuses as compared to circuit 
breakers is that they are able to interrupt short-circuit current before this current is fully expanded to its maximum 
value, i.e. to the peak of its first half-wave. This is illustrated in the figure below. For higher rated currents, NZM and 
LZM circuit breakers up to 630 A with limiting properties are available.   
 
 

 
 
 
 
 
 

Form of limited current behind the current limiting 
protective device:  
 

Icc prospective short current (r.m.s.) - if a 
protective device is not used 

 

ip limited current of protective device (peak 
value) 

 

0 point of fault initiation 
 

t0    contact opening time (creation of arc 
between contacts) 

 

t1    current peak (current limitation) 
 

t2   time to total extinction of arc (complete 
shutdown of fault current) 
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Current limiting characteristics of fuses 
 
 
Modern circuit breakers with the feature of limiting the short-circuit current have a similar limitation characteristic as 
fuses. Certain threshold values of short-circuit current result in opening of contacts and the short circuit current is 
interrupted before it reaches its estimated maximum value. This, compared to circuit-breakers of older design with 
longer response times, greatly increased their short-circuit breaking capacity. Limiting of the short-circuit currents 
decreases the mechanical stress between the conductors and significantly reduces the magnitude of the energy of 
the current energy released. This energy is characterised by I2t value (see also chapter 3.6, 5.1 and 5.2). Chapter 
3.6 describes the rules for proper sizing of the electric line (wire, cable, busbar) so that it withstands thermal stress 
of the let-through short-circuit current.   
 

 

 

 

 

 

                                      
 
 
Let-through current characteristics (Ic) display features of current limiting devices. This information plays important 
role for example in case of low voltage switchboard assemblies. In case the peak current (Ic) in the switchboard 
does not exceed value 17kA, it is not necessary to make design verification of short circuit withstand strength 
according to clausula 10.11 of IEC/EN 61439-2.  

 
Current-limiting MCCB with double rotating 
contacts up to 630 A (NZM2,3 and LZM2,3 
with breaking capacity N, H) 

Example of the let-through energy (I2t) 
characteristics of current limiting NZM1 series 

A – B: full value of non 
limited current [A] 
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Example of let-through current characteristic of NZM2 limiting circuit breaker 
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6. Coordination of protective devices  
 
In practice, it is necessary to perform a correct coordination of two protective devices from different points of view. 
In some installations it is necessary to ensure proper selective sequencing and in the case of high short-circuits 
backup protection.  

6.2 Selectivity 
 
The aim of ensuring selectivity is to ensure that a fault or overload is always tripped only by the protective device 
that is the closest to the fault point or the overload site. If you want to maintain coordination (discrimination) 
between two protective devices arranged after each other, their characteristics must not intersect in any point and if 
the characteristics are defined by zones instead of one unambiguous line, these zones must not intersect either.  
 
The xSpider application in version no. 3 offers a very convenient way of viewing tripping characteristics with the 
option of setting parameters and their immediate display. Assessment of selectivity using the characteristics 
provides very good information about the selective graduation for the area of releases for overload and areas of 
action of delayed currents. The area of high short circuit currents that are beyond the limit of instantaneous effects 
of the short-circuit release Ii is subject of an immediately tripping of the circuit breaker due to high short-circuit 
currents in very short times. In this area, the commonly used tripping time - current characteristics do not provide 
adequate information and the assessment of selectivity must be performed according to the values of let-through 
energy (I2t), or preferably using the results of the selectivity tests (see IEC/EN 60947-2, IEC/HD 60364-5-53). For 
this purpose, selectivity tables are available for the most common combinations of protective devices. They include 
assessment of the values of selective current of two devices in series that were measured in a testing laboratory. 
According to the standard requirements for circuit breakers (IEC/EN 60947-2), all measured values apply for the 
maximum setting of releases. It is necessary to keep that in mind, as the displayed values of selective currents are 
not affected by the setpoints of releases in the characteristics display module.  
 
Selectivity tables are available as a separate publication (Selectivity guide) and are also incorporated in the 
xSpider application. They are easily accessible using the Selectivity function.  
 
Before selectivity assessment, it is necessary to know the actual values of expected short-circuit currents in each 
node, including the loads connection points. Only on the basis of these values it is possible to carry out an 
assessment of selectivity for all pairs of upstream and downstream protective devices, this feature of the 
programme provides a comprehensive picture of the design in terms of selectivity.   
A useful feature of the xSpider application is the ability to evaluate the selectivity of two circuit breakers, 
independently of any project. This feature greatly speeds up searching in the selectivity tables.  
 
Selectivity of two fuses: selectivity of two fuses in series connection is generally guaranteed for the ratio of rated 
currents being 1: 1.6, unless stipulated otherwise by the manufacturer. This is subject to identical types of tripping 
characteristics. 
 
Selectivity of two miniature circuit breakers (MCB): for circuit breakers up to 32A, the IEC/EN 60898 standard 
defines three classes of energy limiting during short-circuit for the circuit-breaker types (B and C) and a rated short-
circuit breaking capacity expressed as the maximum value of the product I2t let through by the circuit breaker in the 
event of a short circuit. Most small circuit breakers belong to the third class (limiting class 3, also selectivity class 3) 
and circuit breakers for higher currents are also practically included here (such as PLHT or AZ circuit breakers up 
to 125 A). The advantage of these limiting circuit breakers is the high limitation of the let-through energy 
comparable with fuses and thus also a very low temperature rise in the line at short circuits (only several degrees 
°C or tens of degrees °C in extraordinary cases). Their disadvantage is the impossibility of selective grading of two 
circuit breakers in the same, i.e. the third selectivity class, arranged after each other because limiting circuit 
breakers arranged after each other disconnect at virtually the same speed. But beware of the common mistake that 
the selectivity of two installation circuit breakers can be resolved only by grading the B, C and D type 
characteristics!  
 
The issue of selectivity of two and more power circuit breakers arranged in series is resolved in following manner. 
IEC/EN 60974-2 defines two groups of circuit breakers. The A selectivity category of use (common, non-selective 
circuit breakers) and then the B selectivity category of use for selective circuit breakers with adjustable delay (at 
least 50 ms; preferable values are 0.05 - 0.1 - 0.25 - 0.5 - 1s).  
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A certain parameter similar to the one for cables is introduced for the selectivity category B of circuit breakers, i.e. 
in the selective design, namely the rated short-time withstand current Icw, which describes the circuit breaker’s 
ability to transmit the short-circuit current equivalent precisely to Icw throughout the duration of the forced delay. 
Manufacturers of power circuit breakers specify the most frequent periods for short-time delay. They are 0.1 s, 0.3 
s, 1 s or 3 s. The circuit breaker located closer to the fault point is not typically of a selective design (selectivity 
category A) and will disconnect the fault within a short time - in tens of milliseconds as the maximum.– Then the Icw 
parameter of the selective circuit breaker usually does not need to be used in full.  
 

  
 

                                   Selectivity of two power circuit-breakers (ACBs, MCCBs) 
 
Evaluation of selectivity between circuit breakers (ACB, MCCB): 
 

Ik < Ii
 
: comparison of tripping characteristics, provides sufficient information on selectivity 

 
Ik ≥ Ii : tripping characteristics are not useful for selectivity comparison in the field of short-circuit currents  

  (above the instantaneous release value Ii) 
a. it is necessary to compare the values of let-through energies at a short circuit; 
b. use selectivity tables (test results). 

 
 
Selectivity between different protection devices: the xSpider application offers the opportunity to work with 
tripping characteristics. After selecting two devices from the database you may encounter the following situations: 

 Full selectivity (T): the outgoing circuit-breaker (2) will trip, while the incoming circuit-breaker (1) remains on. 

 Partial selectivity: selectivity between the relevant circuit-breakers is secured, if the short-circuit current Ik’’ is 
lower than a specified value. In that case the outgoing circuit-breaker (2) will trip, while the incoming circuit-
breaker (1) remains on. 

 No selectivity: both circuit-breakers, the outgoing (2) as well as the incoming (1) will trip. 

 Cannot be evaluated: the pair under examination was not found in the selectivity table; selectivity must be 
evaluated through a comparison of their tripping characteristics, as specified above. 

 

Rated 
current 

Overload Short-circuit 
current 

Tripping time  [s] 

tsd …short-time delay,  
field-settable current / time data 

 
Short time delay of S1 improves 
selectivity of combination. 

tsd (S1) 
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Influence of cable length on selectivity conditions: conditions of selectivity between circuit-breakers are defined 
by the standard IEC/EN 60947-2, Annex A and IEC/ EN60947-2. Two circuit breakers in the series are linked by a 
wire with a length of 0.75 meters. In real installations, moreover, they are subjected to line impedance and this 
reduces the short-circuit current and improves the selectivity conditions. If the expected short circuit current in the 
installation is less than the setting of the short-circuit release Ii of the incoming circuit breaker (limit selective 
current), selectivity is ensured.  
 
 
 

 
 

An example of the influence of the cable impedance on the short circuit current at the fault site. 

 
The xSpider programme enables calculations of short circuit currents at various points in the installation (nodes), 
and comprehensive assessment of selectivity.  

6.3 Backup protection 
 
The end circuits that are protected by small circuit breakers or motor starters, have certain limitations in breaking 
capacity due to their size and design. The problem arises with an installation where the value of the expected 
short-circuit current at the circuit breaker installation site exceeds their breaking capacity. The only possible thing to 
do is to install an upstream fuse for such a device or a suitable limiting circuit breaker suitable to limit the energy to 
a level that does not damage the protective device on the load side. Such sequencing of protection devices in 
terms of the effects of short circuit currents is called backup protection (also known as cascading). The conditions 
for backup protection are described by the standard IEC/EN 60947-2 and also IEC/HD 60364-5-53. Combination of 
two devices that are capable of performing the function of backup protection is tested in a testing laboratory and 
the results apply only to the devices specified by the manufacturer.  
 
In the case of backup protection, the short circuit current is limited by a protective component, which is preceded by 
a component that ensures the disconnection. A limitation consists in disconnecting the short-circuit current before 
the first half-wave of the anticipated short-circuit current reaches its maximum point (i.e. the current which would 
flow through circuit if the protective device was not included). This is shown in the figure below where the waveform 
of the anticipated short-circuit current Icc and the waveform of the limited current io. The maximum values of this 
limited short-circuit current depend on the magnitude of the anticipated short-circuit current.  
 
The expected short circuit current is described by the effective value in the steady state. This is referred to as Icc. 
The maximum value of the short-circuit current (the peak value) is ip = Icc ×2. Icc represents the short-circuit 
current, i.e. its effective value in steady state. When showing the graphical dependence of the maximum value of 
the limited current Ic on the anticipated short-circuit current Icc, this short-circuit current is typically labelled ip (the p-
index - peak).   

Transformer  1 000 kVA 
Cable lenght influence 



xSpider, User’s manual   
____________________________________________________________________________________________________  

 

 ______________________________________________________________________________________________________________________  
 

 I / 41 

 

  
a) back-up protection of RCBOs using fuses b) back-up protection of MCBs using MCCBs 

Backup protection with fuses and circuit breakers 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Example: 

 
NH1 

In = 315 A 

Icu = 120 kA 
 
RCBO (e.g. PKNM series) 
In=16 A 
B characteristic 

Icn = 10 kA 
 

Icc ≤ 50 kA 

Example: 
 
NZMN2  
In= 250 A 
Icu = 50 kA  
 

MCB (e.g. FAZ series) 
B characteristic 
In=16 A 
Icu = 15 kA 
 

Icc ≤ 30 kA 
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7. Reactive power compensation  
 
Electrical equipment, such as electric motors, transformers, fluorescent tube chokes and many others, do not 
consume only active energy from the network, but also the reactive (idle) energy which is required to ensure their 
proper functions. The problem is that the transmission network is loaded with the sum of both these energies. In 
order to reduce the reactive energy transmitted by the system, a compensation condenser is connected to the 
appliance or to its neighbourhood, which supplies the reactive energy directly to the appliance, thus reducing the 
volume of the reactive energy transmitted in the network. The quality of reactive energy compensation is 
determined by the cos φ power factor, which is the ratio of the active power P and the apparent power S. The 
following relation applies with a certain simplification: 
 

cos φ = P / S 
 
The apparent power S consists of the active and the reactive power components: 
 

S P Q 2 2  

 
Where :cos   ...  power factor (cosine of the phase shift angle between the voltage and the current - for 50 Hz)  
 P  ........... active power [W] 
 S  ........... apparent power [VA] 
 Q  ........... reactive power [var] 

 
The ideal situation is to achieve a power factor close to one. If the power factor is too low, then the consumer is 
penalised for drawing reactive energy. Depending on the extent and stability of consumption, various types of 
compensation are used: individual, group or central compensation. As for individual compensation, the condenser 
is switched on directly with the load, while the group and the central compensation is suitable for larger electric 
systems with variable load. Here, condenser switching is controlled by an automatic controller, which ensures that 
the required power factor is reached. In all cases referred to above it applies, however, that the compensation 
located in any network point influences the entire system.  
 
The figure on the right shows a simplified diagram of a parallel 
connected compensation condenser. The current phasor is 
changed due to that from I´ to IK. Following compensation, the 
net line current will change to IK = I´+IC . 
 
With the C capacitor (condenser), you achieve compensation 
power of: 
 

Q
I

CC 


2


 

 
where: QC ......... capacitor output [var] 
 I  ............. effective current value [A]  
   ............ angular frequency  
  ( = 2   f for 50 Hz it is 314)  
 C  ............ condenser capacity [F] 
 
 
 
Only a delta connection (CD) is in fact used for condensers in three-phase networks. xSpider also allows use of 
condensers in star connection. However, these can be employed only for single-phase loads. After connecting a 
condenser, you can deduct the current flowing through the condenser and use it to select the condenser 
contactors. Eaton offers a complete product range.  
 
The required power factor is achieved by selecting a suitable capacitor, however, the application does not perform 
automatic calculation from the initial to the final factor, but only calculates the compensated state with a specific 
capacitor. During the above-mentioned check, it is possible to test the maximum power of the compensation 
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batteries that we will need in the network, in order to not overcompensate the network, or in order to not design 
unnecessarily powerful compensation batteries. The reduction of power of the connected condensers is then 
performed via an automatic mechanism which is a standard component of compensation distribution boards. 
 
xSpider allows you to also compare the voltage drop before and after compensation because the reduction in the 
apparent output leads to a decrease in the current as well. It is demonstrable that reduction of losses occurring 
during the transmission of electric energy is a very beneficial measure since other methods, such as increased 
cross-section, increased rated voltage etc., are not economical and, from a technical point of view, often feasible 
only with difficulties. Through calculations, you can also check that it is even possible to reduce the cross-section of 
the lines used in some cases.  
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8. ArcRISK – Risk Assessment of working on low 
voltage switchboards 

 

The newest trend in the area of safety of personnel while working on electrical equipment is to evaluate the 
risk of burns from electric arcs, the so-called Arc Flash Assessment (Arc-Flash Hazard Analysis). The European 
standard EN 50110-1 3rd edition: Operation of electrical installations, Part 1: General requirements definition is the 
standard which defines the minimum requirements valid for all CENELEC countries and some additional 
informative annexes dealing with safe working on, with, or near electrical installations.   
  

Three basic types of injuries are defined according to cause (chapter 3, cl. 3.1.6):  
 Shock Hazard - an electrical shock is defined as a pathophysiological effect of the 

electric current passing through the human or animal body;  
 Arc Flash – an effect of arc between energized conductors;  
 Fire or explosion caused by electrical energy when operating an electrical 

equipment or while working on it. 
 
The working procedures specified in EN 50110-1 are designed to prevent mainly electric 
shocks and also arc flash.  
 
Chapter 6 specifies the basic principles:  

 Before starting any work, a suitable risk assessment shall be completed and the 
necessary protective measures shall be applied …. 

 Only the nominated person in control of an electrical installation during work activities shall give 
authorisation. This shall be repeated in case of any interruption of the work activity except short breaks 
during which the actual work location is not left unattended. 

 
Working procedures are divided into three different categories:  

 Work under voltage (live working); 
 Work on a switched off device (dead working); 
 Work in the vicinity of parts under voltage (working in the vicinity of live parts). 

 
If the requirements of Work on a switched off device (dead working) or Work in the vicinity of parts under voltage 
(working in the vicinity of live parts) cannot be fully met, then the requirements of Work under voltage (live working) 
shall be observed. 
 
All these procedures are based on the use of protective measures against electric shock and/or the effects of short-
circuits and arcing.  
 
The paragraph 6.1 describes basic terms as Arc Hazard, Hazard and Arc Assessment.  
 
Arc hazard 
 
Persons working in the vicinity of electrical installations are exposed to hazards caused by an electrical arc. 
Although the risk of electrical arcs is rare, reliable protection is required as the possibility of an arc cannot be 
completely excluded particularly since they can be caused by actions of personnel while working on or in the 
vicinity of live equipment. Electric arcs are not only a result of a short circuit, but can also be caused by the 
disconnection of live parts without taking special measures for correct isolation offline, cable connectors, 
switchgear, fuses, etc.). 
 
Hazards 
 
The thermal impact of an electric arc depends on the incident electrical energy (short-circuit capacity), that 
determines the energy converted in the arc, which depends on the arc voltage, arc current, arc duration and the 
heat flux transmission conditions including the exposure conditions and the distance to the arc. The mode and 
violence of heat transfer is basically not dependent on voltage levels (low or high voltage).  
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The consequences of the arc flash generation include the following:  
1. incident energy;  
2. noise (120 – 140 dB); 
3. rapid expansion of the ambient air due to rapid rise in temperature. 

 

                        
 
 
Risk assessment 
 
In all instances where work in the vicinity of an electrical installation or under live conditions is necessary, risk 
assessments shall be carried out. 
 
Hazards due to electric arcs cannot be completely eliminated nor can they be predicted so suitable protective 
measures should be taken. Additionally other workers such as operators may be within the reach of electrical arc 
hazards. These risks should be included in the risk assessment.  
 

 
Risk control in the LV switchboards 

 
Generally, the most effective way to reduce the consequences of an arc flash risk, is to prevent the arc occurring, 
prevention is always better than dealing with the eventual consequences. 
 
There are a number of possible solutions which can reduce the risk in arc initiation in LV switchboards. One 
solution is to ensure that the level of insulation while working is adequate for example applying solid insulation 
materials or maintaining a sufficient isolation distance in air. The standard EN 50110-1, Table A.1 gives guidance 
for the minimal acceptable isolation distances in air. 
 
In the event of an arc fault between energized parts or between energized parts and earth occurring, then an Arc-
Flash incident has happened and all prevention measures are no longer considered and arc mitigation strategies 
come into effect. 
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The risk of arc fault must be considered especially in cases of electrical work near live parts or in contact with 
live parts (work under voltage; see the EN 50110-1). Experience shows that the probability of an arc fault is 
highest where work in these areas is being undertaken.  
 
Despite modern designs of electrical equipment taking into consideration the potential risks of an arc event 
happening, it is a matter of fact that arc-flash injuries do constantly occur. Extensive experimental research in this 
area has led to a deeper understanding of the relationships involved and to the determination the magnitude of the 
arc-flash hazard.  
 
Work procedures for working on a switched off (isolated) device and the use of passive safety measures such as 
barriers, partitions, covers or insulated coverings reduce the likelihood of arcing occuring, but do not reduce 
the risk of an arc flash. To be able to effectively evaluate the risk to personnel in case of an arc flash it is 
necessary to undertake an Arc Risk Assesment (ArcFlash Risk Analysis).  
 

 

 

Definition of basic parameters for Arc Risk Assessment 
 
When an arc fault occurs, then an Arc-Flash is created. Due to the high energy of the arc current (Ia) creates an 
incident energy (E) at the given point in the distribution system. The incident energy is the function of the calculated 
three-phase short-circuit current, breaking time of the protective device and other parameters of the distribution 
system in the given location i.e. type of bus, degree of internal separation, bus bar distance etc. 
 
A method of calculating the incident energy follows the conditions of the IEEE regulation IEEE 1584:2002, which is 
the only globally available guide for the calculation of open arc. Knowledge of this regulation is a prerequisite for an 
objective assessment of the risk at work on the system in terms of the possibility of arc flash. 
 
Method of calculating the incident energy of arc flash event: 
 

Arcting current:  Iarc =  Kb  ͯ  Ik3p  [A] 
Energy of arc:    Earc = Uarc  ͯ  Iarc  ͯ  t [VA s = J] 
Incident energy:  Einc = Earc   ͯ  k   ͯ (1/Dx)   [J/cm²] 

 
I“k3p  - symmetrical phase SC current; 
Uarc  - voltage on the arc; 
Iarc  - arcing current, lower to bolted current; 
t  - clearing time of protective device; 
k - factor for specified conditions; 
D - distance between arc and person; 
x - factor 1,6 ÷ 2 

 
The objective of the Arc-Flash analysis is to find the highest value of incident energy at the point of arc incident 
within the distribution system. In other words, this is to identify the main operating conditions of the given 
distribution system and calculate the incident energy at the given point for each of these operating conditions 
including for instance the changes of the magnitude of the contribution to the short-circuit current from the mains 
supply. A calculation of the incident energy for the specific location where the fault occurred will be performed to 
obtain the worst possible operating condition (worst-case scenario). On the basis of available Incident energy (E) 
the appropriate Personal Protective Equipment (PPE) will be determined for the site. General rule for selection of 

Incident energy E [J/cm2]  
/ radiated energy / cm2 
/ arc flash energy  

 

Working distance D [mm]  
Distance between potential point of arc 
flash and worker. 

 

Arc Flash Boundary DB [mm]  
Distance within which a person could 
receive a second degree burn from an 
arc flash incident (for E =5 J/cm2). 
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suitable PPE is that protection level rating of PPE (ATPV or Class 1, 2) must be higher than available value of 
Incident energy (E).  
 

 
 

Source: company DUPONT 
 
Suitable personal protective equipment (PPE) reduces the effects of the thermal component of the arc hazards and 
contributes to the protection of personnel. There is no PPE level of protective clothing that provides one hundred 
per cent protection against any electric arc. The solution is to minimize the risk of the arc being generated in the 
first instance.  
 
How to use the ArcRISK module within xSpider? 

1. Draw a single line diagram of low voltage network. 
2. Make a standard calculations to obtain optimal design of the low voltage network i.e. voltage drop and short 

circuit currents Ik3p, Ik1p. 
3. Make the correct selection of the protective devices providing coordination selectivity and where applicable 

back-up protection. 
4. Use ArcRISK module: 

 Run the xSpider ArcRISK module. 
 Select suitable parameters and protective measures in the part “Calculation inputs“ (Top – Down). 
 Calculation results are displayed on the top left: Incident energy (E) and Arc Flash boundary (DB).  
 Make a risk assessment of the safety level by the selection of different tabs:  

 

 
 

 Make improvements to the design by the use of protective measures. 
 Print and/or Export report 
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How to run the ArcRISK module 
 
Calculations / All calculations / ArcRISK  
 

 
 

 
 
 

 
 
 
Before first use of ArcRISK module, a password is requested, please ask: xspider@eaton.com 
 

 
 

                                            
 
 
 
 
 
 
 

Calculation inputs 



xSpider, User’s manual   
____________________________________________________________________________________________________  

 

 ______________________________________________________________________________________________________________________  
 

 I / 49 

 
Calculation inputs settings: 

 Select the Network node:  
 Taken from the single line diagram where the analysis is required 

 Short circuit at: 
 Line side = incoming terminals of main circuit breaker 
 Busbar side = behind main circuit breaker     

 Switchboard:  
 Switchboard series – select type of switchboard used 
 D Working distance: distance between person and expected point of arc (default D = 455 mm) 

 Measures to reduce the likelihood of an arc incident: 
 Internal separation 
 Arc free design - provides the maximum possible insulation / separation of busbars and live conductors   
 Temperature diagnostics used on the busbars (Diagnose)  

 Measures to reduce the thermal effect of arc: 
 Passive Arc set (IEC/TR 61641) 
 ARMS: activation (On/Off) and setting (IiArms) is via the Properties selection of the ACB selection criteria. 

Possible improvement of resistance against unwanted trips due to start-up currents of motors; See 
pushbutton Details. 

 Arcon: arc mitigation up to 2ms 
 Protective measures for the prevention of arc flash (see Details): 

 Internal separation (according to IEC/EN 61439); Form 4b being the highest level 
 Temperature diagnostics on the bus: continuous temperature monitoring of selected sites in the 

switchboard highlights areas of potential failure allows for preventative actions to be taken to reduce the 
probability of generating an arc. Transmission of the signal from the temperature sensors is wireless 
(based on radio frequency) and is very well suited for inaccessible places.  

 Protective measures for reduction of the consequences of an arc (see Details): 
 Zone Selective Interlocking (ZSI) 

 The Zone Selective Interlocking (ZSI) function is provided on all trip units and can be enabled or 
disabled through the menu system or Power Xpert Protection Manager software. ZSI functions in 
conjunction with the Short Delay and Ground Fault protection functions.  

 ZSI provides the fastest possible tripping for faults within the zone of protection of the circuit breaker 
and also provides positive coordination among all circuit breakers in the system (mains, ties, feeders, 
and downstream circuit breakers). The function of ZSI can be tested in the xSpider by the setting of 
the main circuit breaker where short time delay is switched to zero. Details are described in the DEMO 
- ArcRISK - ARMS + ZSI.  

 Passive protection in the event of arcing (according to IEC/TR 61641) 
 The buses are arranged and tested so that in an arcing situation the application of gas pressure 

automatically opens the pressure relief valve, generally in the top cover; the mechanically reinforced 
front panels and doors then prevent an injury to the operator. 

 ARMS™ (Arc Reduction Maintenance System)  
 A special solution by Eaton which reduces the tripping time and hence the arc incident energy in the 

system. It is provided in Eaton’s IZM and IZMX series of air circuit breakers from 1600A up to 6300 A. 
Activation of the ARMS function is performed by the operator or automatically using a limit switch 
when opening the switchgear room door or remotely via a communication bus. The significantly 
decreased value of incident energy reduces the level of arc flash to a minimum.  This reduced level of 
incident energy allows for a lower level of PPE to be worn by personnel. Details are described in the 
DEMO - ArcRISK- ARMS + ZSI and DEMO – ArcRISK settings.  

 ARCON ® 
 Arcon provides an active protection of the switchgear if an internal arc fault is detected in the panel. 

The Arcon system extinguishes the arc within 1.4s – 2ms, this guarantees the maximum possible level 
of protection available on the market today for personnel and for the switchgear. Providing protection 
to Class C of IEC61641:2014 and Criteria 7 of IEC61641:2008. 
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Normal Operation and Maintenance 
 
It is necessary to be clear about what the definitions of “operation” and “maintenance” mean in terms of the 
functions carried out by personnel.  
 

 Normal Operation: means the collection of information, operation of switching devices, checking the status 
of devices on the front panel of switchboard. 

 Maintenance: means the replacement of fuses and links, testing, manipulation of live conductors, racking 
breakers, installation of cables into energized equipment or in the vicinity of live equipment as in common 
cable compartments, removal and replacement of live components, connection of cables 

 
The Arc Risk Assessment consists in the assessment of the risk of arcing due to a specific work activity performed 
by the operator in the given NODE (functional unit) / bus. 
 
Tab: Safety level of switchboards  
 
A comprehensive evaluation of the switchboard, with respect to the selected protective measures, is used for the 
prevention of arc flash and also protective measures for effective reduction of the effects of an arc.  
 

 
 

Evaluation of safety level (in relation to Risk matrix results):  
 Low: no or very limited use of protective measures 
 Medium: use of selected protective measures  
 High: high degree of requirement to use protective measures  

 
Calculation results  
 
 

 
 
 
 
 
 
 
 

Normal operation 

Maintenance  

Calculation results  



xSpider, User’s manual   
____________________________________________________________________________________________________  

 

 ______________________________________________________________________________________________________________________  
 

 I / 51 

Tab: PPE (Personel Protection Equipment)  
 
Displayed PPE is only an example. The right PPE must be selected together with a skilled provider of PPE. There 
are two basic rules for the selection of suitable PPE: 
 

1. PPE must be tested as Arc Flash Resistant (AR), not only Fire resistant (FR) !! 
2. Protection level of PPE must be higher than the incident energy of Arc Flash (ATPV or specified Class 1 or 

Class 2).  
 

 
 
 
Tab: Risk Matrix   
 
A Risk matrix is a matrix that is used during the risk assessment to define the various levels of risk as the product 
of the ‘harm probability’ categories and the ‘harm severity’ categories.  
 
This is a simple mechanism to increase visibility of the risks and assist management decision making.  (Different 
companies are using different definitions of these categories, but the principle is the same).  
 

 
 
Note: A risk is the amount of harm that can be expected to occur during a given time period due to specific harm 
event (an accident). Statistically, the level of risk can be calculated as the product of the probability that harm 
occurs (an accident happens) multiplied by the severity of that harm (the average amount of harm). In practice, the 
amount of risk is usually categorized into a small number of levels because neither the probability nor harm severity 
can typically be estimated with accuracy and precision. 

Example of PPE  
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A detailed description of the issues addressed by the ArcRISK module is available on www.xspider.eaton.eu or on 
request. Technical support for this module of the xSpider application includes provision of detailed technical 
documentation.  This module is provided as an additional add-on module to the standard xSpider software package 
and an additional request for access password are necessary for qualified operators of this special module.  
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1. Introduction 
 
The xSpider software system is a graphically oriented design system for dimensioning of low-voltage networks 
fitted with Eaton brand circuit protection equipment. It calculates voltage drops, load distributions and short-circuit 
currents for radial as well as meshed networks and carries out a subsequent check on the suitability of the cables 
and protection equipment used. The software is intended primarily for designers and computational engineers. 
 
Version 3 is a new software generation. It includes a new graphics and computing core, a new user interface. The 
features contained in version 2 are retained and are complemented with new features. The computation 
procedures are updated according to current standards. 
 
General features: 

1. TN / IT / TT network systems of different voltage systems up to 1000V. 
2. Design of radial as well as meshed networks. 
3. Design of networks supplied from one or more different power supplies (supergrid, transformer, generator), 

design of networks supplied concurrently from different power sources.  
4. Option of simulating various operating states of the network by disconnecting power sources and loads; an 

operating status manager is available. 
5. Option of defining simultaneous and utilisation factors. 
6. Database of components with transparent tree structure allowing user-defined additions. 
7. Automatic dimensioning of wires, switching and protective devices for standard network configurations. 
8. All calculations (voltage drops, load distribution, impedance, short circuits) are based on applicable IEC 

standards. 
9. Selectivity solutions – functions for working with selectivity spreadsheets and functions for working with 

tripping characteristics. 
10. Generation of documentation (wiring diagram with calculation results, calculation report, tables of element 

parameters and of calculation results). 
 
User interface: 

11. User-friendly interface allowing quick and easy entry of simple cases while maintaining the maximum 
variability and open-end character.  

12. User operation similar to standard CAD systems (AutoCAD). 
13. Parallel display of wiring diagram + properties of elements + list of errors. 
14. Parallel processing of multiple projects (MDI interface). Transfer of objects between projects via clipboard.  
15. The software application is available in a variety of language mutations. Language version can be 

customised when you first start the programme and can be changed anytime later. 
 
Wiring diagram: 

16. The network wiring diagram (topology) is defined by combining the particular components (power sources, 
transformers, circuit lines, circuit protection equipment, loads) in the graphics.  

17. A function is available to insert standard component groups with a single click (power supply groups, 
couplings, outlets, …). 

18. Option of adding free graphics (line, circle, rectangle, text). 
19. Objects for editing graphic and descriptive characteristics are marked with grips. The grips can be used to 

perform basic graphic editing – moving or stretching. 
20. The method of selecting objects for editing can be customised (single selection, multiple selection, combined 

selection). 
21. The element characteristics are set through a single property grid similarly to standard CAD systems. 
22. Standard functions used for graphics editing are available (erase, move, copy, ...). 
23. Standard functions available for controlling the display (zoom, pan) controlled by the mouse wheel. 
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Parameters of network components, database of components 
24. Parameters of the inserted components (i.e. those components, which cannot be dimensioned within the 

programme - power sources, loads, and transformers) must be entered immediately after inserting the 
respective component into the network wiring diagram.  

25. Parameters of other components (protective devices, switching equipment, cables) must also be specified. 
26. A database of standard components is available (generators, transformers, cables, busbar systems, surge 

arresters, circuit breakers, residual current devices, residual current devices with overcurrent protection, 
overload relays, fuses, switches, motors, compensations).  

27. The database contains Eaton products (switching and protective devices). The range of products displayed 
to the user is dependent on the regional version. The regional version can be customised when you first start 
the programme and can be changed anytime later. 

28. The database contains articles from other manufacturers, necessary to perform the calculation, often used in 
the given region.  

29. The database is built as open-ended and the user can add any components into the database that he uses 
in his projects. The option of adding items to the databases by the user is important in particular with 
components not supplied by Eaton (generators, transformers, cables, motors, compensation units). The 
Eaton product database cannot be customised. 

30. Products can be searched for from the database tree on the basis of technical parameters or data table 
based on the type designation. 

 
Calculations 

31. The calculations based on IEC standards. 
32. TN, IT or TT systems are considered, depending on the user’s selection, for the selected voltage system up 

to 1,000V (low voltage networks). The medium voltage network only allows power supply via the power 
transformer. 

33. Voltage drops in nodal points of the network (a check whether the drop does not exceed the user-defined 
maximum value set locally for every network component). The utilisation factor is always taken into account. 
For radial networks, the simultaneous factor is also taken into account. 

34. Load distribution in the network lines (check on correct dimensioning of the circuit protection equipment and 
conductors according to IEC 60364-5-52), check on line protection for overload and short circuit according to 
IEC 60364-4-43. Power factor calculation for meshed networks. 

35. Three-phase symmetric short circuit, calculation according to IEC 60909 - calculation of the short-circuit 
current in the selected network point, distribution of short-circuit current flows in the network (check on 
correct dimensioning of the circuit protection equipment and conductors). The contribution from the motor is 
taken into account (if the motor is not connected through a soft starter or a frequency converter). 

36. Resolution of backup protection (cascading) – checking the breaking capacities of the outgoing protective 
components at the outgoers with respect to the incoming protective components at the incomers. 

37. Features for the assessment of selectivity of circuit breakers according to the selectivity tables. 
38. One-phase asymmetric short circuit against the ground, calculation according to IEC 60909 - calculation of 

the short-circuit current at the selected network point and of the short-circuit current flow in the network, 
calculation of impedance in the short-circuit point and of contact voltage in non-conductive parts. Calculation 
of the disconnection time for the short-circuit point and check on compliance with the requirements of IEC 
60364-4-41, ed. 2. 

39. Calculation of the positive and zero sequence components of impedance at the network node (which can be 
used for the subsequent design of the connected IT network, for instance). Calculation impedance of fault 
loop Zsv according to IEC 60364-4-41, edition 2 is also included.  

40. Calculation of incident energy during short-circuit flash, hazard analysis according to IEEE 1584TM, 2002. 
41. The calculation results can be displayed either as absolute values or as complex numbers; calculated 

impedances are not adjusted by any coefficients. 
 
Displaying of results 

42. Calculation is followed by a display of the list of non-compliant elements (in parallel with the wiring diagram). 
43. After the calculation has been performed, the calculated values will be displayed for the individual 

components in the network wiring diagram. The diagram showing the results can be printed out. It can be 
printed on any output device, for which a driver is available in Windows (printer, plotter). 

44. After calculation, it is possible to generate a comprehensive report on the calculation and to print it. 



xSpider, User’s manual   
____________________________________________________________________________________________________  

 

 ______________________________________________________________________________________________________________________  
 

 II / 3 

Working with tripping characteristics 
45. The dialogue box with the tripping characteristics is shown in parallel with the wiring diagram (in “Full Mode” 

of operation state). 
46. Alternatively, the "Curve Select Mode" is available - a simplified user interface only for working with tripping 

characteristics without the ability to draw a circuit diagram and perform calculations. 
47. Selection of a protective device from the database and rendering of its tripping characteristic (including 

tolerance range if the necessary data are available). 
48. Selection of protective equipment from the network wiring diagram and drawing of its tripping characteristics 

- selectivity assessment possible (in “Full Mode” of operation state). 
49. If a circuit protection device is equipped with adjustable releases, it is possible to modify all parameters 

available. If this was a device from the wiring diagram, the change of the release parameter setting is 
transferred back into the wiring diagram (in “Full Mode” of operation state). 

50. Selection of a cable from the database and rendering the time-current heating characteristic of the cable. 
51. Selection of a motor from the database and rendering the motor startup characteristic. 
52. Possibility to insert a user-defined curve (by entering a set of points [current, time], or importing a set of 

points from an XLSX/XLS (Microsoft Excel) file). 
53. Possibility to display, print and export let-through current (Ic) and let-through energy (I2t) characteristics. 
54. Possibility to evaluate selectivity and backup protection. 
55. Print-out of wiring diagram at the output device. 
56. Export of wiring diagram to DXF (for their subsequent import to CAD systems) or PDF data format. 

57. It is also possible to work with the tripping characteristics independently without drawing a wiring diagram, 
even in the “Full Mode” of operation state. 

 
Project: storage, archiving, export:  

58. Export of graphics to DXF data format (for their subsequent import to CAD systems). 

59. Export of graphics to PDF data format. 

60. Export of data tables (a list of network components with their parameters, a list of the networks with the 
calculation results, a list of cables) to XLSX/XLS format (Microsoft Excel). 

61. Export of calculation reports to DOCX/DOC format (Microsoft Word). 

62. Export of calculation reports to PDF format. 

63. Archiving of a project in a data file. 
64. Backward compatibility - you can import data files from an earlier version of the application. 
65. Compatibility between different regional and language versions (data file can be opened everywhere 

regardless of the language and regional version). 
 
Hardware and software requirements (minimum configuration): 

 PC, 1GB RAM or more, graphic card with the minimum resolution of 1024x768, monitor, mouse or other 
pointing device, an output device for printing. 

 Min. 1.0 gigabytes of free hard disk space. 

 .NET Framework 4.5.2 installed (system libraries, a Windows component, available for free from Microsoft). 

 Installed Access Database Engine 2016 (system libraries for working with databases, a standard part of 
Microsoft Office, or available free of charge from Microsoft). 

 Operating system: Windows 8, Windows 10. 
 
Notes: 

 The Spider Software (xSpider) is not a network application. It must always be installed on the local disk of 
every user. 

 The licence to use the programme system is provided for a limited period of time. The licence is provided by 
Eaton Industries (Austria) GmbH, the exclusive holder of rights to the programme. 
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2. Installation and update

2.1 Installation 

1. Insert the installation CD/DVD in the drive (e.g. drive D:), or download the setup file from the website to a 
temporary directory on your hard disk.

2. Run the installer by double-clicking on the installation file on the CD/DVD in the \xSpider_Setup directory 
or double-click on the installation file downloaded from the website in the previous step.

3. Select the language version of the installation from the list of the options being offered.
4. Now, you are prompted to close all the running applications (programmes). Click Next to continue the 

installation.
5. Read the Licence Agreement in the dialogue panel that opens up subsequently. If you agree with the 

conditions, select the option ‘I agree’. Then click Next.
6. Specify the directory in which the application is to be installed. If the directory does not suit you, click Browse, 

and then enter a different one in the open dialogue box. Click Next to continue the installation.
Note: We recommend that you install the application into the default directory. The application should not be 
installed in the Program Files directory (because of possible problems with access rights).

7. Specify the name of the group of programmes where the programme’s ‘run’ icon will be located (the name of a 
new item in the Start menu – Programmes). We recommend that you keep the pre-selected (default) name. 
Click Next to continue the installation.

8. The settings carried out in the previous steps are summarised in the sheet that is displayed subsequently. 
Please, check whether the settings meet your requirements. By means of the Back button, you can go back 
the necessary number of steps and modify the individual parameters. Actual installation is launched by clicking 
the Install button.

9. Now, the files will be copied to the hard drive of the computer and installation will be expanded.
10. A final report will be displayed by the installation programme. This means that the installation has been 

completed correctly and that the application is ready for use. Close this dialogue panel by clicking on the 
Finish button. The installation programme will automatically create the ‘run’ icon on the desktop, and it will 
carry out association of the .SPIX extension files (projects of networks) with the xSpider programme (the 
programme is activated automatically by double clicking on the file with the SPIX extension in Windows 
Explorer).

11. Run the application, select the language and regional version, then accept the Licence Agreement and enter 
the licence (see chap 3.1).

12. If the programme does not start and displays an information message about missing Access Database Engine 
and / or .Net Framework system libraries, install these libraries by running the appropriate setup programmes 
which can be found on the CD / DVD in the \xSpider_Setup\WinSys directory or can be downloaded from 
the Microsoft website.

13. The installed programme can be removed by means of the uninstall programme. 

2.2 Software update from the website 

As an integral part, xSpider includes a so-called Updater, software which checks the availability of new versions on 
the Eaton website. Updater runs automatically every time the programme is launched (if an Internet connection is 
available). It connects to Eaton's website and checks for the existence of a new version. If a new version exists, it 
will be downloaded and installed (if the user allows this action). Conditions for this function are an Internet 
connection and authorisation to write in the directory where the programme is installed. Communication by the 
application over the Internet must be allowed in your computer's protective shield (firewall); if you experience any 
problems, contact your IT administrator. 

Note: The Updater application to check the availability of new versions on the Eaton website can be launched at 
any time by using the Software Update from Website function from the File tab. 
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2.3 Software update from the directory 
 
If no Internet connection is available, it is possible to ask the software provider to have the update files sent in 
another way, and subsequently to update the software from the directory.  
 

1. Ask your software provider to send you the update files (or download them from www.eaton.eu/xspider site).  
2. Load your update files to an auxiliary directory on the hard disk.  
3. Do not unpack! 
4. Launch the xSpider application. 
5. In the menu on the File tab, select the Software Update option, and then Software Update from Directory. 
6. In the subsequently opened dialogue box (similar to the Open function), select the latest update file (file with 

the extension *.SPIU) and click the Open button. 

7. The Spider programme will be closed, updated, and restarted.  
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3. Launching xSpider 
 
If you have installed xSpider on your computer successfully in accordance with the procedure described in chapter 
2, you can proceed with launching the programme. 

3.1 First launch 
 

1. Double-click on the software icon on the desktop. 
2. In the subsequently opened dialogue box, select the language and regional version of the 

programme. Simultaneously set default mode of operation: Full mode (complete user interface, 
all program features available), or Curve Select Mode (simplified user interface, only features for working 
with tripping characteristics are available). This setting can be changed later. 

3. A dialogue panel with the Licence Agreement text will be displayed. If you agree, click Accept. By doing so, 
you undertake to respect all provisions of the Licence Agreement. If you do not agree with the Licence 
Agreement, the programme cannot be run. The wording of the Licence Agreement can be also viewed at any 
later point in time by using the function Options ..., Licence tab. (see chapter 15.4). 

4. As the next step, a dialogue box will open requesting the entry of licence data. Enter the required information 
from your Licence Agreement. If you downloaded the application from the website, your licence data will 
have been sent to you via email to the address provided during registration. If you did not receive this e-mail, 
check your spam folder or contact the programme supplier with a request for provision of the necessary 
licence data. Pay special attention to filling out all items carefully, in particular correct entry of the licence 
expiration date and the licence number. The programme will not launch if incorrect values have been 
entered.  

5. Close the dialogue panel by clicking OK. The system remembers the licence conditions and does not 
request their entry the next time you start of the programme. The Licence data can be also changed at a 
later point in time by using the function Options ..., Licence tab. (see chapter 15.4). 

6. Note: The licence data and the default programme settings are stored in the private directory of the currently 
logged on computer user. If you log on to the same computer as a different user, you may be asked to re-
enter your licence information. 

3.2 Second and subsequent launch 
 

1. Double-click on the software icon on the desktop. 
2. The system checks the licence validity and, provided everything is correct, launches the 

programme. The programme is ready for use. 
3. Alternatively, in Windows Explorer, double-click on a file created earlier with the project file (*.SPIX file). 

The file opens in the xSpider application. 
4. A computer can only run one instance of xSpider.  

 If the xSpider programme is already running, then when you try to start it again according to the 
instructions contained in point 1), nothing happens. In this case, switch to the already running instance 
of the programme by clicking on the programme icon on the toolbar, or by pressing Alt+Tab. 

 If the xSpider programme is already running, then when you open another project according to the 
instructions contained in point 3), the project will open in the existing instance of the programme. In this 
case, switch to the already running instance of the programme - as in the previous case. 

 
Notes: 

 For a detailed description of the basic screen, see Chapter 4.1. 

 For general procedure for using the programme, see chapter 4.4. 

 If you want to open a new project now, click on the New icon (see Chap. 14.3) or modify the automatically 
created new project. 

 If you want to continue editing a project you have already created and saved previously, open this file now by 
clicking the icon Open (see Chap. 14.2). 
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 If the "Software lifetime has expired..." pop up message appears when you start the programme, this means 
that the programme cannot be used anymore. Download the new version from the Eaton website and install 
it, or contact your Spider software supplier in order to obtain a new version of the programme. 

 If the "Your licence has expired ..." message appears when you start the programme, contact your spider 
software supplier to obtain a new licence number. When you download a new software version from the 
Eaton website, the new licence number will be sent automatically. 
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4. Introduction to the xSpider system 

4.1 Main screen and program operation 
 
After launching the program (see chapter 3.1, 3.2) in Full Mode of operation state (complete user interface, all 
program features are available), the main screen is activated:  
 

  
 

(1) Menu (access to program functions) 
(2) Tool box - a function for drawing a wiring diagram 
(3) Project window - graphic area for drawing a wiring diagram 
(4) Property grid - editing of the properties of elements of the wiring diagram 
(5) Error list – this is filled after the check on the network wiring logic or after performing a calculation  
(6) Status line, information on the currently performed operation.  

 

 
 
The dimensions of the individual panels can be adjusted by dragging the partitions. Each panel can be released 
and moved (by dragging the top bar), for example, to the second monitor (8). Each panel can be docked in different 
parts of the screen or closed. Re-opening of a closed panel is possible using functions from the menu on the View 

2 

1 

3 
4 

5 
6 

8 

7 

9 
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tab (7). The menu can be minimised (9). Note: after the program is restarted, the layout of various parts of the 
screen reverts back to the default state. 
 
After launching the program (see chapter 3.1, 3.2) in Curve Select Mode of operation state (simplified user 
interface, only functions for working with tripping characteristics are available), the main screen is activated: 
 

 
 

(1) Menu (access to program functions). 
(2) Window with chart – the tripping characteristics of the protective devices, the motor starting characteristics, the cable 

time-current heating characteristic, … will be displayed here. 
(3) Properties panel – selection of products from the database, plotting of characteristics and setting of parameters 

 
The program allows parallel editing of multiple projects. The functions for arranging project windows and switching 
between projects as well as the project being edited are contained in the menu on the View tab (1). 
 

  

2 

3 

1 

1 

2 

3 

(1) Functions for arranging windows with edited projects 
(2) Active project  
(3) Inactive project 
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4.2 Running program functions 
 
Individual functions of the program can be launched by clicking the icon in the menu or toolbox. The last called 
function and frequently used functions can be launched from the context menu (pop-up menu), which is displayed 
after clicking the right mouse button in the graphics area of the window showing the project. 
 
Keyboard shortcuts: 
 

F1 Help (see Chap. 16) Ctrl+N New project (see Chap. 14.3) 
F2 Auto Dimensioning (see Chap. 8.11) Ctrl+O Open project (see Chap. 14.2) 
F3 Osnap (see Chap. 5.20) Ctrl+Shift+O Open demo (see Chap. 14.2.1) 
F4 Calculation (see Chap. 8) Ctrl+S Save project (see Chap. 14.1) 
F5 Tripping characteristics (see Chap. 9) Ctrl+Shift+S Save project as (see Chap. 14.1) 
F6 Database (see Chap. 10) Ctrl+E Export (see Chap. 13) 
F7 Grid (see Chap. 5.20) Ctrl+P Print (see Chap. 12) 
F8 Ortho (see Chap. 5.20) Ctrl+Shift+P Print preview (see Chap. 12.1) 
F9 Snap (see Chap. 5.20) Ctrl+Z Undo (see Chap. 4.3) 
  Ctrl+Y Redo (see Chap. 4.3) 
  Ctrl+F Find symbol (see Chap. 6.1.2) 
  Ctrl+X Cut to clipboard (see Chap. 6.6.1) 
  Ctrl+C Copy to clipboard (see Chap. 6.6.2) 
  Ctrl+V Paste from clipboard (see Chap. 6.6.3) 
  Ctrl+A Select All (see Chap. 6.1.1) 
  Esc Deselect everything, or interrupt the 

operation (see Chap. 6.1.1) 
  Ctrl+R Regeneration display (see Chap. 7.1) 

4.3 Undo, Redo 
 
The effect of all program functions (except for change to display 
with the zoom function), as they were gradually performed, can 
be undone by clicking the Undo icon or by pressing keyboard 
shortcut Ctrl+Z. Use the Undo function with caution, as some 
operations are not directly visually reflected in the wiring 
diagram (e.g. change of line parameters). 
 
The effect of the last performed Undo function can be undone by clicking on the Redo icon by pressing keyboard 
shortcut Ctrl+Y. You can only take back one step of the Undo function. 

4.4 Method of program application 
 
Full Mode of operation state (complete user interface, all program features available): 
 
When designing a network, the first step consists in drawing the wiring diagram (topology). The network wiring 
diagram is defined by combining the particular components (power sources, transformers, circuit lines, switching 
devices, protective devices, loads, compensation units) together in the graphics. Free graphics (lines, circles, text, 
…) can be added into the drawing. The software is intended for design of networks, which are operated as 
TN/IT/TT networks of various voltage systems. Thus, the first step, prior to commencing design of a new network, 
is selection of the network type and the voltage system (see Chap. 5.1).  
 
There are 2 types of components available in general when designing the wiring diagram: 
 

 Inserted components, i.e. introduced components, the parameters of which are pre-set and cannot be 
configured within the program (power sources, transformers, loads, motors, compensation units), 

 User-defined components, i.e. such components, the parameters of which are subject to investigation and 
optimisation (lines - cables, busbar systems; protective devices - circuit breakers, fuses, switching 
components - disconnectors). 
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Entering parameters to custom elements depends on how the program will be run. The following basic modes are 
available: 
 

 Design mode (Automatic Dimensioning AutoDim), i.e. custom feature parameters for which the user request 
it, will be automatically determined and set to meet safety requirements; the proposed solution may not be 
optimal; 

 Control mode, i.e. the parameters of all elements (both user-defined and inserted) are set by the user (based 
on previous experience); After performing the calculation, the criteria for safe network operation are checked. 
The user will evaluate the results and may subsequently carry out some optimization adjustments to the 
design. 

 
Best practice in design mode (Automatic Dimensioning AutoDim): 
 

1. The network wiring diagram (topology) is defined by combining the particular components in the graphics. 

 Parameters of inserted elements must be specified (possibility to select elements from databases).   

 User-defined element parameters may not be specified, but for each element, the Dimension 
Automatically switch must be enabled.  

 Using the Information about project function, the Wiring Diagram tab you can set to automatically 
turn on the Dimension Automatically switch as the default state when you insert an element into 
the wiring diagram. The setting is valid for the currently edited project.  

 With the Options function, the Wiring Diagram tab, you can be set to automatically turn on the 
Dimension Automatically switch automatically as the default state for each new project. 

 Within the network, there may also be user-defined elements that are already specified (by choosing 
from the database) and their dimensioning is not required. For these elements, the Dimension 
Automatically must be automatically turned off. 

 For more details see Chap. 5. 
2. Starting the automatic sizing calculation using the Calculations function and setting of the user preferences 

function (see Chap. 8.11) - determination of the wire standard (material, insulation), determination of the 
preference of the protective devices product series, setting of the limit parameters (maximum number of 
parallel branches) etc. User preferences can also be set using the Options function in the Automatic 
Dimensioning tab. 

3. Starting the automatic sizing calculation using the Calculations function (see Chap. 8.11). A complex check 
of the entire network is carried out after performing the calculation and the results are displayed. 

4. Correction or design optimization, collision and error handling (automatic dimensioning mode solves 
standard cases to meet safety requirements but does not perform optimization and disregards the technical 
feasibility of the design).  

5. Generation of summary report of calculation, printing (export) of the design results - Print function (see 
Chap. 12), or Export (see Chap. 13). 

 
Best practice in control mode: 
 

1. Drawing of the network wiring diagram (topology) by combining the particular components in the graphics 
together (some of the demos supplied with the program can be used as an initial point). 

 Precise parameters of the inserted components must be entered.  

 Precise parameters of the user-defined components must be entered; the Dimension automatically 
switch must be disabled. 

 For more details, see Chap. 5. 
 

2. Design of network behaviour in operating state and in case of overload: calculation of Voltage drops and 
load distribution by using the Calculation function. This step is followed by checks on the calculated 
parameters - whether the requirements of the applicable standards are met. For more details, see Chap. 8.  

3. Design editing and repetition of step 2 until all components comply. It is suitable here to use the module for 
Tripping characteristics to assess the overload protection of cables (for more details see Chap. 9). 

4. Design of network behaviour at the maximum short circuit (resistance of network components to short-circuit 
currents): execution of the Check the entire network calculation: 3-phase symmetric short circuit by 
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using the Calculation function. This step is followed by checks on the calculated parameters - whether the 
requirements of the applicable standards are met. For more details, see Chap. 8.3. 

5. Design editing and repetition of step 4 until all components comply. When designing only a part of the 
network, it is possible to use the calculation of Short-circuit currents: 3-phase symmetric short circuit - 
short circuit only in a single selected network node. For more details, see Chap. 8.3. 

6. Design of network behaviour at the minimum short circuit (check for the fault disconnection time from the 
power source): execution of the Check the entire network calculation: 1-phase asymmetric short circuit 
by using the Calculation function. This step is followed by checks on the calculated parameters - whether 
the requirements of the applicable standards are met. For more details, see Chap. 8.3. 

7. Design editing and repetition of step 6 until all components comply. When designing only a part of the 
network, it is possible to use the calculation of Short-circuit currents: 1-phase asymmetric short circuit - 
short circuit only in a single selected network node. For more details, see Chap. 8.3. 

8. Selectivity assessment by means of the module for Tripping characteristics (for more details see Chap. 9), 
or by means of the special Selectivity function (selectivity comparison between two circuit-breakers based 
on selectivity tables specified in the catalogue, for more details, see Chap. 8.5). 

9. Assessment of network behaviour in various operating states - option of disconnecting individual lines 
(required in case of meshed networks supplied from several power sources, such as networks within the 
healthcare sector). It is possible to use administrator operating states (see Chap. 8.8). 

10. Generation of a summary report on the calculation, printing (export) of the design results - Print function (see 
Chap. 12), or Export (see Chap. 13). 

 
Note: the sequence of the particular steps in the control mode can be modified as desired; the process specified 
above is only the recommended procedure. For details regarding the theory of design and dimensioning of low-
voltage networks, see Part I of this document. 
 
Curve Select Mode of operation state (simplified user interface, only functions for working with tripping 
characteristics are available), the recommended procedure of operation (see also Chap. 9): 
 

1. Choosing a product from database (protection device, cable or motor). The corresponding characteristic is 
immediately drawn in the chart. 

2. Parameter setting (for example: circuit breaker releases, motor start-up time, cable mounting, etc.). 
3. Setting of incoming – outgoing device pair and evaluation of selectivity and backup protection based on 

tables. 
4. Print of a chart to a printer or export to a data file. 
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5. Network wiring diagram (topology) 
 
When designing a network, the first step consists in drawing the wiring diagram (topology). The network wiring 
diagram is defined by combining the particular components in the graphics together. Free graphics can be added 
into the drawing. The following components can be used within the programme: 
 

 

Supply network 

 

see Chap. 5.2 

 

Generator 

 

see Chap. 5.3 

 

Transformer 

 

see Chap. 5.4 

 

Network node - logical network branching    see Chap. 5.5 

 

Line – busbar trunking system 
 

 see Chap. 5.6 

 

Line - cable  see Chap. 5.7 

 

Surge arrester 

 

see Chap. 5.8 

 

Switch disconnector (the operating state of the switching 
component can be set to: on/off, thus allowing disconnection of the 
particular network lines)  

see Chap. 5.9 

 

Circuit-breaker (the operating state of the circuit-protection 
component can be set to: on/off, thus allowing disconnection of the 
particular network lines)  

see Chap. 
5.10 

 

Residual current device RCD (the operating state of the switching 
component can be set to: on/off, thus allowing disconnection of the 
particular network lines)  

see Chap. 
5.11 

 

Residual current device with overcurrent protection RCBO (the 
operating state of the switching component can be set to: on/off, 
thus allowing disconnection of the particular network lines)  

see Chap. 
5.12 

 

Overload relay 

 

see Chap. 
5.13 

 

Fuse, fuse switch (the operating state of the circuit-protection 
component can be set to: on/off, thus allowing disconnection of the 
particular network lines)  

see Chap. 
5.14 

 

Motor (direct start or star / delta start) 

 

see Chap. 
5.15 
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Motor with softstarter 

 

see Chap. 
5.15 

 

Motor with frequency invertor 

 

see Chap. 
5.15 

 

Load in general 

 

see Chap. 
5.16 

 

Load in general - socket outlet 

 

see Chap. 
5.16 

 

Load in general - outlet for lighting 

 

see Chap. 
5.16 

 

Compensation 

 

see Chap. 
5.17 

 

 

 

 

Free graphics - basic geometric figures (line, circle, rectangle, text)  see Chap. 
5.19 

 

5.1 Network type and voltage system 
 
Before starting to draw the wiring diagram, it is necessary to set the network type (TN, IT, or TT) and the voltage 
system. The network type has an impact on calculation of asymmetrical short circuits. The voltage system then 
influences currents in the network and tripping capacity of protective devices. When inserting a component into the 
wiring diagram, a check is carried out as to whether the component is suitable for the selected network voltage. 
The network type and voltage system can be changed at any later point in time using the same function. However, 
such change usually gives rise the need to modify a number of components in the wiring diagram. The initial 
network type and voltage system for a new project can be set in Options... under the Project tab (see Chap. 15.1). 
 

1. In the menu on the File tab, click on Information About Project. 
2. A dialogue panel will open on the Network and voltage system tab, in which you select the 

network type and the voltage system as necessary: Perform setting of the voltage by selection 
from the standard-defined voltage systems. If you select "Other", you can specify any other 
system by entering the combined and phase voltage. 

3. Close the dialogue panel by clicking OK. The new values set will be saved in the network project and can be 
changed any time by using the same function again. The currently set values are shown under the 
description field (title block) in the network project as follows: Network type + Voltage system: combined / 
phase voltage. 
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5.2 Supply network 
 
This component represents the supergrid network supplying power into the designed circuit. It can be a medium-
voltage network feeding the transformer, or a low-voltage network. Every network must include at least one power 
supply unit. The programme allows designing of networks supplied from one or more power sources. In addition to 
the supply network, power supply can be also provided from a generator (see Chap. 5.3). 
 

1. In the Toolbox, click on the Supply Network icon on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. On the Property Grid, enter all parameters defining the 

symbol (it is an inserted symbol, the precise parameters of which must always be entered): 

  Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the tag automatically increases. 

  Entry of the connected phase: either 3-phase connection or a single specific phase. 

  The power supply network voltage must correspond to the selected voltage system (see Chap. 5.1) and 
the connected phases (delta voltage for 3-phase connection; phase voltage for 1-phase connection). 

  How to define the supply network: 

 By short-circuit power: 

 The short circuit power output and short-circuit current are tied values, simply enter one of them 
and the other will be calculated automatically. Clicking on the button with dots to the right of the 
numeric values will display the table of typical values for different cases of power supply networks. 
In the event of absence of other data, you can use some of the offered values. The short-circuit 
power values indicated for the different cases of power supply networks are indicative only. Please 
contact the local power distribution company to obtain exact values. 
 

            
 

 The short circuit power output and short-circuit current for 1-phase short circuit does not have to be 
entered (especially for medium voltage networks). It should always be entered for 3-phase low-
voltage networks. If it is not entered, the calculation of asymmetric short-circuits will be less 
precise. At the bottom of the Property Grid the system displays informational text with a 
recommendation for users. 

 

 By impedances: 

 Effective impedance components obtained through measurement or through independent 
calculation for the supply network can be entered instead of the short-circuit power. This can 
become useful, for instance, in case of IT networks (such as health-care installations) powered 
from a TN supply network – the effective impedance components can be obtained through 
independent calculation for the TN supply network.  

 
Notes: 

 The power network may be directly connected to the transformer, or to a network node. 
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 Supply network can be connected by cable (the ratios between the supply network and the first switchboard 
must be taken into account). 

 In case of parallel feed from several power supply units into one switchboard, all supply networks must be 
connected by cable. 

      
 
 
 

5.3 Generator 
 
This component represents a generator (typically a standby power source) supplying power into the designed 
circuit. The programme allows designing of networks supplied from one or more power sources. In addition to the 
generator, power supply can be also provided from supply networks (see Chap. 5.2). The application allows you to 
simulate various operating states of the network by disconnecting power sources and loads; an operating status 
manager is available (see Chap. 8.8). 
 

1. Click on the Generator icon in the Toolbox on the Symbols tab. 
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. On the Property Grid, enter all parameters defining the 

symbol (it is an inserted symbol, the precise parameters of which must always be entered):  

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 Type designation and the parameters of the symbol: As an integral part, the programme includes a 
database of standard generators with the option of adding user-defined types. The database is 
activated by clicking on the button with the dots on the type designation line. For a description of the 
database explorer, see Chap. 10.1. 

  

     

Correct Incorrect 

Incorrect connection of 
two parallel power 

supply networks into a 
single network node 

Supply from MV 
networks 

Supply from LV 
networks 



xSpider, User’s Manual   
____________________________________________________________________________________________________  

 

 ______________________________________________________________________________________________________________________  
 

 II / 17 

 Notes: 

 It is suitable here to connect the generator by line with a circuit breaker. The programme enables the user to 
change the operating state of the circuit breaker between ON-OFF, therefore it is possible to analyse various 
network situations (with supply from a generator or with supply from a supply network); An Operation states 
manager is available (see Chap. 8.8). 

 The programme allows calculation of electrically remote short circuits only - it is not possible to calculate the 
short circuit directly on the generator terminals. 

 
 
 
 

  
 
 
 

5.4 Transformer 
 
This component represents either a distribution transformer dividing the medium-voltage supply network and the 
designed low-voltage network, or a protective isolation transformer used to build IT networks (e.g. for medical 
isolated system). 
 

1. Click on the Transformer icon in the Toolbox on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. On the Property Grid, enter all parameters defining the 

symbol (it is an inserted symbol, the precise parameters of which must always be entered): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entering the connected phase: either 3-phase connection or a single specific phase. 

 Type designation and the parameters of the symbol: As an integral part, the programme includes a 
database of standard transformers with the option of adding user-defined types. The database is 
activated by clicking on the button with the dots on the type designation line. For a description of the 
database explorer, see Chap. 10.1. 

 The transformer rated current is automatically calculated and displayed as one of the parameters. 
  

       
  

Power supply from 
generator: 

Generator 
disconnected: 

Correct Incorrect 

Incorrect connection of the generator and 
the network directly into network node. 
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Notes: 

 With its medium-voltage end, the transformer can be connected either to a supply network or to a cable (VN 
components not contained in databases) 

 With its low-voltage end, the transformer can be connected only to a cable or a busbar system. The 
transformer cannot be connected directly to the "Network Node", or "Circuit Breaker" component. 

 The computational node is always located on the transformer’s low-voltage side; calculation results shown 
for the transformer always relate to the low-voltage side. 

 Primary voltage Ur1 must match the voltage of the supergrid supply network precisely. Secondary voltage 
Ur2 must correspond to the selected voltage system (see Chap. 5.1) and the connected phases (delta 
voltage for 3-phase connection; phase voltage for 1-phase connection). 

        
 
 
 

5.5 Network node 
 
The network node is represented by any logical branching of network implemented e.g. as a bus or terminal, 
terminal bar etc. It is a component with negligible impedance. Network branching is possible only at this 
component. The component must not be an end-component in the network - at least two additional components 
must be connected to it. 
 

1. In the Toolbox, click on the Network node icon on the Symbols tab.  
2. Click the first point of the line representing the network node component in the diagram. The clicked 

point will be automatically captured in the grid (coloured dots in the graphics area). 
3. Now drag the radius vector - the line representing the Network Node component in the diagram. The line can 

be horizontal only. Drawing from the left to the right is presumed. Click the end point of the line representing 
the network node component in the diagram. The clicked point will be automatically captured in the grid 
(coloured dots in the graphics area) in such a way to ensure that the line is parallel to the X axis. 

4. The inserted symbol is automatically selected. On the Property Grid, enter all parameters defining the 
symbol (it is an inserted symbol, the precise parameters of which must always be entered): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 The power supply network voltage must correspond to the selected voltage system (see Chap. 5.1) (it is 
automatically pre-filled) and the connected phases (delta voltage for 3-phase connection; phase voltage 
for 1-phase connection). 

 Maximum permitted voltage drop in this network node with respect to the power supply voltage; it is 
possible to select one of the values prescribed by the standard (see Part I, Chap. 4), or to enter any 
desired value. Calculation of voltage drops is followed by a check whether the calculated drop exceeds 
the limit value set here. The default value for new project is specified by the Options function on the 

Correct Correct Incorrect Incorrect 

The calculation results are related to 
the low voltage side of the transformer. 
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Wiring diagram tab. The default value for the current project can be set by the function Information 
About Project, Wiring diagram. tab. 

 Simultaneous factor - defines simultaneity of withdrawals from the node (the ratio between the number 
of devices in operation and the total number of devices). Example: there are 3 outlets connected to a 
node = 3 loads with a nominal current of 100A, 500A, 1000A, and a simultaneous factor was defined as 
Ks=0.5; the current flowing to the node is 0.5x (100+500+1000) = 800A.  

 The simultaneous factor is taken into account only with radial networks. 

 The simultaneous factor is ignored with meshed networks. 
 

   
 
 
 
 
 
 
 
 
 

  
 
 
 

5.6 Lines - busbar systems 
 
This component represents a line executed as an enclosed busbar distribution system. Power is transferred from 
the initial point to the end point. Taps or network branching are not possible along the component (use the 
“Network node” component for network branching - see Chap. 5.5).  
 

1. In the Toolbox, click the Line - Busbar Trunking Systems (BTS) on the Symbols tab.  
2. Click the first point of the line representing the line component in the diagram. The clicked point will 

be automatically captured in the grid (coloured dots in the graphics area). 

The blue line represents Network Node symbol in the diagram. Position and 
length of the line can be subsequently changed - see Chap. 6. The line can be 
horizontal only. 

2. Click the endpoint (drawing from left to right is assumed). The length of the 
line must be greater than the distance between two adjacent dots of the grid. 

1. Click the starting point. 

Network node design marking. Placed automatically at the first clicked 
point, its position can be changed subsequently - see Chap. 6. 

Proper branching on the 
network node 
component. 

Inadmissible branching 
off the network element 

node. 

Inadmissible network 
branching on MV side. 

Correct Incorrect Incorrect 

At least 2 other 
components must be 
connected to each 
network node component. 
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3. Now drag the radius vector - the line representing the line component in the diagram. The system 
automatically enables Orto tool allowing drawing only in parallel to the X or Y axis (can be turned off using 
the F8 key or switch in the menu - see Chap. 5.20). Click the line breakpoint. The clicked point will be 
automatically captured in the grid (coloured dots in the graphics area). 

4. Repeat step 3 until you draw the entire line curve. Every line section must exceed the distance between two 
adjacent grid dots. The line must include at least two points (the beginning and the end) clicked by the left 
mouse button. 

5. Click the right mouse button to complete the definition of the line shape. 
6. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining the 

component. It is a custom component.  

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entering the connected phase: either 3-phase connection or a single specific phase. 

 Line length – this has a major impact on the calculation and must be entered as accurately as possible.  

 Number of parallel branches - the number of parallel branches of the line protected by a common 
protective device. 

 Maximum voltage drop on the line; You can choose from a standard set of values (see Part I. Chap. 4), 
or enter any value. Calculation of voltage drops is followed by a check whether the calculated drop 
exceeds the limit value set here. The default value for new project is specified using the Options 
function on the Wiring diagram tab. The default value for the current project can be set using the 
function Information About Project, Wiring diagram tab. 

 Method of installation and ambient temperature - limits the current-carrying capacity of the line. 

 Type designation and the parameters of the line: As an integral part, the programme includes a 
database of Eaton busbar systems and products with the option of adding user-defined types. The 
database is activated by clicking on the button with the dots on the type designation line. For a 
description of the database explorer, see Chap. 10.1. 

 Current capacity with regard to installation is automatically calculated and displayed on the Property 
grid. 

 If you use the program in the design mode and leave the Dimension automatically switch turned on, 
then it is not necessary to select a specific product type (it will be determined automatically after the 
function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

 
Notes: 

 The line must not be an end-component in the network - at least one additional component must be 
connected to every end of the line. Taps or network branching are not possible along the component (use 
the “Network node” component for network branching - see Chap. 5.5). 

 
 
 

   
 
 
 
 
 
 
 
 

1. The first point - beginning of the line (left click). 

4. The fourth point - end of the line - after clicking on this point 
end the line drawing with a right click. 

2. The second point - break on the line (left click). 

3. The second point - break on the line (left click). 

Tag placed automatically at the first clicked point (start of the line), its position can be 
changed subsequently - see Chap. 6.4. 

At the beginning of the line there is a protection component (in this case, it is a circuit breaker). 

At the end of the line there is a load in this case. 

Line curve - encapsulated busbar distribution - shown in the 
diagram with dark green colour. 
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5.7 Line - cable 
 
This component represents a line executed as a cable, a group of single-core cables or an overhead line. Power is 
transferred from the initial point to the end point. Taps or network branching are not possible along the component 
(use the “Network node” component for network branching - see Chap. 5.5). 
 

1. In the Toolbox, click the Line - Cable on the Symbols tab.  
2. Click the first point of the line representing the line component in the diagram. The clicked point will 

be automatically captured in the grid (coloured dots in the graphics area). 
3. Now drag the radius vector - the line representing the line component in the diagram. The system 

automatically enables Orto tool allowing drawing only in parallel to the axis X or Y (can be turned off using 
the F8 key or switch in the menu - see Chap. 5.20). Click the line breakpoint. The clicked point will be 
automatically captured in the grid (coloured dots in the graphics area). 

4. Repeat step 3 until you have drawn the entire line curve. Every line section must exceed the distance 
between two adjacent grid dots. The line must include at least two points (the beginning and the end) clicked 
using the left mouse button. 

5. Click the right mouse button to complete the definition of the line shape. 
6. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining 

component. It is a custom component. 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 Line length – this has a major impact on the calculation and must be entered as accurately as possible.  

 Number of parallel branches - the number of parallel branches of line protected by a common protective 
device. 

 The maximum voltage drop on this line; you can choose from a standard set of values (see Part I, 
Chap. 4), or to enter any desired value. Calculation of voltage drops is followed by a check whether the 
calculated drop exceeds the limit value set here. The default value for new project is specified by 
Options function on the Wiring diagram tab. The default value for the current project can be set by the 
function Information About Project, Wiring diagram tab. 

 The method of installation limits the current carrying capacity of the line. 

 After clicking on the button with dots to the right of the text the system displays a table of all possible 
methods of installations given by the IEC 60364-5-52 (DIN 33 2000-5-52) standard and line 
configuration for groupings (for different installations, there are various groupings; grouping influence 
is reflected in the case of multiple parallel branches, or if the number of additional circuits in the 
grouping is greater than zero). 

 The number of other circuits within the grouping is the number of other cables located in the 
grouping together with the designed circuit. The total number of circuits within the grouping is 

The line is not protected. 
There is nothing connected at the end of 

the line. 

Inadmissible branching 
off the network element 

node. 

Incorrect Incorrect 
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determined by the number of parallel lines in the designed circuit + the number of other circuits. If 
the cable is lead separately, leave the value 0. 

 As for the ambient temperature, the maximum temperature of ambient air or of the surrounding soil 
which can occur during the operation of the equipment must be entered. For more details, see the 
theoretical introduction - Part I. Chap. 2.2. The specific thermal resistance of ground can be also set 
for the D-type installation. 

 The user coefficient allows you to take other factors into account or to solve situations not described 
in the IEC standards. By means of this coefficient, it is possible to increase or reduce the cable 
current-carrying capacity in any way. Use of this coefficient is in the sole responsibility of the user. 

 The programme addresses only the cases described in IEC 60364-5-52. However, it may be a useful 
aid also for those cases that it does not explicitly mention, because you can choose some close 
variant and on its basis, estimate the case that we need to solve, or to make a correction by means 
of the user coefficient. 

 Type designation and the parameters of the line: As an integral part, the programme includes a 
database of standard cables with the option of adding user-defined types. The database is activated by 
clicking on the button with the dots on the type designation line. For a description of the database 
explorer, see Chap. 10.1. 

 The number of wires must correspond to the number of connected phases (3-phase connection: 4 
and more wires, 1-phase connection: 2 or 3 wires). 

 Rated current of the cable for installation in the air. For the cables from the master database, this is 
calculated from the tables given by the standard on the basis of the conductor material and 
insulation. The specified value will be used for user-defined cables. This allows you to define cables 
with greater current carrying capacity than imposed by the standard. The user is then responsible for 
the correctness of the entered value. 

 If you use the program in the design mode and leave the Dimension automatically switch turned 
on, then it is not necessary to select a specific product type (it will be determined automatically after 
the function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

 Current capacity with regard to installation is automatically calculated and displayed on the Property 
grid 

 
Notes: 

 The line must not be an end-component in the network - at least one additional component must be 
connected to every end of the line. Taps or network branching are not possible along the component (use 
the “Network node” component for network branching - see Chap. 5.5). 

 
 
 

      
 
 
 
 
 
 
 
 
 
 
 

1. The first point - beginning of the line (left click). 

4. The fourth point - end of the line - after clicking on this point 
end the line drawing with a right click. 

2. The second point - break on the line (left click). 

3. The second point - break on the line (left click). 

Design designation of the line placed automatically at the first clicked point (start of the 
line), its position can be changed subsequently - see Chap. 6.4. 

At the beginning of the line there is a protective component 
t

At the end of the line there is a load in this case. 
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5.8 Surge arresters 
 
This protective component serves to protect installations against surge effects. 
 

1. Click on the Surge Arrester icon in the Toolbox on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining component 

(this is a custom component): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 Type designation and the parameters of the symbol: The programme includes a database of Eaton 
surge arresters. The database is activated by clicking on the button with the dots on the type 
designation line. For a description of the database explorer, see Chap. 10.1. 

 
Notes: 

 The surge arrester must be connected by a cable and protected (usually by a fuse) according to the 
manufacturer´s conditions. 

 To insert a branch with surge arrester it is advisable to use a predefined group (in the Toolbox on the 
Outlets tab). 

5.9 Switch-disconnector 
 
The switch-disconnecting component is designed for disconnection of the individual network lines and monitoring of 
the network behaviour under various operating states. It is used in situations where the use of a circuit-protection 
component is unnecessary. The switch-disconnector will not switch off the short circuit, but it must withstand the 
short-circuit current until the moment it is switched off. The rated current In and the short-time one-second withstand 
current Icw are checked during the calculations. 
 

1. Click on the Switch-disconnector icon in the Toolbox on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining component 

(this is a custom component): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

The line is not protected. 
At the end of the line there is nothing 

connected. 

Inadmissible branching of 
the network off the network 

node component. 

Incorrect Incorrect 
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 Setting the operating state of the on/off switching component; option of disconnecting branches and 
monitoring of various operating states of networks. 

 Type designation and the parameters of the symbol: The programme includes a database of Eaton 
switch-disconnectors. The database is activated by clicking on the button with the dots on the type 
designation line. For a description of the database explorer, see Chap. 10.1. 

 The number of poles of the equipment must correspond to the number of connected phases. 

 Rated voltage indicates the maximum voltage for which the component can be used (must be equal to 
or greater than the network voltage). 

 If you use the program in the design mode and leave the Dimension automatically switch turned on, 
then it is not necessary to select a specific product type (it will be determined automatically after the 
function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

 

Notes: 

 The line must always be connected from one side of the switching component. Correct connection of the 
switching element is subject to the same rules as those for a circuit breaker, see Chap. 5.10. 

5.10 Circuit breaker 
 
The circuit-breaker type protection component is used to protect lines. A circuit-protection component should be 
connected to one of the ends of every line. The operating state of the circuit-protection component can be set to: 
on/off, thus allowing disconnection of the particular network lines and monitoring of network behaviour in different 
operating states. 
 

1. Click on the Circuit-breaker icon in the Toolbox on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining component 

(this is a custom component): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 The maximum disconnection time from the point of view of protection against indirect contact with 
exposed conductive parts - pursuant to IEC 60364-4-41 (see Part I, Chap. 3.7). From the list, select one 
of the values provided for by the standard or enter any number. Following the 1-phase short circuit 
calculation, a check is carried out as to whether the circuit breaker will switch off the failure faster, i.e. 
before the limit time set here. The default value for new project is specified by Options function on the 
Wiring diagram tab. The default value for the current project can be set by the function Information 
About Project, Wiring diagram tab. 

 Setting the operating state of the on/off switching component; option of disconnecting branches and 
monitoring of various operating states of networks. 

 Determining which of the parameters of the circuit breaker will be taken into account when checking for 
load with short-circuit current: 

 Operating tripping capacity Ics - this short circuit current can be tripped by the circuit-breaker 
repeatedly without damage. 

 Ultimate tripping capacity Icu - this short circuit current can be tripped by the breaker, but can be 
damaged. 

 The default value for new project is specified by Options function on the Wiring diagram tab. The 
default value for the current project can be set by the function Information About Project, Wiring 
diagram tab. 

 Type designation and the parameters of the symbol: The programme includes a database of Eaton 
circuit breakers. The database is activated by clicking on the button with the dots on the type 
designation line. For a description of the database explorer, see Chap. 10.1. 

 The number of poles of the equipment must correspond to the number of connected phases. 

 Rated voltage indicates the maximum voltage for which the component can be used (must be equal 
to or greater than the network voltage). 
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 The switching capacity of some circuit-breaker types depends on the voltage of the network, in which 
the component is connected. When selecting the component from the database, the system will 
automatically select the switching capacity corresponding to the selected voltage system (see Chap. 
5.1). 

 If the circuit breaker is equipped with adjustable releases, a modification of their settings is possible 
under the Releases tab. All control features of the releases are set to the maximum value by default. 

 With the module for Tripping characteristics (see Chap.15), it is possible to view the tripping 
characteristics including the impact of the release settings (to assess the selectivity or overload 
protection). 9). 

 

 
 

 Evaluation of selectivity can also be carried out using the special Selectivity function (selectivity 
comparison of two circuit-breakers based on selectivity tables specified in the catalogue, for more 
details, see Chap. 8.5). 

 If you use the program in the design mode and leave the Dimension automatically switch turned 
on, then it is not necessary to select a specific product type (it will be determined automatically after 
the function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

L 

I 

G 

S 



 xSpider, User’s Manual 
 __________________________________________________________________________________________________ 
 

 ______________________________________________________________________________________________________________________  
 

 II / 26 

Notes: 

 A line must always be connected to one side of every circuit breaker. 

 The design includes backup protection (cascading), circuit-breaker / fuse (the fuse serves as backup 
protection of the circuit breaker). 

 The design includes backup protection (cascading) fuse / circuit breaker - see Chap. 8.5. 
 
 
 
 
 

  
 
 
 
 
 

5.11 Residual current device 
 
The residual current protection device component serves as protection of persons against direct contact with live 
parts and a protection against fire and protection of non-live parts by automatic disconnection from the source of 
power supply.  
 

1.  In the Toolbox, on the Symbols tab, click the Residual current device.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining component 

(this is a custom component): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 Setting the operating state of the on/off switching component; option of disconnecting branches and 
monitoring of various operating states of networks. 

 Type designation and the parameters of the symbol: The programme includes a database of Eaton 
RSDs. The database is activated by clicking on the button with the dots on the type designation line. For 
a description of the database explorer, see Chap. 10.1. 

 The number of poles of the equipment must correspond to the number of connected phases. 

 Rated voltage indicates the maximum voltage for which the component can be used (must be equal 
to or greater than the network voltage). 

 If you use the program in the design mode and leave the Dimension automatically switch turned 
on, then it is not necessary to select a specific product type (it will be determined automatically after 
the function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

 
Notes: 

 Correct connection of the switching element is subject to the same rules as those for a circuit breaker, see 
Chap. 5.10. 

 The residual current device must be protected against overload and short circuit with suitable primary 
protection. 

Correct Incorrect 

Correct design of 
busbar coupling 

Unacceptable circuit breaker 
connection between the 

network node. 

A cable, even 
with large cross-
section and 
minimum length, 
must always be 
present. 

Circuit breaker on. 

Circuit breaker off. 
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5.12 Residual current device with overcurrent protection 
 
The residual current device with overcurrent protection RCBO (combination of residual current device (RCD) + 
circuit breaker (CB)) serves as personal protection against direct contact with live parts, protection against fire, 
protection of non-live parts by automatic disconnection from the source of power supply, as well as line protection 
from the effects of overcurrent and short circuit.  
 

1. In the Toolbox, on the Symbols tab, click the RCBO (combined RCD+MCB) device.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining the 

component (this is a custom component): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 The maximum disconnection time from the point of view of protection against indirect contact with 
exposed conductive parts - pursuant to IEC 60364-4-41 (see Part I, Chap. 3.7). From the list, select one 
of the values provided for by the standard or enter any number. Following the 1-phase short circuit 
calculation, a check is carried out as to whether the circuit breaker will switch off the failure faster, i.e. 
before the limit time set here. The default value for new project is specified by Options function on the 
Wiring diagram tab. The default value for the current project can be set by the function Information 
About Project, Wiring diagram tab. 

 Setting the operating state of the on/off switching component; option of disconnecting branches and 
monitoring of various operating states of networks. 

 Type designation and the parameters of the symbol: The programme includes a database of Eaton 
RCBO (combined RCD/MCB) devices. The database is activated by clicking on the button with the dots 
on the type designation line. For a description of the database explorer, see Chap. 10.1. 

 The number of poles of the equipment must correspond to the number of connected phases. 

 Rated voltage indicates the maximum voltage for which the component can be used (must be equal 
to or greater than the network voltage). 

 With the module for Tripping characteristics (see Chap. 9), it is possible to view the tripping 
characteristics (to assess the selectivity or overload protection). 

 Evaluation of selectivity can also be carried out using the special Selectivity function (selectivity 
comparison of two circuit-breakers based on selectivity tables specified in the catalogue, for more 
details, see Chap. 8.5). 

 If you use the program in the design mode and leave the Dimension automatically switch turned 
on, then it is not necessary to select a specific product type (it will be determined automatically after 
the function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

 
Notes: 

 The line must always be connected from one side of the switching component. Correct connection of the 
switching element is subject to the same rules as those for a circuit breaker, see Chap. 5.10. 

 The design includes backup protection (cascading), circuit-breaker/fuse (the fuse serves as backup 
protection of the circuit breaker). 

 The design includes backup protection (cascading) fuse / circuit breaker - see Chap. 8.5. 

5.13 Overload relay 
 
Overload relay is used to protect motors from the effects of overcurrent. Short-circuit protection must be ensured 
using another suitable device (circuit breaker, fuse). 
 

1. Click on the Overload relay icon in the Toolbox on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining 
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component (this is a custom component): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 The maximum disconnection time from the point of view of protection against indirect contact with 
exposed conductive parts - pursuant to IEC 60364-4-41 (see Part I, Chap. 3.7). From the list, select one 
of the values provided for by the standard or enter any number. Following the 1-phase short circuit 
calculation, a check is carried out as to whether the circuit breaker will switch off the failure faster, i.e. 
before the limit time set here. The default value for new project is specified by Options function on the 
Wiring diagram tab. The default value for the current project can be set by the function Information 
About Project, Wiring diagram tab. 

 Type designation and the parameters of the symbol: The programme includes a database of Eaton 
overload relays. The database is activated by clicking on the button with the dots on the type 
designation line. For a description of the database explorer, see Chap. 10.1. 

 The number of poles of the equipment must correspond to the number of connected phases. 

 Rated voltage indicates the maximum voltage for which the component can be used (must be equal 
to or greater than the network voltage). 

 With the module for Tripping characteristics (see Chap. 9), it is possible to view the tripping 
characteristics (to assess the selectivity). 

 If you use the program in the design mode and leave the Dimension automatically switch turned 
on, then it is not necessary to select a specific product type (it will be determined automatically after 
the function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

5.14 Fuse 
 
The fuse type protection component is used to protect lines. A circuit-protection component should be connected to 
one of the ends of every line. The operating state of the circuit-protection component can be set to: on/off, thus 
allowing disconnection of the particular network lines and monitoring of network behaviour in different operating 
states. 
 

1. Click on the Fuse icon in the Toolbox on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. In the Property grid, enter all parameters defining component 

(this is a custom component): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 The maximum circuit-breaker disconnection time from the point of view of protection against indirect 
contact with exposed conductive parts - pursuant to IEC 60364-4-41 (see Part I, Chap. 3.7). From the 
list, select one of the values provided for by the standard or enter any number. Following the 1-phase 
short circuit calculation, a check is carried out as to whether the circuit breaker will switch off the failure 
faster, i.e. before the limit time set here. The default value for new project is specified by Options 
function on the Wiring diagram tab. The default value for the current project can be set by the function 
Information About Project, Wiring diagram tab. 

 Setting the operating state of the on/off switching component; option of disconnecting branches and 
monitoring of various operating states of networks. 

 Type designation and the parameters of the symbol: The programme includes a database of Eaton 
fuses. The database is activated by clicking on the button with the dots on the type designation line. For 
a description of the database explorer, see Chap. 10.1. 

 Rated voltage indicates the maximum voltage for which the component can be used (must be equal 
to or greater than the network voltage). 

 The breaking capacity applies for the full voltage range up to Un. 

 With the module for Tripping characteristics (see Chap. 9), it is possible to view the tripping 
characteristics (to assess the selectivity or overload protection). 9). 
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 Evaluation of selectivity can also be carried out using the special Selectivity function (selectivity 
comparison of two circuit-breakers based on selectivity tables specified in the catalogue, for more 
details see Chap. 8.5). 

 If you use the program in the design mode and leave the Dimension automatically switch turned 
on, then it is not necessary to select a specific product type (it will be determined automatically after 
the function of Cable and protective devices dimensioning is activated - see Chap. 8.11). 

 
Notes: 

 A line must always be connected to one side of the fuse (similarly to circuit breakers, see Chap. 5.10). 

 The design includes circuit breaker / fuse backup protection (cascading). 

5.15 Motor 
 
This component represents a rotary (motor) load consuming power from the designed circuit (typically an 
asynchronous motor). It is an end-type network component, which must always be connected at the end of the line. 
 

1. Click on the Motor icon in the Toolbox on the Symbols tab. Individual variants differ in the 
shape of the mark and the method of connection of the motor to the network (direct connection / 
soft starter / frequency converter). A motor with a direct connection responds to short-circuit by 
supplying power to the shorted circuit and thus contributes to an increased short circuit current. 

2. Click the symbol position in the graphics area of the project window. The insertion point will be 
automatically captured in the grid (coloured dots in the graphics area). 

3. The inserted symbol is automatically selected. On the Property Grid, enter all parameters 
defining the symbol (it is an inserted symbol, the precise parameters of which must always be entered): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 Operating status: stable operation or start (allows calculation of network behaviour at motor start-up). 

 Type designation and the parameters of the symbol: As an integral part, the programme includes a 
database of standard motors with the option of adding user-defined types. The database is activated by 
clicking on the button with the dots on the type designation line. For a description of the database 
explorer, see Chap. 10.1. 

 The number of poles of the equipment must correspond to the number of connected phases. 

 Rated voltage of the component must correspond to the number of connected phases (3-phase 
connection - delta voltage; 1-phase connection - phase voltage) and to the selected voltage system 
(see Chap. 5.1). 

 Utilisation factor defines to what extent the motor is subject to load during ordinary operation (the 
default value is 1 – the motor is subject to load up to 100%). Example: The project utilises a motor with 
an output of 7.5kW, in normal mode it is subject to load at a maximum of 80% - utilisation factor Ku = 
0.8. The utilisation factor is taken into account only with radial networks and meshed networks. 

 Maximum voltage drop - the highest voltage drop allowed in this network node with respect to the power 
supply voltage; it is possible to select one of the values prescribed by the standard (see Part I, Chap. 4), 
or to enter any desired value. Calculation of voltage drops is followed by a check whether the calculated 
drop exceeds the limit value set here. The default value for new project is specified by Options function 
on the Wiring diagram tab. The default value for the current project can be set by the function 
Information About Project, Wiring diagram tab. 

 The entered current and output values are checked for consistence. An error message is generated in 
case of any inconsistency. This message can be ignored if we need to design the network state at the 
moment of motor startup and if we temporarily increase the rated current up to the value of the starting 
current, or it can be ignored in case of a minor inconsistence caused by rounding. 

 
Notes: 

 The motor is an end-type network component, which must always be connected at the end of the line. 

 The motor can be connected to only one line (the network branching is ensured by "network node" 
component, see Chap. 5.5). 
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5.16 Load 
 
This component represents a general stationary (non-motor) load consuming power from the designed circuit 
(typically lighting, heaters, socket circuits etc.). This is an end-type network component, which can always be 
connected at the end of the line or directly to the network node. 
 

1. Click on the Load... icon in the Toolbox on the Symbols tab. The individual variants differ only 
in the shape of the mark (they are identical in terms of calculation). 

2. Click the symbol position in the graphics area of the project window. The insertion point will be 
automatically captured in the grid (coloured dots in the graphics area). 

3. The inserted symbol is automatically selected. On the Property Grid, enter all parameters 
defining the symbol (it is an inserted symbol, the precise parameters of which must always be 
entered): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 Rated voltage of the component must correspond to the number of connected phases (3-phase 
connection - delta voltage; 1-phase connection - phase voltage) and to the selected voltage system 
(see Chap. 5.1). 

 Load definition method: by rated power or nominal current (the second parameter is calculated 
automatically additionally). 

 Power factor specifies the type of load (prevailing resistive load – the higher the value, prevailing motor 
load – the lower value).  

 Load character: inductive or capacitive. 

 Utilisation factor defines to what extent a load is loaded during ordinary operation (the default value is 
1 – the load is loaded at 100%). Example: a general load is constituted by a socket circuit composed of 
10 sockets with 16A each. The nominal current of such load is In=10x16=160A; however, the 
simultaneous consumption is max. 10%. This means that the utilisation factor is Ku=0.1. The utilisation 
factor is taken into account only with radial networks and meshed networks. 

 The maximum voltage drop - the highest voltage drop allowed in this network node with respect to the 
power supply voltage; it is possible to select one of the values prescribed by the standard (see Part I, 
Chap. 4), or to enter any desired value. Calculation of voltage drops is followed by a check whether the 
calculated drop exceeds the limit value set here. The default value for new project is specified by 
Options function on the Wiring diagram tab. The default value for the current project can be set by the 
function Information About Project, Wiring diagram tab. 

 

Defective wiring of motors 
without the use of the line 

Correct wiring of motors at 
the end of line 

Correct Incorrect Incorrect Incorrect 

Inadmissible branching of 
the network off the network 

node component. 
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Notes: 

 The load is an end-type network component, which can always be connected at the end of the line or directly 
to the network node. 

 The load can be connected to only one line (the network branching is ensured by "network node" 
component, see Chap. 5.5). 

 
 
 
 
 

         
 
 

5.17 Compensation 
 
This component represents a load constituted by a compensation condenser. It is an end-type network component, 
which can always be connected at the end of the line or directly to the network node. 
 

1. Click on the Compensation icon in the Toolbox on the Symbols tab.  
2. Click the symbol position in the graphics area of the project window. The insertion point will be 

automatically captured in the grid (coloured dots in the graphics area). 
3. The inserted symbol is automatically selected. On the Property Grid, enter all parameters defining the 

symbol (it is an inserted symbol, the precise parameters of which must always be entered): 

 Tag identifies the symbol in the project; it must be unique within the entire project; when entering a new 
symbol, the number in the Tag automatically increases. 

 Entry of the connected phase: either 3-phase connection or a single specific phase. 

 Type designation and the parameters of the symbol: As an integral part, the programme includes a 
database of standard compensation condensers with the option of adding user-defined types. The 
database is activated by clicking on the button with the dots on the type designation line. For a 
description of the database explorer, see Chap. 10.1. 

 The number of poles of the equipment must correspond to the number of connected phases. 

 Rated voltage of the component must correspond to the number of connected phases (3-phase 
connection - delta voltage; 1-phase connection - phase voltage) and to the selected voltage system. 

 The connection of condensers must correspond to the number of connected phases (3-phase 
connection - star or delta connection; 1-phase connection - star connection). 

 The entered output and capacity values are checked for consistence. In case of minor inconsistence 
caused by rounding, it is possible to ignore the warning message. 

 
Notes: 

 Compensation is an end-type network component, which can always be connected at the end of the line or 
directly to network node (similarly to loads, see Chap. 5.16). 

 The compensation can be connected to only one line (the network branching is ensured by "network node" 
component, see Chap. 5.5). A line must be always present between a circuit-protection component and a 
compensation (similarly to loads, see Chap. 5.16). 

Erroneous wiring of loads 
directly to circuit breaker 

elements 

Correct connection of 
loads directly to the 

network node 

Correct wiring of loads at 
the end of line 

Correct Correct Incorrect Incorrect 

Inadmissible branching of 
the network off the network 

node component. 
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 After the calculation of the voltage drop and the load distribution (calculation through admittance matrix), the 
power factor is displayed in the 3-phase network nodes consisting in the "Network node". The programme 
does not allow the user to enter the target power factor; the required compensation volume must be 
determined by trial and error through successive insertion of various-size condensers. The possibility of 
changing the operating state of switching and protective devices can be used to an advantage for successive 
connection of the individual condensers. 

5.18 Group 
 
The Group function allows insertion of typical groups of components forming a part of the wiring diagram. 
Therefore, a group of components comprising the power supply (network, transformer, cable, protection) or an 
outlet to the load (protection, cable, load) etc. can be created with a single mouse click. 
 

1. Display Tool Box, if not already displayed: 

 Click on the Show Tool Box on the View tab. 
2. In the Tool Box, select the tab that contains the desired group (either on the 

left side or from the list at the top of the Tool Box) 

 Favourites - a selection of frequently used groups and components. 

 Power Groups - the power groups (network, transformer, cable, 
protection). 

 Coupling groups - connection groups (line, protection). 

 Outlet groups - outlets to loads (protection, cable, load). 

 Symbols - a complete set of symbols of the wiring diagram 
3. Click on the image of the required group. 

 The cross shows the position of the insertion point of the group. The 
position of this point must be clicked in the graphics area of the window with the project. 

4. Click the group position in the graphics area of the project window. The insertion point will be automatically 
captured in the grid (coloured dots in the graphics area). 

5. Repeated insertion of the same group is the fastest via the context menu that appears after clicking the right 
mouse button in the graphics area of the window with the project - the first item in the context menu repeats 
the last performed function. 

6. Now set the properties of the individual component groups. To go to the properties editing mode as fast as 
possible, click on the respective component (see Chap. 6.1). 

Notes: 

 Groups are only offered for typical combinations of components. Any other combinations must be composed 
by separate insertion of individual components (The Symbols tab in the Tool Box, see Chap. 5.2-5.17). 

 In case of repeated occurrence of component groups, the parameters of which differ only very slightly (such 
as several motor outlets differing only in the cable length), it is more suitable to insert only one group, set the 
parameters of all its components and then copy this group (see Chap. 6.3). 

5.19 Free graphics 
 
The term “free graphics” includes a group of functions allowing the user to add the basic graphical entities into the 
network wiring diagram, such as a line, rectangle, circle and text. In this way it is possible e.g. to add notes to 
network connection, separate the individual enclosures, indicate the flow of energy in various operating states of 
the network etc. The functions are available in the menu on the Home tab, in the Draw group. 

5.19.1 Line 
 

1. In the menu on the Home tab, in the Draw group, click the Line icon. 
2. Click the initial point of the line (point B1).  
3. Now drag the radius vector - a curve representing the future line. Click the end point 

of the line (point B2). The line is now inserted in the diagram.  
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5.19.2 Rectangle 
 

1. In the menu on the Home tab, in the Draw group, click the Rectangle icon. 
2. Click one corner of the rectangle (point B1).  
3. Now drag the shape representing the future rectangle. Click the 

opposite corner of the rectangle (point B2). 
4. The rectangle is now inserted in the diagram.  

5.19.3 Circle 
 

1. In the menu on the Home tab, in the Draw group, click the Circle icon. 
2. Click the centre of the circle (point B1).  
3. Now drag the shape representing the future circle. Click the point representing the 

radius of the circle (point B2).  
4. The circle is now inserted in the diagram.  

5.19.4 Text 
 

1. In the menu on the Home tab, in the Draw group, click the Text icon. 
2. Click the bottom left corner of the text (point B1).  
3. A dialogue panel will open, in which you enter the text string and the font height: 
4. The text is now inserted in the diagram. 

5.20 Drawing aids 
 
When creating a wiring diagram and pasting free graphics, tools for drawing are applied. Each of the aids can be 
turned on / off via: 

 Switches in the menu on the Home tab in the Drawing aids section;  
 Switches in the status bar; 
 Keyboard shortcuts. 

 
Setting the parameters for each of the aids is possible using the Drawing aids dialogue box. It appears after clicking 
on the icon at the bottom of the menu on the Home tab, Drawing aid section: 
 

 
 
Overview of tools for drawing: 

 Osnap - Allows automatic grabbing of important points of the existing components (endpoint of lines, half of 
lines, centre of circles). Keyboard shortcut for switching F3. 

 Grid - a mesh of dots filling the drawing area and allowing easier orientation. Keyboard shortcut for switching 
F7. Setting the grid density (distance of dots) can be performed using the Drawing Aids dialogue box. 

 Ortho - locking the pointer movement within the direction of the coordinate axes. With Ortho turned on, only 
horizontal or vertical lines can be drawn for instance. When drawing symbols Network node, Line – busbar 
trunking system or Line - cable in the wiring diagram Ortho is automatically switched on. After edit it is 
automatically reverted back to previous setting before edit. Keyboard shortcut for switching F8. 

 Snap - automatic capturing of the clicked point to the tops of the invisible grid with the given spacing. When 
drawing or editing symbols in the wiring diagram Snap is automatically switched on. After edit it is 
automatically reverted back to previous setting before edit. Keyboard shortcut for switching F9. Setting the 
grid density can be performed using the Drawing Aids dialogue box. 
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6. Editing the Network Wiring Diagram 

6.1 Editing properties  
 
The term “editing properties” shall be understood to mean modification of all geometric properties (position, 
dimensions) as well as non-geometric properties (colour, line thickness and type, electrical parameters) of a 
component forming part of the network wiring diagram. Geometric properties can be edited with grips or using 
special editing functions (Erase, Move, Copy, Stretch). To edit non-geometric properties, it is necessary to first 
select a component and then edit individual properties in the Property Grid. 

6.1.1 Selection of components for editing 
 
The method of selecting components for editing can be set: 
 

1. Click the Options… icon in the menu on the File tab. 
2. Set the desired selection method in the Wiring diagram tab of the dialogue box which subsequently opens: 

 Single-select mode: 

 Only one component is selected by default: Clicking deselects the previously selected component (or 
components) and selects only the component that was clicked. 

 Selection of components: Press the Shift key and hold it down and click on another component. 

 After deselecting a component: Press the Shift key and hold it down and click on the already 
selected component. 

 After deselecting all the components: press the Esc key. 

 This mode is typically used, for example, in Microsoft Office applications. 

 The setting affects both selection of components with grips and selection of components within the 
special editing functions (Erase, Move, Copy, Stretch). 

 

 Multi-select mode: 

 Click to select this component. The previously selected component (or components) remain(s) 
selected. 

 After deselecting a component: Press the Shift key and hold it down and click on the already 
selected component. 

 After deselecting all the components: press the Esc key. 

 This mode is typically used in CAD systems. 

 The setting affects both selection of components with grips and selection of components within the 
special editing functions (Erase, Move, Copy, Stretch). 

 

 Combined mode: 

 A combination of the previous two methods: 

 For selection of components with grips, simple selection mode is used (clicking deselects the 
previously selected component (or components) and selects only the component that was clicked 
on. 

 Selection in the framework of the special editing functions (Erase, Move, Copy, Stretch) is facilitated 
by multiple selection (this component is selected by clicking on it, the previously selected component 
(or components) remain(s) selected). 

 After deselecting a component: Press the Shift key and hold it down and click on the already 
selected component. 

 After deselecting all the components: press the Esc key. 

 This mode is set as the default in the xSpider application. 
 

3. Close the dialogue panel by clicking OK. An application restart is required. The application will now close. 
Restart it in the usual way. The setting remains in effect until further notice. 
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Independently of the above-mentioned settings, you can select multiple components at once using the selection 
windows: 
 

1. Window type type selection window: 

 Click on a place where no component is located (point B1) - thus activating the selection window. 

 Move the mouse to the right from the first clicked point to drag a blue window type selection window 
(only components lying fully within the window will be selected). 

 Click the opposite corner of the window (point B2). The selected components will be highlighted. 
 

    
 

 

 

2. Crossing type selection window: 

 Click on a place where no component is located (point B1) - thus activating the selection window. 

 Move the mouse to the left from the first clicked point to stretch the green intersection selection window 
(all components lying inside the window, or intersecting it will be selected). 

 Click the opposite corner of the window (point B2). The selected components will be highlighted. 
 

    

 
 
The procedure for deselecting multiple components at once is the same, but it is necessary to hold down the Shift 
key. 
 
To select all components in the wiring diagram: 

1. Click Select All in the menu on the Home tab, or press the Ctrl+A keyboard shortcut. 
 

To deselect all components in the wiring diagram: 
1. Click Deselect All in the menu on the Home tab, or press the Esc keyboard shortcut. 

B1 

B2 

B1 

B2 
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6.1.2 Searching for a component in the scheme by type number and selecting it 
 

1. Click Find in the menu on the Home tab, or press the Ctrl+F keyboard shortcut. 
2. Enter the component ‘tag’ in the subsequent dialogue box. It is possible to enter the entire type 

designation of a specific component (by selecting from a list), or wildcard characters can be used: 

 The * character replaces a group of characters. 

 The ? character replaces one character. 
3. Click the Find button.  
4. The component being searched for is highlighted by a frame and can be viewed and selected by clicking the 

Zoom to button. 
5. Close the dialogue panel by clicking the Close button. 

6.1.3 Editing properties of network components 
 

1. Display the Property Grid if not already displayed: 

 Click on Show Property Grid on the View tab. 
2. Select the component (components) from the network wiring diagram, the properties of which you want to 

edit (see Chap. 6.1.1). 
3. Edit the required properties in the Property Grid. 

 The entered value is immediately and automatically assigned to the component.  

 If several identical components are selected, the entered value will be assigned to all selected 
components. 

 If multiple components are selected, then you can set only a property common to all the components, 
i.e. connected phases. 

 Comments about the edited property are displayed at the bottom of the Property Grid.  

 Some of the complex properties cannot be edited directly (e.g. the editing of the ‘tag’, assignment of the 
method of laying cables, database driver, etc.). In that case: 

 Select the relevant property (e.g. the type designation).  

 Click on the button with dots on the right at the end of the line. 

 This opens a dialogue box to perform the editing task. 

 Close the dialogue panel by clicking OK.  

 For a more detailed description of each property, see the description of insertion of each component of 
the wiring diagram, Chap. 5.2-5.17).  

 

 

1 
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(1) Display Property Grid. (3) Property Grid 
(2) Selected component from the wiring diagram for editing 

properties. 
(4) Edited property. 

 (5) Comments on the edited property. 
 
 

6.1.4 Editing of ‘tags’, automatic numbering of components 
 
The ‘tag’ attribute is set locally for each component when the component is being inserted into the wiring diagram. 
This attribute can be edited either within the framework of editing each individual component (see Chap. 6.1.3), or 
‘in bulk’ – in this case, the end-position number is changed automatically. This way, for example, it is possible to 
easily renumber a group of circuit-breakers that has been transferred by means of the clipboard from another 
project (see Chap. 6.6). 
 

1. Select the component (components) from the network wiring diagram to edit the "tag" (see Chap. 6.1.1).  

 When selecting several components, it is necessary to select only components of the same type (e.g. only 
the circuit breaker). 

 The components are numbered in order of selection.  

 If the selection window is used, the order of the components in the selection set cannot be influenced.  
 

2. Display the Property Grid if not already displayed: 

 Click on Show Property Grid on the View tab. 
 

3. Click on the Tag line in the Property Grid. 
4. Click on the button with dots on the right at the end of the line to display the dialogue box. 
5. Enter the following text before the number in the dialogue box which opens (e.g. FA12. for circuit breaker), 

number of the selected component (such as 1); numbering step (for ex. 1). 

3 

5 

2 

1 

4 



 xSpider, User’s Manual 
 __________________________________________________________________________________________________ 
 

 ______________________________________________________________________________________________________________________  
 

 II / 38 

6. Close the dialogue panel by clicking OK. The tag of the selected components will be changed to FA12.1, 
FA12.2, FA12.3, FA12.4, …. This function does not carry out a check on unwanted duplicities. This check is 
carried out automatically before any computation is performed. 

 

 
 
 
 

 
 
 

6.1.5 Editing properties of free graphics components 
 

1. Select a component (or multiple components) of free graphics (line, circle, rectangle, text) to edit the 
properties (see Chap. 6.1.1). 

2. Display the Property Grid if not already displayed: 

 Click on Show Property Grid on the View tab. 
 

3. Edit the required properties in the Property Grid (colour, line thickness and type, geometry, ...). 
 
 

1 

2 

3 

5 

4 
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6.2 Changing component position 
 
Using grips: 

 
1. Select a component (or multiple components) to move (see Chap. 6.1.1). 
2. Click on any grip with the left mouse button – you now change the position of the part of the element with 

respect to the selected grip. 
3. Right-click in the graphics area. The context menu will be displayed. 
4. Select Move from the context menu. Now move the selected components - their position changes depending 

on the position of the cursor. If you have selected at least one component from the wiring diagram, the Snap 
drawing aids will always be automatically enabled and cannot be switched off during the course of the 
function. 

5. Click the left mouse button. The selected components will be moved to the new position. 
 
Using special editing functions - Procedure A: 

 
1. Select a component (or multiple components) to move (see Chap. 6.1.1). 
2. Click the Move icon in the menu on the Home tab. 
3. Click two points defining the displacement vector - B4, B5 in the figure. The selected components 

will be moved to the new position. The Snap drawing aids will always be automatically enabled and cannot 
be switched off during the function. 

 
Using special editing functions - Procedure B: 

 
1. Click the Move icon in the menu on the Home tab. 

1 

2 

3 
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2. The mouse pointer will change to the form of a selection square. Now you will be asked to select the 
components to be moved (the request to do so is displayed in the status bar in the bottom part of the main 
programme window, see Chap. 4.1). 

3. Select all of the components that you want to move. Either click on any line forming component (point B1), or 
use the selection window (points B2, B3), for more details, see Chap. 6.1.1. 

4. Click the right mouse button to exit the selection set. 
5. Click two points defining the displacement vector - B4, B5 in the figure. The selected components will be 

moved to the new position. The Snap drawing aids will always be automatically enabled and cannot be 
switched off during the function. 

 

      
 

6.3 Copying components 
 
Using grips: 

 
1. Select a component (or multiple components) to copy (see Chap. 6.1.1). 
2. Click on any grip with the left mouse button – you now change the position of the part of the element with 

respect to the selected grip. 
3. Right-click in the graphics area. The context menu will be displayed. 
4. Select Copy from the context menu. Now drag the selected components - their position changes depending 

on the position of the cursor. If you have selected at least one component from the wiring diagram, the Snap 
drawing aids will always be automatically enabled and cannot be switched off during the course of the 
function. 

5. Click the left mouse button. The selected objects are copied to the specified position. 
 
Using special editing functions - Procedure A: 

 
1. Select a component (or multiple components) to copy (see Chap. 6.1.1). 
2. Click the Copy icon in the menu on the Home tab. 
3. Click two points defining the displacement vector - B4, B5 in the figure. The selected components 

will be copied to the new position. The Snap drawing aids will always be automatically enabled and which 
cannot be switched off during the function. 

 
Using special editing functions - Procedure B: 

 
1. Click the Copy icon in the menu on the Home tab. 
2. The mouse pointer will change to the form of a selection square. Now you will be asked to select the 

components to be copied (the request to do so is displayed in the status bar). 

Before editing 

B1 

B2 

B3 

B4 B5 

After editing: 
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3. Select all of the components that you want to copy (click on any line constituting the component - points B1, 
B2, B3 in the figure. The selected component will be highlighted. You can also use window selection, for 
more details, see Chap. 6.1.1. 

4. Click the right mouse button to exit the selection set.  
5. Click two points defining the displacement vector - B4, B5 in the figure. The selected components will be 

copied to the new position. The Snap drawing aids will always be automatically enabled and cannot be 
switched off during the function. When copying components constituting one wiring diagram, the tags of the 
copied components will be changed in order to avoid any undesired duplicities (the tags can be adjusted 
additionally, either by editing the individual components – see Chap. 6.1.3).  

6. Click another point determining the position of the next copy - point B6. 
7. Repeat step 5 until you have created the required number of copies. Click the right mouse button to exit 

copying mode. 
 
 

 
 
 

6.4 Modifying component geometry - stretch 
 
Using grips: 

 
1. This procedure is especially useful for editing text position and for changing the width of the text box next to 

a component in the wiring diagram. 
2. Select a component for stretching (see Chap. 6.1.1) – point B1 in the figure. 
3. Click on any grip with the left mouse button (point B2 in the figure) – you now change the position of the part 

of the element with respect to the selected grip.  

 If you have selected at least one component from the wiring diagram, the Snap drawing aids will always be 
automatically enabled and cannot be switched off during the course of the function.  

 If the selected grip belongs to the Network grip component, the Ortho drawing aid will always be 
automatically enabled and cannot be switched off during the course of the function. 

4. Click the new position of the selected grip (point B3 in the figure). 
 
 

Before editing: 

B1 

B5 B4 

After editing: 

B2 

B3 

B6 
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Using special editing functions: 
 

1. Click the Stretch icon in the menu on the Home tab. 
2. The mouse pointer will change to the form of a selection square. Now you will be asked to select 

the component to be stretched (the request to do so is displayed in the status bar in the bottom part 
of the main programme window, see Chap. 

3. Select components using the intersecting selection window (see Chap. 6.1.1), so that the parts to change 
position are in the inside of this window and the parts that remain without a change are on the outside of the 
selection window - points B1 and B2 in the figure. 

4. Click the right mouse button to exit the selection set. 
5. Click two points defining the displacement vector - B3, B4 in the figure. The shape of the components will be 

updated accordingly. 

 The Snap drawing tool will always be automatically enabled and cannot be switched off during the 
function.  

 If the Network grip component was selected, the Ortho drawing tool will always be automatically 
enabled and cannot be switched off during the course of the function. 

 

 
 

Before editing: 

B1 

After editing: 

B2 B4 

B4 B3 

Before editing: After editing: 

B1 

B2 B3 
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6.5 Removal of components 
 
Using special editing functions - Procedure A: 
 

1. Select a component (or multiple components) to remove (see Chap. 6.1.1). 
2. Click the Erase icon in the menu on the Home tab. 
3. The selected components will be removed. 

 
Using special editing functions - Procedure B: 
 

1. Click the Erase icon in the menu on the Home tab. 
2. The mouse pointer will change to the form of a selection square. Now you will be asked to select the 

component to be removed (the request to do so is displayed in the status bar in the bottom part of the main 
programme window). Select all of the components that you want to remove (see Chap. 6.1.1). 

3. Click the right mouse button to exit the selection set. The selected components will be removed. 
 

6.6 Using the clipboard 
 
The xSpider programme clipboard can be used to transfer and copy objects either among simultaneously opened 
projects or within the framework of the currently opened project. Objects are either free graphics or components 
that form a wiring diagram. The method of utilisation is similar to the method of utilisation for the Windows clipboard 
in other programmes. The necessary functions can be found in the menu on the Home tab. Standard icons and the 
Ctrl+X, Ctrl+C and Ctrl+V keyboard shortcuts are available.  
 
Notes: 

 The clipboard cannot be used to transfer objects into other programmes (e.g. to transfer graphics to CAD 
systems or text processors). To transfer graphics into other programmes, you can use the Export function 
(see. Chap. 13). 

 The clipboard cannot be used to transfer objects from other programmes. Objects (graphics) cannot be 
imported from other programmes. 

6.6.1 Cut objects to clipboard 
 
Using special editing functions - Procedure A: 
 

1. Select a component (or multiple components) to cut into clipboard (see Chap. 6.1.1). 
2. Click Cut to Clipboard in the menu on the Home tab, or press the Ctrl+X keyboard 

shortcut. 
3. The components that have been selected will be removed from the project and cut to the xSpider programme 

clipboard. Pasting objects from the clipboard to the project - see Chap. 6.6.3. 
 
Using special editing functions - Procedure B: 
 

1. Click Cut to Clipboard in the menu on the Home tab, or press the Ctrl+X keyboard shortcut. 
2. The mouse pointer will change to the form of a selection square. Now you will be asked to select the 

component that should be cut to the clipboard (the prompt is displayed on the status line). 
3. Select all of the components that you want to cut to clipboard (see Chap. 6.1.1). 
4. Click the right mouse button to exit the selection set. The components that have been selected will be 

removed from the project and cut to the xSpider programme clipboard. Pasting objects from the clipboard to 
the project - see Chap. 6.6.3. 
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6.6.2 Copy objects to clipboard 
 
Using special editing functions - Procedure A: 
 

1. Select a component (or multiple components) that you want to copy to clipboard (see Chap. 6.1.1). 
2. Click Copy to Clipboard in the menu on the Home tab, or press Ctrl+C keyboard 

shortcut. 
3. The components that have been selected will be copied to the xSpider programme 

clipboard (they remain in the project). Pasting objects from the clipboard to the project - see Chap. 6.6.3. 
 
Using special editing functions - Procedure B: 
 

1. Click Copy to Clipboard in the menu on the Home tab, or press Ctrl+C keyboard shortcut. 
2. The mouse pointer will change to the form of a selection square. Now you will be asked to select the 

component that should be copied to the clipboard (the prompt is displayed on the status line). 
3. Select all of the components that you want to copy to clipboard (see Chap. 6.1.1). 
4. Click the right mouse button to exit the selection set. The components that have been selected will be copied 

to the xSpider programme clipboard (they remain in the project). Pasting objects from the clipboard to the 
project - see Chap. 6.6.3. 

6.6.3 Paste objects from the clipboard 
 

1. Click Paste from Clipboard in the menu on the Home tab, or press Ctrl+V keyboard shortcut. 
2. If the clipboard does not contain any objects from the xSpider programme, an information 

message will be displayed (the clipboard cannot be used to transfer objects from other 
programmes; objects (graphics) from other programmes cannot be imported). Inserting objects to 
the clipboard - see Chap. 6.6.1, 6.6.2. 

3. If the clipboard contains at least one object from the xSpider application, you will now be required to 
determine the position of objects in the graphics area (the prompt is displayed in the status bar). 

4. Click the point. The objects from the clipboard will be pasted into the project. The exact positions of the 
objects can be subsequently adjusted by means of the Move function (see Chap. 6.2). In the components 
constituting one wiring diagram, the tags of the copied components will be changed in order to avoid any 
undesired duplicities (the tags can be adjusted additionally, see Chap. 6.1.3, 6.1.4). 
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7. View control (Zoom) 
 
The view control (zooming in and out in the design sections) is based on the method of operation applied in CAD 
systems (such as AutoCAD). The programme draws on an area with dimensions of infinity x infinity. The screen of 
your monitor is only like a zooming glass, a “peep-hole” through which you look at a part of the infinite drawing 
area. Depending whether the zooming glass is further from or closer to the area, you see a larger or smaller part of 
the design in it, with smaller or larger details. Each function can be called from the menu on the View tab, or from 
the floating pop-up menu that appears when you right-click in the graphics area, or you can use the mouse wheel. 

7.1 Regenerating images 
 

1. Click on Regeneration on the View tab. 
2. The image will be regenerated - image defects will be removed. We for example recommend that 

you this after changing the main programme window dimensions by dragging its edge or in the 
event of faulty diagram representation after non-standard termination of an editing operation. 

7.2 Pan 
 

1. Click on the Pan icon on the View tab. 
2. Pan mode is activated. The standard mouse pointer (usually an arrow) changes to a shifting 

character (hand). Click on the image, hold down the left mouse button and move the mouse slowly. 
The graphics are dragged simultaneously as the mouse moves.  

3. Release the left mouse button - the graphics will be redrawn in the new position. 
4. Exit scrolling view, press Esc. 

 
Tip: the pan function can be also activated by pressing the middle mouse button (wheel) even in parallel to another 
performed command (such as when inserting a component in the wiring diagram or when selecting objects for an 
editing operation, e.g. their move): 
 

1. Click the middle mouse button (wheel), hold it down and move the mouse slowly. The standard mouse 
pointer (usually an arrow) changes to a shifting character (hand). Pan mode is activated - the graphics are 
dragged simultaneously as the mouse moves. 

2. Release the middle mouse button - the graphics will be redrawn in the new position. If the operation was 
called up parallel to another function, it is now possible to continue in this function. 

7.3 Zoom in / zoom out 
 

1. The Zoom function can be activated by turning the mouse wheel. 
2. Alternatively: click the Zoom In or Zoom Out icon in the menu on the View tab. 

7.4 Zooming in on a part of the design (Zoom Window) 
 

1. Click on Zoom Window on the View tab. 
2. Specify the area that you want to be zoomed-in: Click the first corner of the rectangle and 

move the mouse - drag the rectangle defining the area to zoom in. Click the opposite corner of 
the rectangle. 

3. This will enlarge the specified area. Return to the previous view is possible with Zoom Previous (see Chap. 
7.5). 
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7.5 Return to the previous image (Zoom Previous) 
 

1. Click on Zoom Previous on the View tab. 
2. It will return to the previous screen (if it exists). 

7.6 Viewing the drawing area image (Zoom All) 
 

1. Click on  Zoom All on the View tab. 
2. The entire drawing area will be displayed. The image will be zoomed in or out in order to show 

the entire network drawing in the current graphical window. 
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8. Network parameter calculations 
 
Once the network wiring diagram (topology) has been designed, you can proceed with network parameter 
calculations. A number of calculation algorithms are available, both complex (relating to the network as a whole) 
and local, being focused only on a certain network segment (such as a short circuit in one selected node).  
 
Each computational algorithm is started with the Calculation function from the menu on the Home tab.  
 

 
 

 Clicking on the arrow next to the icon - will pull down a list of basic calculations = the most important 
calculations required by the standard.  

 Clicking on the icon displays a dialogue box with a list of computational methods divided into groups: 

 Basic calculations – includes only the most important calculations required by the standard. This 
group will be the only one used by the most common users. 

 All calculations – includes absolutely all calculation procedures that are available in xSpider. The 
functions from this group are in particular intended for advanced users. 

 Set parameters for calculations – includes functions to modify software behaviour. The functions from 
this group are in particular intended for advanced users. 

 
Note: software setting and currently edited project setting have influence on calculation results. See Options… 
function (Calculation tab) and Information about project function (Calculation tab). 

8.1 Checking the network connection logic, working with the error list 
 
This function checks the logical links between the network components. Potential problems are listed in the error 
list. The function is activated automatically prior to every calculation. We recommend that you launch this 
separately after completing the layout of a new diagram in order to eliminate mistakes made during the drawing 
process. 
 
Examples of the most frequent logic errors together with instructions for their remedy are specified at the end of 
chapters defining insertion of the particular network components - see Chap. 5.1 - 5.18. 
 
Working with the error list: 
 

 If the window with the list of errors is not displayed, then click Show error list in the menu on the View tab.  

 The window is displayed in parallel with the currently edited project. The dimensions and position of the 
window can be adjusted similarly to other windows including the possibility of anchoring it (see Chap. 4.1). 

 Problems are divided into several categories: 

 Note: Text information, recommendations. Does not indicate any problem. 

 Warning: Warning of a nonstandard situation that may be a potential cause of a problem. The 
calculation may however continue. 

 Error: problem, the calculation cannot continue. The wiring diagram or the parameters of the 
component must be modified by the user to ensure that the problem is fixed. The components with 
an error are highlighted in the wiring diagram (for experts only: this highlighting can be switched 
off – Options function ...Calculation tab). 

 Click again on the column header in the error list - this will sort the list by the values in the column (the 
sorting method changes with each click in a cycle: ascending / descending / unsorted). 
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 Click on the line in the error list - the corresponding component is highlighted in the wiring diagram by a 
border. 

 Double click the cell in the tag - the corresponding component is displayed (the display setting (zoom) 
ensures the visibility of the component). The corresponding component is automatically selected and it is 
possible to edit the parameters on the property grid. 

 Double click the cell with the problem description - the description text will be displayed in the dialogue box 
and it will be easier to read. 

  After editing the diagram, the list of errors is retained (so you can gradually solve several errors 
without having to repeat the calculation). The lines corresponding to the edited element change 
colour and the icon changes to "Restore". This means that in order to check whether the problem has 
been resolved, the calculation must be repeated. 

 Double click the cell with the "Refresh" icon - this will automatically start the network connection logic control. 

8.2 Voltage drops and load distribution 
 
This function calculates network behaviour at the rated operating state and under overload. The function can be 
applied if you are using the application in control mode. The following algorithms are available: 
 
Algorithm omitting the impact of the voltage drop: due to the impedance of conductors located between the power 
supply source and the load, the voltage in load terminals is lower than the supply unit voltage. However, the current 
consumed by the load will not be affected by this drop. In other words, the load currents are constant. This is a 
conventional calculation; the results obtained are comparable with outputs of common methods. This algorithm is 
available in the following versions: 

 For radial networks – taking the simultaneous factors into account (available in the Basic calculations 
group in the Calculation dialogue panel). 

 For general networks, both radial and meshed networks, using the admittance matrix method – the 
simultaneous coefficients are ignored (available in the All calculations group in the Calculation dialogue 
panel). 

 
Algorithm taking into account the impact of the voltage drop: due to the impedance of conductors located between 
the power supply source and the load, the voltage in load terminals is lower than the supply unit voltage. However, 
since loads work with constant output, the voltage drop results in an increase in the consumed current. The 
increase in the consumed current leads to increase in voltage drops. In other words, the load outputs are constant. 
The network balance state is found through the iteration method. Though this calculation is more precise, it is also 
more time-consuming and its results may be slightly different from those obtained by common methods. The 
function is available in the All calculations group in the Calculation dialogue panel. 
 

1. We assume that the network wiring diagram (topology) 
has been defined and all network components have 
been dimensioned. 

2. Click the arrow next to the Calculation icon in the 
menu on the Home tab. In the list of computational 
algorithms, click on the Voltage drops and load 
distribution. 

3. The network type is detected automatically.  

 The algorithm that takes simultaneous factors into 
account is applied automatically for radial 
networks. 

 For meshed networks, information about the ignored simultaneous factors is indicated to the user. 
When the calculation continues, the algorithm working with the admittance matrices will be used. 
Alternatively, the calculation can be terminated and the meshed network can be transformed to a radial 
one through an appropriate modification of the operating status / switching off of some switching 
devices. 

4. The calculation is performed and single checks follow (non-compliant components are included in the error 
list): 
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 Check on voltage drops in the nodes with respect to power source voltage. Such nodes are not 
compliant where the voltage drop exceeds the limit set when inserting the component. 

 Check on voltage drops in branches. Such nodes are not compliant where the voltage drop exceeds the 
limit set when inserting the component. 

 Check on the protective components for rated current. Such devices are not compliant where the 
current in the branch exceeds the nominal current of the device (switching off already takes place in the 
nominal state). 

 Checking of overcurrent protection residual current circuit breakers and switches. 

 Check on busbars for rated current load. Such components are not compliant where the current in the 
branch exceeds the rated current of the component. The component’s rated current is determined with 
respect to its installation. 

 Check on cables for rated current load. Such components are not compliant where the current in the 
branch exceeds the rated current of the component (determined with respect to its installation, ambient 
temperature, cable grouping etc). 

 Check on cable overload protection.  

 The nominal current of the protective device must be smaller than the cable current-carrying capacity 
determined with respect to its installation and ambient temperature. The second condition according 
to IEC standard regarding the protection of the cable against overload must also be satisfied: 
I2≤1.45*Iz.  

 The ampere-second heating characteristics of the cable must lie above the tripping characteristics of 
the circuit breaker (this test is not required by IEC and can switched off - see Chap. 15.2). 

 The ampere-second characteristics of the cable in relation to the respective protective device can be 
viewed by means of the Tripping Characteristics module (see Chap. 9). 

 For more details, see the theoretical introduction - Part I. Chap. 2.3.  

 Check on transformer and generator for load and protection. 

 Components on the transformer line are checked for the transformer nominal current regardless of the 
current load. 

 

5. Based on the check results, the network design can be modified and this function can be repeated. The 
calculation results are displayed in the network wiring diagram. 

 

Unode Voltage in the node (shown only if the admittance matrix algorithm method is used) 
dUnode Voltage drop in the node due to the power supply voltage 
cosfi Power factor (shown only if the admittance matrix algorithm method is used) 
Inode Current consumed by the load with respect to the Ku utilisation factor (shown only in 

a node with load) 
dUwl Voltage drop on the line 
Iwl Current passing through the line (percentage line load indicated in brackets) 

 
Notes: 

 The voltage of the source (s) of power supply is firmly fixed: 

 The voltage at the transformer is securely fixed (the transformer works as an ideal machine). 

 If there is at least one 1-phase consumption in the network, the calculation is carried out separately for every 
phase. Voltage drops and currents are showed for every phase separately in L1, L2, L3 and N sequence. 
This allows you to verify the load distribution to the particular phases. All checks are carried out with respect 
to the most loaded phase. 

 For display of the connected phases of the individual components - see Chap. 8.7. 

 The cosPhi power factor is determined automatically in 3-phase network nodes formed by the network 
node component (when the general-network algorithm working with the admittance matrix method is 
applied). The programme does not allow the user to enter the target power factor; the required compensation 
volume must be determined by trial and error through successive insertion of various sizes of condensers. 
The possibility of changing the operating state of switching and protective devices can be used to advantage 
for successive connection of individual condensers. For insertion of the compensation component, see 
Chap. 5.17. 
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 The simultaneous factor is taken into account in radial networks only. In meshed networks, the operating 
state of circuit-breakers can be modified (on/off) to test the network behaviour in different operating 
conditions. 

 In case of unbalanced networks with 1-phase loads, the voltage on the low-load or tripped phase can be 
higher than the power source voltage; in such case, different computational algorithms can deliver slightly 
different results. 

 The wiring diagram with calculation results can be printed out (see Chap. 12), or exported to a data file (see 
Chap. 13). 

 It is possible to create a summary report containing the results of the calculation and to print the report (see 
Chap. 12.2) or export it to a data file (see Chap. 13.1). 

 You can create a list of elements with calculation results and export this list to a data file (see Chap. 13.2). 

 By means of the Options... function (see Chap. 15.1, 145.2) the following operations are possible: 

 Activation of the display of the real and the imaginary components of currents (show currents as 
complex numbers); 

 Suppression of highlighting of error components in the wiring diagram (for experts only); 

 Activation of display of admittance matrices and other intermediate results of the calculation. 

8.3 Short-circuit currents 
 
Several algorithms are available in the programme to calculate short-circuit currents. The first group of algorithms is 
based on the assumption that the short circuit will only occur in one selected network node - this is for instance 
useful when we are solving one specific outlet. The other group carries out a complex check on the entire network - 
the short circuit occurs in all nodes one by one. The calculation of asymmetric short circuits 
against ground depends on the selected network type (see Chap. 5.1) 
 

 Short-circuit currents: 3-phase symmetric short circuit Ik3p - analysis of network 
behaviour under a short circuit in a single selected network node, check for the load applied 
on network components due to the short-circuit current (maximum short circuit). 

 Short-circuit currents: 2-phase asymmetric short circuit Ik2p - theoretical problem, this 
calculation is usually not required. 

 Short-circuit currents: 2-phase asymmetric short circuit against ground Ik2PE - 
theoretical problem, this calculation is usually not required. 

 Short-circuit currents: 1-phase asymmetric short circuit Ik1p - analysis of network 
behaviour under a short circuit in a single selected network node, check for the load applied 
on network components due to the short-circuit current and check for the fault point 
disconnection from source (minimum short circuit). 

 Check the entire network: 3-phase symmetric short circuit Ik3p - the short circuit will 
occur in all network nodes one by one, check for the load applied on network components 
due to the short-circuit current (maximum short circuit). 

 Check the entire network: 1-phase asymmetric short circuit Ik1p - the short circuit will 
occur in all network nodes one by one, check for the load applied on network components 
due to the short-circuit current and check for the fault point disconnection from source 
(minimum short circuit). 

 

1. We assume that the network wiring diagram (topology) has been defined and all network 
components have been dimensioned. 

2. Click the Calculation icon in the menu on the Home tab.  
3. Double click on the line corresponding to the required short-circuit type in the list of computational algorithms 

under the Basic calculations group (see the list above). 
4. If you select an algorithm calculating the short circuit only in a single node, in the next step you must select 

the node where the short circuit occurs. Double click on the component tag forming the short-circuited node. 
5. This displays a dialogue box with the definition of backup protection (cascade, see Chap. 8.5); if necessary, 

adjust the settings and then close the dialogue box, press Esc or click on the Continue icon. 
6. The calculation will be performed.  
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7. In the case of a 3-phase symmetrical short circuit in the selected node, short circuit current waveform is 
displayed. Close the dialogue box by clicking on the cross in the upper right hand corner or press Esc; the 
chart display can be switched on / off using the Options... Calculation tab - see Chap. 15.2). 

8. Single checks follow (non-compliant components are included in the error list): 

 Check on circuit breakers and fuses for breaking capacity. Devices for which the breaking short-circuit 
current in the branch exceeds the breaking capacity of the component are not compliant. The breaking 
capacity of the device is determined by the Ics or Icu value in the case of circuit breakers - depending on 
the setting of the “Dimension for …” switch (see Chap. 5.10), or the Icn value in modular circuit-
breakers and fuses. If backup protection has been defined (cascade, i.e. the incoming protective 
components (at the incomers) and the outgoing protective components (at the outgoers) have been 
determined for each node formed by the ‘Network node’ component – see Chap. 8.5), the breaking 
capacities of the outgoing protective components are assessed with respect to the incoming 
components (both the limitation of the short-circuit current by means of a fuse and the interoperation of 
the circuit-breakers are taken into account). 

 Check on the RCD for suitable overcurrent protection as required by the manufacturer. 

 Check on the surge arresters for suitable overcurrent protection as required by the manufacturer. 

 Check on switch-disconnectors for nominal current load. The switch disconnector will not disconnect the 
short circuit, but must be able to withstand the short-circuit current in the short term. Such devices are 
not compliant where the effective heating current in the branch per 1 s exceeds the short-time withstand 
current Icw(1s) of the component. If a passed energy characteristic is available for the protective 
components, maximum possible energy passed is checked instead of thermal current. 

 Protection against dangerous voltage in non-conductive parts (check for the failure disconnection time 
from source). This is only performed for 1-phase short circuits. Such a component, located closest to 
the short-circuit point, for which the disconnection time exceeds the limit set when inserting the 
component is not compliant. 

 Check on cables / busbars for short-circuit current load. Such devices are not compliant where the 
effective heating current in the branch per 1 s exceeds the short-time withstand current Icw(1s) of the 
component. If a passed energy characteristic is available for the protective components, the maximum 
possible energy passed is checked instead of thermal current. For more details, see the theoretical 
introduction - Part I. Chap. 5.4. 

 Check on the PEN conductor for short-circuit current load. This is only performed for 1-phase short 
circuits in case the PEN conductor cross-section is smaller than the phase-conductor cross-section. 
Such devices are not compliant where the effective heating current in the branch per 0.1 s exceeds the 
short-time withstand Icw(1s) PEN current of the component. If a passed energy characteristic is available 
for the protective components, maximum possible energy passed is checked instead of thermal current. 
 

6. Based on the check results, the network design can be modified and this function can be repeated. The 
calculation results are displayed in the network wiring diagram. 

 

Ik3p’’ Initial impulse short-circuit current for 3-phase short circuit (effective value of the 
symmetric alternating component at the moment of short-circuit occurrence, for 
remote short circuits identical with the effective value of the steady short-circuit 
current) 

Ip3p Surge short-circuit current for 3-phase short circuit - height of the first short circuit 
current half-wave after a short circuit; current resulting in dynamic effects. This is 
only given for the node where the short circuit is to occur. 

Ik1p’’ Initial impulse short-circuit current for 1-phase short circuit. 
Ip1p Surge short-circuit current for 1-phase short circuit. 
Ic Fuse let-through short-circuit current; the peak value of the short-circuit current, 

which will be let through by the fuse. Displayed only in the event of a short circuit in 
one selected network node. 

 
Notes:  

 In case of IT networks, asymmetric short circuit against ground is calculated at the moment of a second fault. 

 In case of TT networks, it is necessary to enter the ground resistance Rt of the transformer node and the 
ground resistance Ra in the network node where the short circuit occurred. (Information about project 
function, Network and voltage system tab, see Chap. 11). 
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 The safety coefficient, which is defined by the regulation and which increases the impedance of the short-
circuit loop, is applied when calculating the disconnection time of the fault point from supply (for 1-phase 
short circuit). The safety coefficient value can be set by Information about project function under the 
Calculation tab. Default value for new project can be set by Options… function under the Calculation tab. 

 If the fault point disconnection time from source is not compliant, it is possible to adjust the settings of the 
protective device releases (if possible for such device), otherwise it is necessary to increase the cross-
section of the line in the branch. 

 Assessing short-circuit resistance of protective devices connected to the "Network Node" component: It is 
assumed that the short circuit, which the protective component at the outgoer has to withstand, may occur 
not only at the end of the line protected by this protective component, but also immediately behind the circuit-
breaker. So, the breaking capacity of the component is assessed with respect to the short-circuit current of 
the node to which the protective component is connected (the ‘Network node’ component). This solution 
improves the margin of safety. 

 The short circuit current is calculated regardless of the protective devices.  

 Limited short-circuit current downstream from the fuse is not displayed when checking the entire network. 
However, when considering switching capabilities of protective elements, it is always taken into account. To 
view the limited short-circuit current downstream from the fuse, it is necessary to calculate short-circuit 
currents in one selected network node. 

 In order to assess selectivity, the ampere-second characteristics of the protective devices can be viewed by 
means of the Tripping Characteristics module (see Chap. 9). 

 Assessment of the selectivity of protective elements on the basis of the selectivity tables is possible using 
the Selectivity function (see Chap. 8.5) 

 A wiring diagram with calculation results can be printed out (see Chap. 12.4), or exported to a data file (see 
Chap. 13.3). 

 It is possible to create a summary report containing the results of the calculation and to print the report (see 
Chap. 12.2), or to export it to a data file (see Chap. 13.1). 

 You can create a list of elements with calculation results and export this list to a data file (see Chap. 13.2). 

 By using the Programme settings function (see Chap. 15.1, 15.2) the following operations are possible: 

 Suppression of highlighting of error components in the wiring diagram (for experts only); 

 Activation of display of admittance matrices and other intermediate results of the calculation. 

8.4 Backup protection (cascading) 
 
Backup protection (cascading) is a concept in which an incoming circuit-breaker or a fuse are used to restrict the 
short-circuit current to a value which can be safely switched off by the outgoing circuit-breaker. If a prescribed 
combination of circuit-breakers and of the nominal currents of these circuit-breakers is used, it is guaranteed that 
the outgoing circuit-breaker can be used even in circuits with short-circuit conditions exceeding the breaking 
capacity of this circuit-breaker – for more details, see Part I, Chap. 6.2. 
 
The Backup protection function allows you to define the incoming protective components 
(at the inputs) and the outgoing protective components (the outputs) for each node 
composed of a "Network Node" component. The breaking capacities of the outgoing 
protective components are assessed with respect to the incoming components (both the 
limitation of the short-circuit current by means of a fuse and the interoperation of the circuit-
breakers are taken into account). This function is called up automatically before any short 
circuit computation, with the exception of a 1-phase short-circuit check on the whole network. 
Definition of backup protection is not obligatory (for complex, ‘knotted’ networks, definition of backup protection is 
sometimes not possible); if no backup protection is defined, the protective components do not influence one 
another. Backup protection for radial networks is preset automatically. 
 
Warning: Pay particular attention to the definition of backup protection. Incorrect determination of the incoming 
components may result in wrong conclusions. If you are not sure, do not set any incoming component. 
 

1. We assume that the network wiring diagram (the topology) has been drawn correctly. 
2. Click the Calculation icon in the menu on the Home tab.  
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3. Double click the line Definition of backup protection in the list of computational algorithms in the 
Calculation parameter settings group. 

4. This will display a dialogue box where incoming and outgoing circuit breakers are displayed for each 
"Network Node" component. In the default setting, no component is defined as an incoming component (the 
protective components do not influence one another). 

5. Select the line (Network Node) which you want to define backup protection for (change the incoming and 
outgoing protective components). 

6. Click on the Edit back-up protection icon (or double-click the selected line). Define the incoming and 
outgoing protective components in the dialogue panel that opens up subsequently: 

 In the list of outgoing protective components on the right side of the dialogue box, select the one that 
will be incoming. 

 Click Add to incoming components button. The component will be moved to the left to the list of 
incoming devices. 

 In the list of incoming protection devices, select one for removal. 

 Click Add to outgoing components button. The component will be moved to the right to the list of 
outgoing devices. 

7. Repeat steps 5 and 6 for all nodes of the network. 
8. If you need to look on wiring diagram, click on Zoom icon. Scroll mouse wheel to zoom-in or to zoom-out. 

Hold down mouse wheel and move to pan. Press Esc key or right click to exit zoom mode and return to 
dialog. 

9. Close the Backup protection dialogue box by clicking on the Continue icon (or by pressing the Esc key). 
The changes that have been made are always saved (the Cancel option is not available in this case). 

 
Examples (1 = incoming component, 2 = outgoing component): 
 
A fuse used as backup protection for circuit-breakers: 

 If the protection at the input consists of the series connection of a circuit breaker and a fuse, define only fuse 
as the incoming component. 

 During a short circuit, the FA3 and FA4 circuit-breakers may be subject to the short-circuit current stress 
Ik3p’’=14.6kA (this is more than their Ics=6kA); the incoming fuse will limit this current to the peak value of 
about 6.5kA, which is less than Ics* 2  

 
 
 

  
 
 

1 

2 2 

1 
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Circuit breaker as backup protection: 

 The FA3 incoming circuit-breaker serves as backup protection for the FA4, FA5, FA6 outgoing circuit-
breakers if the short-circuit current does not exceed 30kA (the limiting value given by the manufacturer for 
this pair; in this case, the condition has been fulfilled: Ik3p''=27kA at NOD1). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 

1 

2 2 
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Incoming component is not a breaker - backup protection is not defined: 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 

No backup protection can be 
defined for node Rv2 (a switch 
disconnector is at the incomer); 
no circuit-breaker may be 
defined as an incoming circuit-
breaker, each protective 
component must be assessed 
separately, without regard to 
the other protective 
components. It is not possible 
to take into account the 
influence of the protective 
components of other nodes. 

All the components connected to this node must 
withstand this short-circuit current (i.e. the short circuit 
immediately behind the component, not only the short 
circuit at the end of the line). 

The FA8 incoming circuit-breaker 
serves as backup protection for the 
outgoing circuit-breakers at node Rv1.  
 

1 

2 

If it is not possible that the outgoing 
protective component may interoperate 
with the incoming one, it is always 
assessed separately, without regard to 
the setting of the cascades (in this 
case, the FA2 and FA3 motor starters). 
The fact that the incoming circuit 
breaker is considered as backup 
protection, it is indicated by an 
information message. 

2 2 

If the outgoing protective component 
cannot interoperate with incoming one, 
it is always assessed separately, 
regardless of the backup protection 
setting (here FA2, FA3 motor starter).  
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‘Meshed’ network: 

 Rv1 Node: In this configuration, it is possible to assume two incomers = two incoming components. 
However, other alternatives are also possible. Proceed with increased caution! 

 Rv1a Node: It is not possible to determine generally what an incomer is and what an outgoer is – no 
incoming component has been set, each component is assessed separately. 

 Rv2 Node: two incomers = two incoming components. 
 
 

 
 
 
Evaluation of backup protection: 

 The incoming protective components are either fuses or fuses and circuit-breakers: The limited short circuit 
current is computed for the incomers with fuses, and we add to this current the unlimited short-circuit current 
of the incomers with the circuit-breakers. The current computed in this way is causing stress to the outgoing 
component. The interoperation of the circuit-breakers is not assumed. 

 The incoming protective components are circuit-breakers (two or more): The interoperation of the circuit-
breakers cannot be assessed, each protective component is evaluated separately, without regard to the 
setting of the backup protection. 

 The incoming protective component is a circuit-breaker: A test is carried out to establish whether it is 
possible that the incoming component and the outgoing component may interoperate. If it is possible that 
they may interoperate, the assessment is carried out to establish whether the assumed cut-off short-circuit 
current is not greater than the limit specified by the manufacturer for the given pair. If it is not possible that 

1 

2 

1 2 2 

2 2 2 2 2 

1 1 
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they may interoperate, each of the circuit-breakers is assessed separately – they do not influence 
one another. 

 Warning: Pay particular attention to the definition of backup protection, especially in meshed networks. 
Incorrect determination of the incoming components may result in wrong conclusions. If you are not sure, do 
not set any incoming component. 

 

8.5 Coordination between protective devices 
 
The aim of securing selectivity is to ensure that, in case of short-circuit or overload, only the protective device 
closest to the fault point will trip and the rest of the installation will remain operational (for more details see Chap. 
6.1). Selectivity of two protective elements - incoming (1) and outgoing (2) can be assessed by comparing the 
tripping characteristics (see Chap. 9) as well as special functions to evaluate the selectivity based on selectivity 
tables listed in the catalogue of power circuit-breakers. The latter option is addressed in this Chapter. 

8.5.1 Selectivity - comparing two protective components selected from database 
 
This function allows you to evaluate selectivity of two circuit-breakers on the basis of selectivity tables 
independently on the wiring diagram edited. There is no need to make drawings, you can just select two devices 
from the database and the selectivity is then shown, accompanied by the relevant comments. 
 

1. In the menu on the Home tab, click the Calculation icon.  
2. In the list of computational algorithms under the Calculation parameter settings group, double click on the 

line called Selectivity (comparison of two circuit-breakers selected from the database). 
3. In the opened dialogue box, select the incoming protective component: 

 Click on the Database button. 

 Select the type of protective components (circuit breakers, fuses, ...) from the drop down list. 

 This will activate the database driver (see Chap. 10.1). Select the desired product. 
4. Select the incoming protective element: 

 Click on the Database button. 

 Select the type of protective components (circuit breakers, fuses, ...) from the drop down list. 

 This will activate the database driver (see Chap. 10.1). Select the desired product. 
5. The combination of the selected circuit-breakers will be searched in the selectivity tables, and the result will be 

displayed, accompanied by the relevant comments (limiting conditions, where relevant, see also the 
theoretical introduction, Chap. 6).  

6. Close the dialogue panel by clicking the Close button. 

8.5.2 Selectivity - comparison of protective components in the project 
 
This allows you to assess the selectivity of circuit breakers connected to one node constituted by one "Network 
Node" component. 
 

1. Click the arrow next to the Calculation icon in the 
menu on the Home tab. In the list of computational 
algorithms, click on Selectivity (comparison of circuit 
breakers in the project). 

2. Unless backup protection (cascade) has been defined 
for the project, a dialogue box with a request for their 
definition will be displayed (see Chap. 8.5). An incoming 
circuit-breaker must be defined for every node where 
the line splits (a node constituted by the “Network 
Node” component). Backup protection for radial 
networks is preset automatically. 
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3. If you have already determined backup protection, a dialogue box with the results will be displayed. An 
incoming and outgoing circuit-breaker is considered for every node where the line splits (a node constituted by 
the “Network Node” component). The combination of circuit breakers is searched for in the selectivity tables 
and the results are displayed (see also theoretical introduction, Chap. 6). 

4. Click on the Close icon or press Esc to close the dialogue box. 
5. The results are also shown in the wiring diagram (attached to the results of the last calculation made, it is 

therefore suitable to calculate "Check on the entire network: 3-phase symmetric short-circuit Ik3p") before this 
calculation. 

8.6 Displaying impedances in network nodes 
 
The function allows you to display impedances in the individual network nodes: positive phase sequence 
component Z(1),  zero-sequence component Z(0) and fault loop impedance Zsv for single-phase short circuit as 
defined by the IEC 60 634-4-41 (without any applied coefficient). Either absolute values or complex numbers are 
optionally displayed. The displayed impedances are not corrected by any coefficients and can be used as input 
data to solve the connected IT networks. 
 

1. We assume that the network wiring diagram (topology) has been defined and all network components have 
been dimensioned. 

2. Click the Calculation icon in the menu on the Home tab.  
3. In the list of computational algorithms in the Calculation parameter settings group, double click the line 

Show impedance in network nodes. 
4. The calculation will be performed and the impedance values will be displayed in the wiring diagram.  

 
Notes: 

 The specified impedance values apply for the conductor temperature equivalent to the ambient temperature. 

 The shown impedances represent values determined by calculation, which are not adjusted by any 
coefficients. 

 The specified impedance values of Z(1) and Z(0) can be used for further calculations (such as in the linked IT 
networks, isolated medical system, etc.) 

 A wiring diagram with calculation results can be printed out (see Chap. 12.3), or exported to a data file (see 
Chap. 13.3). 

 It is possible to create a summary report containing the results of the calculation and print the report (see 
Chap. 12.2), or export it to a data file (see Chap. 13.1). 

 You can create a list of elements with calculation results and export this list to a data file (see Chap. 13.2). 

 By using the Programme settings function (see Chap. 15.1, 15.2) the following operations are possible: 

 Activation of display of the real and the imaginary components of impedances (show impedances as 
complex numbers); 

 Activation of display of admittance matrices and other intermediate results of the calculation. 

8.7 Displaying the values of limit voltage drops, tripping times and conn. phases 
 
The properties of maximum voltage drop in the network node with respect to the power supply voltage, the 
maximum voltage drop in the network branch and the maximum disconnection time of the protective device are set 
locally for every component. This attribute can be edited either within the framework of editing each individual 
component or cumulatively (see Chap. 6.1.3). The entered values can be displayed to ensure better orientation and 
transparency. 
 

1. Click the Calculation icon in the menu on the Home tab. 
2. In the list of computational algorithms in the Calculation parameter settings group, double click the line 

Show values of max voltage drops, .... 
3. The required values will be displayed in the wiring diagram.  
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8.8 Operation states manager  
 
The application allows you to simulate various operation states of the network by disconnecting power sources and 
loads. Each switching component has two operation states: on / off. Each motor has two operating states: start / 
stable operation. The operation states manager allows to define the group of named operating states for the drawn 
network wiring diagram. Each operation state of the network has the determined setting of operation states of all 
switching components and all motors. It is possible to easily switch between the operating states of the network. 
This function thus for example allows you to quickly switch between "Power supply from transformer" and "Power 
supply from the standby source unit - generator". 
 
 

1. Click the arrow next to the Calculation icon in the 
menu on the Home tab. Click on the Operation 
states manager line in the list of computational 
algorithms. 

2. The application displays a dialogue box with a list of 
operation states defined for the currently edited 
network project. 

 
Add a new operational state of the network 
 

1. Click the Add ... icon in the Operation states manager dialogue box. 
2. In the subsequently opened dialogue box, enter the name of the new network operation state and 

specify what the default operation state of the switching components and motors will be. 
3. Close the dialogue panel by clicking the OK button. The new operation state of the network will be added to 

the list. 
4. If you need to look on wiring diagram, click on Zoom icon. Scroll mouse wheel to zoom-in or to zoom-

out. Hold down mouse wheel and move to pan. Press Esc key or right click to exit zoom mode and 
return to dialog. 

 
Edit selected operation state 
 

1. Click the row that you want to edit in the Operation states manager dialogue box. 
2. Click the cell corresponding to the switching element / motor whose operation state you want to change. The 

operation state changes cyclically by clicking: on / off; stable operation / start. 
3. Click the cell with the name of the operation state. Enter the new name. 

 
Apply the selected operation state on the wiring diagram 
 

1. Click the row that you want to apply on the wiring diagram in the Operation states manager dialogue box. 
2. Click on the Apply ... icon. All the switching components in the wiring diagram will be set according to 

the selected line. The current operation state name is displayed in the header of the Error List window 
close to the current project file name, in the title block close to network identification and in the calculation 
report. 

 
Arranging the list of operation states 
 

1. In the Operation states manager dialogue box click on the line, whose position in the list you want to 
change. 

2. Click on Move Line Upwards or Move Line Downwards. 
 
Removing a selected operation state from the list 
 

1. Click the row that you want to remove in the Operation states manager dialogue box. 
2. Click on the Remove ... icon. Confirm the action by clicking the Yes button. 

 
 
 
 
 
 



 xSpider, User’s Manual 
 __________________________________________________________________________________________________ 
 

 ______________________________________________________________________________________________________________________  
 

 II / 60 

Export the operational status list to Microsoft Excel 
 

1. In the Operation states manager dialogue box click the Export to Excel icon. 
2. In the dialog box that follows (the Save dialog box, known from other applications), enter the directory 

(folder) and the name of the file to which the list will be saved. 
3. Close the dialog panel by clicking Save. 

 
End of work with Operation states manager  
 

1. In the Operation states manager dialogue box, click the icon Continue or close the dialogue box by 
clicking on the cross in the top right hand corner. The changes made will always be saved (the Cancel 
option is not available in this case). 
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8.9 Comprehensive check on the entire network 
 
This function gradually starts all basic calculations:  

 Network wiring logic control 

 Voltage drops and load distribution 

 Entire network check: 3-phase symmetric short-circuit 

 Entire network check: 1-phase asymmetric short-
circuit 

 
1. Click the arrow next to the Calculation icon in the 

menu on the Home tab. 
2. Select the developed Comprehensive check on the 

entire network.... from the drop down list. 
3. Before performing short-circuit calculations, you will be 

asked to define backup protection (cascades) see Chap. 8.5. Perform the necessary modifications. Close the 
dialogue box by pressing Esc key or clicking on the Continue icon. 

4. In the end the dialogue box is displayed with the result of the check on selectivity between the protective 
components according to the selectivity tables. Close the dialogue box by pressing Esc key or clicking on 
the Continue icon. 

5. Error elements are highlighted and included in the error list. 
6. The results of all the calculations are displayed in the network wiring diagram. Due to the large amount of 

data the wiring diagram can be confusing (it is preferable to run the calculations gradually manually and after 
each calculation, to print or export the wiring diagram with the results of the last performed calculation).  

8.10 Hide calculation results  
 

1. Click the arrow next to the Calculation icon in the 
menu on the Home tab.  

2. Select the Hide calculation results item. 
3. Results of the last performed calculation, which are 

shown in the network wiring diagram with the 
particular components will be erased. A new 
calculation must be performed if you want them to be 
shown in the drawing again (for more details see 
Chap. 8.1, 8.2). 

 

8.11 Automatic dimensioning of cables and protective devices 
 
If you are using xSpider application in design mode, this feature will automatically configure wires switching and 
protective devices that have the Dimension automatically switch on. Parameters of other elements, where the 
Dimension automatically switch is off, must already be specified and will not be modified. 
 
The automatic dimensioning algorithm assigns the types of wires, switching and protective devices from the 
database tables. The assignment process is controlled through user preferences. User preferences determine, for 
example, the preferred standard (set of regulations and standards defining the product series), mechanical design, 
area of application, material and insulation of conductors, etc. Elements are dimensioned to meet the required 
standards (see Chap. 1…4). The proposed solution cannot be considered optimal and its technical feasibility must 
always be assessed. 
 

1. Create a network wiring diagram (topology) - see Chap. 5. 

 Precise parameters of the inserted components (sources, loads) must be entered.   

 User-defined components parameters (wires, switching and protective devices) may not be specified, 
but for each element, the Dimension Automatically switch must be enabled.  
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 Within the network, there may also be user-defined elements that are already specified (by choosing 
from the database) and their automatic dimensioning is not required - for these elements, the 
Dimension Automatically switch must be disabled. 

 Using the Information about project function, the Wiring Diagram tab, you can set to automatically 
turn on the Dimension Automatically switch as the default state when you insert an element into 
the wiring diagram. The setting is valid for the currently edited project.  

 With the Options function, the Wiring Diagram tab, you can set automatically turn on the 
Dimension Automatically switch as the default state for each new project. 

 

2. Set up user preferences and run the calculation: 

 In the menu on the Home tab, click the arrow 
next to the Calculation icon. 

 From the expanded list, select Cable and 
protective dimensioning (or use the F2 shortcut 
key).  

 A dialog box asking you for setting custom 
preferences is displayed. Click the Yes button.  

 In the dialog box that follows, set the preferred 
standard (set of regulations and standards 
defining the product line), the mechanical design, 
the scope of use and other parameters for cables, protective and switching devices that will be 
automatically dimensioned. 

 Click the Restore Default Status button to set all user preferences to their default settings. 
 

 
 

 Close the dialogue panel by clicking OK. 
 

3. Now the calculation is done. If an appropriate element cannot be found in the data table defined by user 
preferences, the auto-dimensioning algorithm fails. In that case, you must manually dimension the element, 
turn off the Dimension automatically switch, and repeat point 2. 

4. At the end of the calculation, a comprehensive check of the entire network, of all elements, regardless of 
whether or not they were dimensioned, will be completed. The results of the individual checks are shown in 
the wiring diagram. Any errors are displayed in the error list (see Chap. 8.1). Based on the results of the 
verification, it is necessary to modify the network design in the same way as in the control mode (see Chap. 
4.4).  
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Notes: 

 Note: User preferences can also be set using the Options function, Automatic Dimensioning tab (or use 
the Alt + F2 shortcut key). 

 It is not recommended to automatically dimension the links for meshed networks. 

 In the case of meshed networks, the simultaneous factors will be ignored.  

 In the case of more complex meshed networks, and in the case of networks with more operation states, it is 
recommended to use the program only in control mode. 

8.12 Summary of variables relating to calculations 
 
Device parameters and general network parameters 
 

Uph/Ud V/V Network: Voltage system (phase voltage / delta voltage) 
Uph V Network: Phase voltage 
Ud V Network: Delta voltage 
Fn Hz Network: Rated frequency 
RA W TT network: Total resistance of the earth wire and guard wire of exposed 

conductive parts in the node where the short circuit occurred 
RB W TT network: Earth resistance of the source (node) centre  

Un V Supply network: Nominal voltage 
Sk'' MVA Supply network: Short-circuit power output (3-phase or 1-phase short circuit) 
Ik'' kA Supply network: Peak short-circuit current (3-phase or 1-phase short circuit) 
R1 W Supply network: Active resistance, positive-sequence network 

X1 W Supply network: Inductive reactance, positive-sequence network 

R0 W Supply network: Active resistance, zero-sequence network 

X0 W Supply network: Inductive reactance, zero-sequence network 

Ur V Generator: Nominal voltage 
Sr kVA Generator: Nominal power output 
cosPhi - Generator: Power factor 
Xd'' % Generator: Subtransient reactance 
In A Generator: Nominal current 
Ur1 V Transformer: Nominal primary voltage 
Ur2 V Transformer: Nominal secondary voltage 
Sr kVA Transformer: Nominal power output 
Pk kW Transformer: Short-circuit losses 
uk % Transformer: Short-circuit voltage 
Intr A Transformer: Nominal current 
Uc V Surge arrester: Maximum continuous operating voltage 
Iimp kA Surge arrester: Impulse current 
Icn kA Surge arrester: Short circuit resistance (at maximum upstream fuse / breaker) 
Un V Circuit-breaker: Nominal voltage 
Iu V Circuit-breaker: Nominal uninterrupted current - according to IEC/EN 60947-2; 

analogue to Rated current (In) 

Ics kA Circuit-breaker: Operating breaking capacity 
Icu kA Circuit-breaker: Limit breaking capacity 
Icn kA Circuit-breaker: Rated breaking capacity 
Icm kA Circuit-breaker: Short-circuit switching capacity 
Icw(1s) kA Circuit-breaker: Short-time withstand current 1s 
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Ir A Circuit-breaker: Overload release 
IrN A Circuit-breaker: Overload release in N-pole 
tr s Circuit-breaker: Tripping time, as an X-multiple of Ir 
Isd A Circuit-breaker: Short-circuit release delayed 
tsd s Circuit-breaker: Delay short-circuit release delayed 
Ii A Circuit-breaker: Short-circuit release, non-delayed  
IiArms A Circuit-breaker: Instantaneous short-circuit release when ARMS (Arc Reduction 

Maintenance System) function is switched on 
Ig A Circuit-breaker: Ground fault protection, current 
tg s Circuit-breaker: Ground fault protection, time delay 
Un V RCD: Nominal voltage 
In A RCD: Nominal current 
Idn A RCD: Rated residual current 
Ir kA RCD: Resistance to surge current  
Icn kA RCD: Short circuit resistance (at maximum upstream fuse) 
Un V Residual current device with overcurrent protection (RCBO) Nominal voltage 
In A Residual current device with overcurrent protection (RCBO) Nominal current 
Idn A Residual current device with overcurrent protection (RCBO) Rated residual 

current 
Ir kA Residual current device with overcurrent protection (RCBO) Resistance to surge 

current  
Icn kA Residual current device with overcurrent protection (RCBO)Rated breaking 

capacity 
Un V Fuse: Nominal voltage 
In A Fuse: Nominal current 
Icn kA Fuse: Breaking capacity 
Un V Overload relay: Nominal voltage 
In A Overload relay: Nominal current 
Iq kA Overload relay: Contingent short-circuit resistance 
Un V Switch-disconnector: Nominal voltage 
In A Switch-disconnector: Nominal current 
Icw(1s) kA Switch-disconnector: Short-time withstand current 1s 
Icm kA Switch-disconnector: Short-circuit switching capacity 
I2tMax A2S Switch-disconnector: Maximum possible energy released by upstream protective 

device 
L M Line - cable: Length 
Un V Line - cable: Nominal voltage 
In A Line - cable: Nominal current (in air, 30°C) 
Tau s Line - cable: Heating time constant 
Icw(0.1s) kA Line - cable: Short-time withstand current 0.1 s 
R1 mW/m Line - cable: Active resistance, positive-sequence network 

X1 mW/m Line - cable: Inductive reactance, positive-sequence network 

R0 mW/m Line - cable: Active resistance, zero-sequence network 

X0 mW/m Line - cable: Inductive reactance, zero-sequence network 

Ta °C Line - cable: Ambient temperature 
- K.m/W Line - cable: Specific thermal resistance of earth 
k - Line - cable: User coefficient 
L m Line – busbar system: Length 
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Ta °C Line – busbar system: Ambient temperature 
Un V Line – busbar system: Nominal voltage 
In A Line – busbar system: Nominal current (in air, 30°C) 
Tau S Line – busbar system: Heating time constant 
Icw(0.1s) kA Line – busbar system: Short-time withstand current 0.1s 
R1 mW/m Line – busbar system: Active resistance, positive-sequence network 

X1 mW/m Line – busbar system: Inductive reactance, positive-sequence network 

R0 mW/m Line – busbar system: Active resistance, zero-sequence network 

X0 mW/m Line – busbar system: Inductive reactance, zero-sequence network 

Un V Motor: Nominal voltage 
Pn kW Motor: Nominal power output 
eta - Motor: Efficiency 
In A Motor: Motor nominal current 
Is/In - Motor: Starting/nominal current ratio 
cosPhi - Motor: Power factor 
Ku - Motor: Utilisation factor 
dUmax % Motor: Maximum voltage drop (in node constituted by a motor) 
Un V Load in general: Nominal voltage 
In A Load in general: Nominal current 
Pn kW Load in general: Nominal power output 
cosfi 

(CosPhi) 

- Load in general: Power factor 

Ku - Load in general: Utilisation factor 
dUmax % Load in general: Maximum voltage drop (in node constituted by a load) 
Un V Compensation: Nominal voltage 
Qn kVA Compensation: Capacitance reactive power 
Qcal kVA Compensation: Calculated capacitance reactive power 
Cn mF Compensation: Capacity (per 1 phase) 
 
Voltage drops and load distribution calculation 
 

Unode Voltage in the network node (absolute value) 
dUnode Voltage drop in the network node in [%] relative to the power source voltage 
dUnodeMax Maximum voltage drop in the network node in [%] relative to the power source voltage (limit 

value defined by the user) 
dUwl Voltage drop in [%] in the network branch, i.e. voltage drop in the respective wiring line 
dUwlMax Maximum voltage drop in [%] in the network branch, i.e. voltage drop in the respective wiring 

line (limit value defined by the user) 
Inode Current consumed in the network node (absolute value) 
Inoder Active current consumed in the network node *) 
Inodex Idle current consumed in the network node *) 
Iwl Current flowing through the network branch (absolute value) 
Iwlr Active current flowing through the network branch *) 
Iwlx Idle current flowing through the network branch *) 
In Rated current of a network element in general 
Inf Nominal current of a protective device (circuit breakers, fuses) 
I2, I2f Conventional breaking current of circuit-breaker / fuse 
Inc Rated current of a line (cable, busbar system) 
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InInst Cable nominal current with respect to the installation  
cosPhi Power factor in the network node 
Ta Ambient temperature (with definition of cable installation) 
TaMax Maximum operating ambient temperature (with definition of cable installation) 
 
Short-circuit calculation 
 

Ik3p’’ Initial surge short-circuit current for 3-phase short circuit (effective value of the symmetric 
alternating component at the moment of short-circuit occurrence, for remote short circuits 
identical with the effective value of the steady short-circuit current) 

Ik2p’’ Initial short-circuit current for 2-phase short circuit 
Ik2PE’’ Initial impulse short-circuit current for 2-phase short circuit against ground, current flowing into the 

ground 
Ik2L’’ Initial impulse short-circuit current for 2-phase short circuit against ground, current flowing 

between phases 
Ik1p’’ Initial impulse short-circuit current for 1-phase short circuit against ground 
Ik Stabilised short-circuit current (in general) 
Ip3p Surge short-circuit current for 3-phase short circuit. 

(Maximum possible short-circuit current instantaneous value - height of the first half-wave of the 
short circuit current) 

Ip1p Surge short-circuit current for 1-phase short circuit. 
Ike1 Short-time withstand current 1s 
Ike01 Short-time withstand current 0.1s 
Ttr Disconnection time of the protective device (disconnection of the fault point from the power 

supply) 
TtrMax Maximum time of tripping of protective component  

(Disconnection of the fault location from power supply; threshold defined by the user) 
Icu Limit breaking capacity of the protective component  

(The component trips this current, but can be damaged) 
Ics Operating breaking capacity of the protective component 

(The component may repeatedly trip this current without damage) 
Icn Breaking capacity of circuit-breaker / fuse 
Ikcas Breaking capacity of a circuit breaker / circuit breaker pair, where the upstream circuit breaker 

serves as backup protection 
Icw01s Rated short-time withstand current, i.e. the current, which the equipment can transmit for a period 

of 0.1 second without damage 
Icw1s Rated short-time withstand current, i.e. the current, which the equipment can transmit for a period 

of 1 second without damage 
Ic Limited short-circuit current behind fuse. Peak value of the short-circuit current, which is let 

through by the fuse 
 
Impedances 
 

R1 Resistance of positive-phase sequence component system as viewed from the short-circuit point *) 
X1 Reactance of positive-phase sequence component system as viewed from the short-circuit point *) 
Z1 Impedance of positive-phase sequence component system as viewed from the short-circuit point  
R0 Resistance of zero-phase sequence component system as viewed from the short-circuit point *) 
X0 Reactance of zero-phase sequence component system as viewed from the short-circuit point *) 
Z0 Impedance of zero-phase sequence component system as viewed from the short-circuit point  
Rsv Fault loop resistance for single-phase short circuit *) 
Xsv Fault loop reactance for single-phase short circuit *) 



xSpider, User’s Manual   
____________________________________________________________________________________________________  

 

 ______________________________________________________________________________________________________________________  
 

 II / 67 

Zsv Fault loop impedance for single-phase short circuit 
 

 
*) In order to view the active and idle components of currents and impedances, you need to enable this function in 

the Options, Calculation tab (see Chap. 15.2). 
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9. Tripping characteristics 
 
The module for working with tripping characteristics is an integral part of xSpider software tool. It can be used 
independently of the network project as well as in combination with the currently edited project. The module allows 
you to: 
 

 Select devices from the database, display tripping characteristics of protective devices with respect to 
release settings, read the disconnection time and assess selectivity; 

 Select a cable from the database and plotting cable time-current heating characteristic. 
 Select a motor from the database and plotting the motor startup characteristics. 
 Insert a user-defined curve (by entering a set of points [current, time], or importing a set of points from an 

XLS / XLSX (Microsoft Excel) file). 

 Display the tripping characteristics of protective devices and cables from the currently edited project; option 
to adjust the settings of releases – changes are transferred back into the project; 

 Evaluate selectivity and backup protection. 
 Display, print and export let-through current (Ic) and let-through energy (I2t) characteristics. 

 Export a chart to PDF or DXF format, print a chart on a printer; 

 One project may include multiple collections of characteristics. 
 
Tripping characteristics module window display in the Full Mode of operation state 
(complete user interface, all program features available): Click the Tripping 
characteristics icon (shortcut key F5) in the menu on the Home tab. The window is 
displayed in parallel with the currently edited project. The dimensions and position of 
window can be adjusted similarly to other windows including the possibility of anchoring it 
(see Chap. 4.1). The window can be closed using the cross in the top right-hand corner. 
Characteristics collections are stored with the currently edited project (which may or may not include a network 
wiring diagram). 
 
In the Curve Select Mode of operation state (simplified user interface, only functions for working with tripping 
characteristics are available), tripping characteristics module window is displayed automatically. The Curve Select 
Mode can be activated when the first time the program is run after installation, or later using the Options… 
function from the File tab of ribbon menu (see Chapter 15.3). 
 

   
 

Full Mode Curve Select Mode 
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9.1 Chart view control (Zoom) 
 
The view control (zooming in and out of the chart with characteristics) is based on the method of operation applied 
in CAD systems (such as AutoCAD). The module window is only a magnifier, a viewer, through which you look at a 
part of the drawing area containing the chart with characteristics. Depending whether the zooming glass is further 
from or closer to the area, you see a larger or smaller part of the chart in it, with smaller or larger details. Icons 
triggering various functions are located in the right part of the window next to the chart, or you can use the mouse 
wheel.  
 
Pan: 
 

1. The mouse cursor must be located in the area of the chart 
2. Click the middle mouse button (wheel), hold it down and move the mouse slowly. The standard mouse 

pointer (usually an arrow) changes to a shifting character (hand). Pan mode is activated - the chart is 
dragged simultaneously as the mouse moves. 

 
Zoom in / zoom out 
 

1. The mouse cursor must be located in the area of the chart 
2. Rotate the mouse wheel. 
3. Alternatively: Click the Zoom In or Zoom Out icon in the Tripping Chars Collection tab. 
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View the entire chart (Zoom All): 
 

1. Under the Tripping Chars Collection click the Zoom All. The image will be zoomed in or out to show the 
entire chart in the current window. 

 

 
 

9.2 Working with collections of characteristics  
 
One project may include multiple collections of characteristics (collections of curves). Each collection of 
characteristics is defined by its name. 
 
Creating a new collection of characteristics 
 

1. Under the Tripping Chars Collection click the New collection... icon. A new collection of 
characteristics (empty chart) will be created with a default name. 

 
Renaming a collection of characteristics 
 

1. In the Tripping Chars collection section, select one collection from the list whose name you want to 
change. 

2. Click on the Rename collection ... icon. 
3. Enter the new name in the subsequently opened dialogue box and click on the OK button. The collection will 

be renamed. 
 
Removing a collection of characteristics 
 

1. In the Tripping Chars collection section, select one collection from the list that you want to remove. 
2. Click on the Delete collection ... icon. 
3. Confirm the action by clicking the Yes button. The collection will be removed (at least one collection must 

remain in the project). 
 
Viewing one selected collection of characteristics 
 

1. In the Tripping Chars collection section, select one collection from the list that you want to view. 
2. Collection contents (a collection of curves) will be displayed in the chart. 

 

 
 
 

9.3 Plotting characteristics of the protective device from the database 
 
The module of tripping characteristics enables the user to select a protective device from the database 
independently of the currently edited network project and to plot its tripping characteristic with respect to release 
settings. 
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1. Click on the Add protection device tripping characteristics from 
database ... icon in the Tripping characteristic section. 

2. From the menu under the icon, select the type of protective device 
(circuit breakers, fuses, overload relays, ...) by clicking on the item. 

3. The database driver is activated. For a description of the database 
explorer, see Chap. 10.1. Select the device, the characteristic of which 
you would like to be plotted and click Insert. 

4. The tripping characteristic is drawn up. 
5. If necessary, adjust the colour and tag (see Chap. 9.8). 
6. In the Releases section set the individual parameters of the tripping release (by dragging the slider, or 

clicking on the + and - buttons). You can adjust only those parameters that the release type allows you to 
change (see Chap. 9.8). 

 

9.4 Plotting characteristics of a protective device taken from a network project 
 
The module for working with the tripping characteristics allows you to take over information about the diagram 
components from the currently edited network project and to display any combination of the tripping characteristics. 
It is thus possible to assess the selectivity and cable overload protection or to fine tune the required settings (the 
function is only available in Full Mode). 
 

1. Select the protective devices whose tripping characteristics you want to view in the network wiring diagram.  
2. View the window with the module of tripping characteristics (if not displayed) - see Chap. 9. The network 

wiring diagram and the window with tripping characteristics module can be displayed in parallel. 
3. In the tripping characteristics module window, in Tripping characteristic section, click the Add 

protection device tripping char from project to collection... icon. 
4. A confirmation dialogue box will be displayed. Confirm the insertion by clicking the Yes button. 
 

Or 
 

1. Be sure that no wiring diagram symbol is selected (press Esc key or click on Deselect All icon in ribbon 
menu, Home tab). 

2. View the window with the module of tripping characteristics (if it is not displayed).  
3. In the tripping characteristics module window, in Tripping characteristic section, click the Add 

protection device tripping char from project to collection... icon. 
4. Confirm protective device selection from dialog by clicking the Yes button. 
5. In subsequently opened dialogue select the protective devices whose tripping characteristics you want to 

view according to its tag. To select more devices, hold down Ctrl key and click on the row. Close dialog by 
clicking on OK button. 
 

6. If "Check coordination between protective device and cable by comparing cable time-current heating 
characteristic and protective device tripping characteristic.... (Information about project… function, 
Calculation tab) is enabled, the switching characteristics of the protective component is displayed ((1) in the 
following figure) and ampere-second warming characteristics of the connected cable ((2) in the following 
figure). If this option is disabled, only the tripping characteristic of the protective component will be displayed. 

7. If necessary, adjust the colour of the curve (see Chap. 9.8). 
8. In the Releases section, set the individual parameters of the tripping release (by dragging the slider, or 

clicking on the + and - buttons). You can adjust only those parameters that the release type allows you to 
change (see Chap. 9.8). Changes in settings are automatically transferred back to the wiring diagram. 

9. Repeat this procedure until you have inserted all the required characteristics. In order to maintain 
transparency, we recommended that you do not insert a greater number of curves into one chart. 

10. A set of characteristics created by its transfer from a network project can be supplemented with 
characteristics of protective devices and cables inserted freely from the database (see Chap. 9.3). 
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9.5 Plotting of time-current heating characteristic of cable from database 
 
The tripping characteristic module allows you to select a cable from the database, completely independent of the 
currently edited network project, and plot its time-current heating characteristic. This option is also completely 
independent of the "Check coordination between protective device and cable by comparing cable time-current 
heating characteristic and protective device tripping characteristic" (Information about Project, Calculation tab). 
The only condition is that the selected cable must have a value of the heating time constant (Tau) entered. 
 

1. Click on the Add protection device tripping characteristics from 
database... icon in the Tripping char section. 

2. Select Cables from the menu below the icon. 
3. The database driver is activated. Description of the database driver 

see chap. 10.1. Select the cable whose time-current heating 
characteristic you want to plot and click the Insert button. 

4. The time-current heating characteristic is plotted. 
5. If necessary, adjust the colour and tag (see Chap. 9.8). 
6. In the Line - Cable section, set the individual parameters defining 

installation of the cable (number of parallel branches, method of installation, ambient temperature, ...). 
 

1 

2 
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(1) Time-current heating characteristic of the cable 
(2) Tripping characteristic of the circuit breaker 
(3) Property panel - setting of parameters that define method of cable installation 

 

9.6 Plotting of the motor start characteristics of motor from database 
 
The tripping characteristic module allows you to select a motor from the database, completely independent of the 
currently edited network project, and plot its start-up characteristic.  
 

1. Click on the Add protection device tripping characteristics from 
database... icon in the Tripping char section. 

2. Select Motors from the menu below the icon. 
3. The database driver is activated. Description of the database driver 

see chap. 10.1. Select the motor whose start-up characteristic you 
want to plot and click the Insert button. 

4. The start-up characteristic is plotted. Note: because the chart starts at 
10ms, the part of the characteristic below 10ms (containing the first 
current peak) is not displayed. This is a standard behavior of the 
application. Eaton's motor protection devices are designed and tested to prevent unwanted tripping by the 
first current peak. 

5. If necessary, adjust the color and tag (see Chap. 9.8). 
6. In the Motor section, set the individual parameters defining the start-up characteristic (total starting time, 

utilization factor, …). 
 

 

2 

1 

3 
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(1) Motor start-up characteristic; part of the characteristic below 10ms (containing the first current peak) is not 
displayed (this is the standard behavior of the application). 

(2) Tripping characteristic of the thermal relay. 
(3) Tripping characteristic of the fuse. 
(4) Property panel - setting of parameters that define the motor start-up. 

 

9.7 Plotting user-defined tripping characteristics 
 
The tripping characteristic module allows you to plot any curve – a user-defined tripping characteristic. The 
characteristic is defined by a set of points [current, time]. You can enter a set of points directly in the dialog box, or 
import them from an XLS/XLSX (Microsoft Excel) file. Sets of points for typical characteristics are included in the 
directory …\Demo\CurveSelectMode. This function is also useful for inserting auxiliary graphics, such as vertical 
lines indicating selectivity limit. 
 

1. In the Tripping characteristic section click on the Add tripping characteristic – user-defined 
curve ... icon. 

2. Click the Clear tables icon (remove all rows). 
3. Enter the set of points [current Ik (A), time Ttr (s)] for min curve (lower envelope) and max curve (upper 

envelope).  
 Click on the Insert row icon. 
 Type a numerical value in the Ik (A) column and press Enter. 
 Type a numerical value in the Ttr (s) column and press Enter. 
 To remove a point, Click the Delete row icon. 

4. If the characteristic consists of only one curve (line characteristic), enter a set of points only for the min curve 
(lower envelope); leave the table for the max curve (upper envelope) empty. 

5. Enter a Tag to identify the curve in the chart. 
6. Close the dialog panel by clicking the Ok button. The curve is plotted in the chart.  
7. If necessary, adjust the colour and tag (see Chap. 9.8). 
8. Editing (changing position of the points) is possible by clicking the Edit button in the User Defined Curve 

section. 
 
A set of points defining a curve is easier to create with a spreadsheet application, such as Microsoft Excel:  
 

1. In the Tripping characteristic section click on the Add tripping characteristic – user-defined 
curve ... icon. 

1 

2 

3 

4 
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2. Click the Export to Data File icon. Thus, you will obtain a template. 
3. Open the file created in the previous step using a spreadsheet application such as Microsoft Excel. Enter the 

set of points [current Ik (A), time Ttr (s)] for min curve (lower envelope) and max curve (upper envelope). All 
spreadsheet functions such as copying, formula calculations, etc. can be used. Save and close the file.  
 

Note: Files containing sets of points for typical characteristics are included in the directory 
…\Demo\CurveSelectMode. 
1.  

1. DEMO_CurveSelectMode_User-Defined-Curve_MCB-
Bchar-16A.XLS 

Modular circuit breaker, characteristic B, In=16A. 

1. DEMO_CurveSelectMode_User-Defined-Curve_MPCB-
16A.XLS 

Motor protective device, In=16A. 

1. DEMO_CurveSelectMode_User-Defined-Curve_MCCB-
ThermoMag-100A.XLS 

Compact circuit breaker, thermomagnetic release, In=100A. 

1. DEMO_CurveSelectMode_User-Defined-Curve_MCCB-
Electronic-1000A.XLS 

Compact power circuit breaker, electronic release, In=1000A. 

1. DEMO_CurveSelectMode_User-Defined-Curve_ACB-
Electronic-4000A.XLS 

Air circuit breaker, electronic release, In=4000A. 

1. DEMO_CurveSelectMode_User-Defined-Curve_FUSE-
gG-16A.XLS 

Fuse, gG characteristic, In=16A. 

 
4. Click the Import from Data File icon. In the subsequently opened dialog panel, select the file created in the 

previous step. After loading a set of points from the file into the dialog panel, you can edit the coordinates 
locally. 

5. Close the dialog panel by clicking the Ok button. The curve is plotted in the chart.  
6. If necessary, adjust the colour and tag (see Chap. 9.8). 
7. Editing (changing position of the points, new loading of a set of points) is possible by clicking the Edit button 

in the User Defined Curve section. 
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9.8 Editing the properties of an already plotted characteristic 
 

1. We assume that the window with the module of tripping characteristics is shown (see Chap. 9) and that at 
least one curve is plotted in the chart. 

2. In the tripping characteristics module window, in Tripping characteristic section, select a tag of the curve 
that you want to edit from the list, or click on the cure in chart. The selected curve is highlighted in the chart. 
 

 
 

3. Adjust the colour of the curve: click on the coloured square in the Tripping characteristic section. 
Select a suitable colour in the subsequently opened dialogue box and click on the OK button. 

4. Adjust the tag: click on the Rename... icon in the Tripping characteristic section. Enter the new tag 
in the subsequently opened dialogue box and click on the OK button. The tag identifies the curve in 
the chart (shown at the top of the chart above the curve). The tags of the devices taken from the wiring 
diagram cannot be changed. 

5. In the Releases section set the individual parameters of the tripping release (by dragging the slider, or 
clicking on the + and - buttons). The curve is automatically redrawn. You can adjust only those parameters 
that the release type allows you to change. The settings for devices taken from the wiring diagram are 
automatically transferred back to the wiring diagram (in the Full Mode operation state only). 
 

 
 

6. In the Line – Cable section, set the individual parameters defining the cable installation. 
7. In the Motor section, set the individual parameters defining the start-up. 
8. In the User Defined Curve section, edit the position of the points on the curve by clicking the Edit button. 
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Notes: 

 Options of tr switch and I2t, I4t functions (for MCCB and ACB): 
 
 

Option Meaning 
L: tr=ON 
tr = according to 
the selection 

L-curve – the overload release (thermal, overcurrent release) switched on; 
the tr value (tripping time as an X-multiple of Ir) set according to the selection. 

L: tr=OFF 
tr = infinite value 

L-curve – the overload release switched off (thermal, overcurrent release); 
the tr setting (tripping time as an X-multiple of Ir) ignored (tr = ∞), short circuit protection 
only; it is used, for example, to protect motor outlets with a thermal relay. 

L: I0.5t L-curve – the overload release (thermal, overcurrent release) switched on; 
the tr value (tripping time as an X-multiple of Ir) set according to the selection; inclination 
of the curve according to the I0.5t function (very slightly inverse time current curve). 

L: I2t L-curve – the overload release (thermal, overcurrent release) switched on; 
the tr value (tripping time as an X-multiple of Ir) set according to the selection, inclination 
of the curve according to the I2t function (inverse time current curve; used in standard 
distribution protection). 

L: I4t L-curve – the overload release (thermal, overcurrent release) switched on; 
the tr value (tripping time as an X-multiple of Ir) set according to the selection, inclination 
of the curve according to the I2t function (extremely inverse time current curve; a steep 
protective slope for coordination with fuses or for special types of loads). 

S: I2t=OFF S-curve – short-circuit release, the I2t function switched off 
S: I2t=ON S-curve – short-circuit release, the I2t function switched on (used for proper selective 

coordination between upstream circuit-breaker and downstream fuse link). 
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 Option IiArms: Arc Reduction Maintenance System; provides reduction of tripping time of circuit breaker, 
what reduces an incident energy value by ca 30%. It is used for improved personal protection in case of 
internal arcs in the switchboards. See Part I Theoretical introduction, Chapter 8 for details. 

 

                    
 

9.9 Removing an already rendered characteristic from a collection 
 

1. We assume that the window with the module of tripping characteristics is shown (see Chap. 9) and that at 
least one curve is plotted in the chart. 

2. In the tripping characteristics module window, in the Tripping characteristic section, select a tag of the 
curve that you want to remove from the list, or click on the cure in chart. The selected curve is 
highlighted in the chart. 

3. Click on the Delete... icon in the Tripping characteristic section. 
4. A confirmation dialogue box will be displayed. Click on the Yes button. The characteristic will be removed 

from the chart.  

9.10 Verifying selectivity and backup protection 
 
The aim of securing selectivity is to ensure that a fault or overload is always 
tripped only by the protective element that is the closest to the site of fault or 
overload (for more details see Part I, Chapter 6.1). 
 
Backup protection (cascading) is a solution where an upstream circuit breaker 
or a fuse provides short-circuit current limitation to such a value which the 
assigned circuit breaker is able to safely trip. If a prescribed combination of 
circuit-breakers and of the nominal currents of these circuit-breakers is used, it 
is guaranteed that it is possible to use an associated circuit breaker even in 
circuits whose short-circuit ratios exceed its breaking capacity (for more details 
see Section I, Chapter 6.2). 
 

1. We assume that the window with the module of tripping characteristics is shown (see Chapter 9). 
2. Enter the tripping characteristics of all protection devices whose selectivity you want to assess in the chart 

(see Chapter 9.3). 
3. For Ik < Ii : comparison of tripping characteristics waveforms provides sufficient information about selectivity. 

If you want to maintain selectivity between two protective devices arranged in sequence, their characteristics 
must not intersect at any point, and if the characteristic bands are given instead of a clearly indicated 
characteristic, even these bands must not intersect (see also Chapter 6). 
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4. For Ik ≥ Ii : tripping characteristics are not suitable for comparing selectivity in the area of short-circuit currents 
(above the value of instantaneous trigger Ii), selectivity tables need to be used (test results). This is the 
purpose of the function described. 

5. Click on the icon Selectivity check between the circuit-breakers in the project based on selectivity 
tables. 

6. Now it is necessary to define the pair of incoming device / outgoing device. If the function is called for the 
first time, the application asks what should be used as the default arrangement: 
 Node style - the first device is incoming, the others are outgoing: 1/2, 1/3, 1/4, .... 

 

 
 

 Chain style - the first device is incoming, the second is outgoing; the second is 
incoming, the third is outgoing, ...: 1/2, 2/3, 3/4, .... 
 

 
 
 
 
 
 

7. In the subsequently opened dialog panel, adjust the settings of the incoming device / outgoing device pairs: 
 Click on the Insert row button: 

 Select the incoming protection device. 
 Select the outgoing protection device. 
 It is only possible to select from devices whose tripping characteristics are shown in the chart. 

 Click the Remove row button to remove the incoming device / outgoing device pair. 
 Click the Edit row button to change the incoming device / outgoing device pair. 
 Use the Move row button to arrange the rows in the table. 
 Use the Clear Table button to return to the default settings ("node" style or "chain" style). 

 

8. The selectivity table information is immediately displayed in the dialog panel. Hover over the table with the 
mouse pointer to see additional and explanatory comments on the specified value. 

9. If the incoming protection device acts as a backup protection for the outgoing device, the breaking capacity 
for this combination is displayed.  
 

10. Close the dialog panel by clicking the Ok button.  
11. The table will be displayed below the chart when printed or when exported to DXF data format (for CAD 

systems) or to PDF data format. 
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9.11 Display let-through current (Ic) let-through energy (I2t) characteristics 
 
Let-through current characteristics (Ic) and let-through energy (I2t) characteristics display features of current limiting 
devices (see part I. Theoretical introduction, Chap. 5.4 for details). Let-through current characteristic (Ic) plays 
important role for example in case of low voltage switchboard assemblies. In case the peak current (Ic) in the 
switchboard does not exceed value 17kA, it is not necessary to make design verification of short circuit withstand 
strength according to clausula 10.11 of IEC/EN 61439-2. 
 

1. We assume that the window with the module of tripping characteristics is shown (see Chap. 9). 
2. Enter the tripping characteristics of all protection devices whose Ic or I2t charts you want to display (see 

Chapter 9.3). 
3. Click on icon Let-through current and Let-through energy. 
4. In subsequently opened dialogue panel click on button: 

 Click on button Yes to display let-through current (Ic) characteristic. 
 Click on button No to display let-through energy (I2t) characteristic. 

5. New window with chart will be displayed. 
 Scroll mouse wheel or click on icon Zoom In or Zoom Out or Zoom All to adjust chart size (by the 

same way as in Tripping chars window). 
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 Move with mouse cursor above chart. Current values of Ik and Ic / I2t corresponding with cross hair 
position are displayed. Values from chart can be obtained easily by this way.  

 Click on Print icon to print chart on printer. 
 Click on Export icon to export chart to PDF or DXF data file. 

6. Close window with chart by clicking on Close icon (or by clicking on cross on upper right corner of window). 
 

  
 

9.12 Printing a characteristics collection on a printer 
 

1. We assume that the window with the module of tripping characteristics is shown (see Chap. 9) and that at 
least one curve is plotted in the chart. 

2. We assume that information has been entered in the description field (title block) by using the Information 
about Project function (see Chap. 11). 

3. In the tripping characteristics module window, in Tripping chars collection section, click on the Print 
tripping chars collection icon. 

4. It there are more Tripping chars collections in the project question appears. Only current collection or all 
collections in the project can be printed. 

5. The application displays a dialogue box with a preview. 
6. To zoom in / zoom out move your mouse cursor over the preview window, press the Ctrl key, hold it down 

and turn the mouse wheel to zoom in / out. 
7. Click Select Printer and select the output device on which to print. 
8. The paper size is set to A4 and a different size for printing cannot be selected. 
9. Set the print range (everything). 
10. Close the dialogue panel by clicking OK. The collection of characteristics will be printed. Collection contains 

a chart, a list of devices in the chart with appropriate parameter settings, and an evaluation of selectivity and 
backup protection (if defined). 

 

9.13 Exporting a characteristics collection 
 

1. We assume that the window with the module of tripping characteristics is shown (see Chap. 9) and that at 
least one curve is plotted in the chart. 

2. We assume that information has been entered in the description field (title block) by using the Information 
about Project function (see Chap. 11). 
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3. In the tripping characteristics module window, in Tripping characteristics collection section, click on 
the Export tripping chars collection icon. 

4. If there are more tripping chars collections in the project, question appears. Only current collection or all 
collections in the project can be exported. 

5. In the subsequently opened dialogue box (the standard Save dialogue box, known from other applications) 
enter the directory (folder) and the name of the file to which the list will be saved. You can also set the data 
file format in the dialogue box: 

 PDF,  

 DXF general exchange format for CAD systems.  
 

6. Close the dialogue panel by clicking the Save button. The tripping characteristics collection will be exported. 
Collection contains a chart, a list of devices in the chart with appropriate parameter settings, and an 
evaluation of selectivity and backup protection (if defined).  Provided the export was executed successfully, 
the final message appears. 

7. If there are more tripping chars collections in the project and export of all collections was selected, only one 
PDF file is created (all collections are exported to one PDF file). 

8. If there are more tripping chars collections in the project and export of all collections was selected, each 
collection is exported to separate file. Selected directory (folder) is used. File name is created from specified 
file name prefix and collection name. 

 

9.14 Saving characteristics collections  
 
Tripping characteristics collections are stored together with the project in a single file (see Chap. 14.1). The wiring 
diagram of the network may or may not also be included. 
 

9.15 Demonstration examples 
 
The application includes several demonstration examples illustrating the use of the tripping characteristic module. 
To open a demonstration example: 
 
In Full Mode: 

 
1. Click the Open Demo icon (menu, File tab). 
2. In the subsequently opened dialog box, go to the Demo directory. 
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3. Select the CurveSelectMode subdirectory. 
 

 
 

4. Select the example file and click the Open button.  
 

 
 

 
In Curve Select Mode: 

 
5. Click the Open Demo icon (menu, File tab). 
6. In the subsequently open dialog panel, select the example file and click the Open button.  
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10. Component databases 
 
A database of standard components (generators, transformers, circuit breakers, fuses, switch-disconnectors, lines, 
motors, etc.) is included in the programme. When creating the wiring diagram (topology), it is possible to use the 
component parameters from these databases. The range of the products offered depends on the regional version 
of the programme. Some databases are built as an open-end system with the possibility of modifications and 
additions made by the user. The database explorer can be activated in two ways: 
 
On the Property grid: 

1. Select a component for editing of properties (see Chap. 6.1.1). 
2. Click on the line with the Type designation parameter in Property grid. 
3. Click on the button with dots on the right on the line with the parameter. 
4. The application automatically activates the database explorer corresponding to the edited component. 

 

 
 
From a separate function: 

1. Click the Database icon in the Tools section in the menu on the Home tab (or press 
shortcut key F6).  

2. A dialogue panel will open in which you select the database to be edited and click OK 
(databases are different depending on the component type): 

3. The application activates the selected database explorer. 

10.1 Database operation - product selection 
 
Products are divided into logical groups and subgroups according to their function and properties and are arranged 
into a tree structure database. Databases were created based on the available documentation (IEC, national 
standards, manufacturer data) and need not necessarily cover the needs of all users. For such cases, the 
application offers the option of user-defined database modifications (see Chap. 10.2). 
 
The principle of a product search in the database is explained in the following example: You need to find the 
device: Miniature circuit breaker, B char., 16A, 3-pole, 10kA breaking capacity. 
 
Product search using the database tree 
 

1. We assume that the network project is activated. The wiring diagram contains at least one breaker type 
component. We require assignment of a product with the specified parameters for this component. 

2. Select a component for editing of properties (see Chap. 6.1.1). Click on the line with the Type designation 
parameter in Property grid. Click on the button with dots on the right on the line with parameter. By doing 
so, you activate the circuit-breaker database explorer. 
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3. Find the desired device type in the database tree structure. Searching in the tree is identical to that in the 
tree of directories in Windows Explorer: 

 An item beginning with the “+” character is rolled up (this includes additional sub-branches, which are 
not shown). To roll down the item menu (and to view its sub-branches) double click the respective item 
(or click on the “+” character). 

 An item beginning with the “-” sign is rolled down (all its sub-branches are shown on the screen). To roll 
up the item menu double click the respective item (or click on the “-” character). 

 Click on any branch once to view more detailed information about the branch in the items on the right of 
the database tree. 

 Clicking on the Collapse all tree nodes icon will collapse all the branches of the tree (return to default). 

 Clicking on the first branch of the tree displays all products from the database.  

 The range of products offered and thus the tree structure of the database depends on the regional 
version of the application (only those products which are available in the selected region are offered). 

  

We now need to find our device - circuit-breaker (characteristic B, 16A, 3-pole, breaking capacity 6kA): 

 Double click on "Modular circuit breakers (MCB)" - the tree covered within this branch will roll down. 

 Double click on the "For residential applications (xPole)" branch 

 Double click on the "Icu=6kA (EN 60898), PLS6 range" branch 

 Double click on the "B characteristics" branch 

 Click on the "3-pole" branch - now you are already at the terminal branch of the tree; the offer of 
possible devices appears in the data table on the right of the tree. 

 Select the appropriate type (16A) from the data table on the right. 

 Using the horizontal and vertical scroll bars, you can display the hidden parts of the table. 

 You can change the size of the dialogue box and its parts by dragging the edges and the partition. 

 Point the mouse cursor on the column header in the data table - this will show clarification of the 
meaning of the abbreviation in the data table header. 

 Click again on the column header in the data table - this will sort the table by the values in the column 
(the sorting method changes with each click in a cycle: ascending / descending / unsorted). 

 Click on the Information about ... icon - this will display a dialogue box with all the product information 
contained in the database. 

 Click on the illustrative image – this opens in a new larger window.  
  

  
 

(1) Database tree structure.  
(2) Data table. 
(3) Product Information - shows all product information from the database. 
(4) Illustrative image for a selected product, click to enlarge the image. 
(5) Inserting selected product into the network project. 

   

1 2 

4 

5 

3 
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4. Double click on the selected line - by doing so you insert the device from the database into the network 
project (all items in the Property Grid will be set according to properties of the selected device). Alternatively, 
you can insert the device by means of the Insert button. 

 
Product search using filters 
 

1. Activate the database explorer. 
2. Click on the first branch of the tree with the database structure. 
3. Click Filter database ... (Ctrl+Shift+F shortcut). 
4. Set the appropriate filter in the opened dialogue box. In our example, set: 

 "B characteristics",  

 "Number of poles 3"  

 Icn=6kA,  

 In=16A. 
5. Click on the Apply button. The data table will contain only products complying with the preset filter (the 

switched-on filter indicator is displayed under the illustrative image). 
6. Close the dialogue box with the filter by clicking the Close button. 
7. Select the appropriate type from the data table on the right. 
8. Double click on the selected line, or click Insert - this will insert the device from the database to the network 

project. 
9. Click on the Remove filter icon. The data table will again include all available products. 

 
 

  
 
 
Product search by type designation 
 

1. Activate the database explorer. 
2. Click on the Find product... icon (Ctrl+F shortcut). 
3. Enter the product type designation in the subsequently opened dialogue box.  

 It is possible to enter only the beginning of the text. 

 You can use wildcards: 

 ? - Any character at a given position; 

 * - Any group of characters at a given position; 

 In our example, set: PLS6-B16 
 

4. Click the Find next button. The first product with the type designation corresponding to the specified text will 
be found. 

5. Repeatedly using the Find Next / Find Previous buttons, search for the desired product. 

2 

7 

3 

8 

9 
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6. Click on the Information about ... icon - this will display a dialogue box with all the product information 
contained in the database. 

7. If you have found the desired product, click the Insert button. 
8. Close the Find dialogue panel by clicking the Close button. 

 
 

  
 

10.2 Database modifications by the user 
 
Some databases are built as an open-end system with the possibility of modifications and additions made by the 
user. You can only edit entries in the data table. The part of the database supplied as standard together with the 
programme (the so-called parent database) cannot be edited. However, the products can be copied to the user-
defined database part (the “User-defined” branch) and here they can be modified in any way. The databases are 
independent of the currently open network project and modifications in the database will remain saved even after 
you close the application. User databases are stored outside the programme installation and will be retained even 
after update or reinstallation. The user is responsible for the correctness of user-added data and calculations 
performed on the basis of these data. 
 

1. Click the Database icon in the menu on the Home tab. 
2. Select the database to be edited in the subsequently opened dialogue box and click OK. A 

dialogue box with the database explorer is displayed. 
3. Click the Custom branch in the database structure tree. The data table will display the 

contents of the user database. Note: Eaton Product Database (breakers and switchgears) cannot be edited 
and therefore the database structure tree does not include the Custom branch.  

 
Inserting a product into the user database 
 

1. We assume that the database explorer is activated and the Custom branch is selected in the database 
structure tree. 

2. Click on the Insert row... icon. 
3. A dialogue panel in which you enter all parameters defining the product will open subsequently. Warning: if 

any parameter is not specified, or an invalid value is entered, this may result in calculation failure, or the 
results of calculations performed will be incorrect. The user is responsible for the correctness of user-added 
data and calculations performed on the basis of these data. 

4. Close the dialogue panel by clicking OK. The new product will be added to the end of the data table. 
 
Editing product attributes in the user database 
 

1. We assume that the database explorer is activated and the Custom branch is selected in the database 
structure tree. 

2 

3 

4,5 6 7 8 
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2. Select the product that you want to edit in the data table. 
3. Click on Edit selected product... . 
4. A dialogue panel in which you can edit all parameters defining the product will open subsequently. 
5. Close the dialogue panel by clicking OK. Warning: the data concerned will be changed in the database; 

however, the data in the already inserted device units used in the network project will not be edited! 
 
Removing a product from the user database 
 

1. We assume that the database explorer is activated and the Custom branch is selected in the database 
structure tree. 

2. Select the product that you want to remove in the data table. 
3. Click on the Remove row... icon. 
4. The system will ask you whether you are sure you want to delete the selected product from the database. If 

you confirm removal, it deletes the product from the database. Warning: The product is removed from the 
database, but not from a network project! 

 
Copying a product from the master database to the user database or within a user database 
 

1. We assume that the database explorer is activated. 
2. Locate the product that you want to copy in the master part of the database. 
3. Click on the Copy row to clipboard (Ctrl+C keyboard shortcut). 
4. Click the Custom branch in the database structure tree. 
5. Click on the Paste row from clipboard (Ctrl+V keyboard shortcut). 
6. The line will be inserted at the end of the data table. Thus, the inserted line can be freely edited. 
7. This method can also be used to copy data into other applications. 

 
Exporting a user database to a file 
 

1. We assume that the database explorer is activated and the Custom branch is selected in the database 
structure tree. 

2. Click on the Export... icon. 
3. In the subsequently opened dialogue box (the standard Save dialogue box, known from other 

applications), enter the directory (folder) and the name of the file to which the contents of the user database 
will be saved. You can also set the data file format in the dialogue box: 

  XLS/XLSX for Microsoft Excel and other alternative spreadsheet processors that supports this format;  

  CSV common exchange format for spreadsheet processors - semicolon-delimited text. 

4. Close the dialogue panel by clicking the Save button. The contents of the user database will be exported. 
Provided the export was executed successfully, the final message appears. 

 
Importing a user database from a file 
 

1. For preparation of data outside the xSpider application and their subsequent import into a user database, we 
recommend the following: 

 Export the user database to a file to obtain a data file template. 

 Add data to the file using an external application, e.g. in Microsoft Excel. 

 Perform the import. 
 

2. We assume that the database explorer is activated and the Custom branch is selected in the database 
structure tree. 

3. Click on the Import... icon. 
4. A dialogue box with the informative text is displayed:  

 The structure of the imported file must correspond to the structure of the database. Each database has 
a different structure (different number of columns). 

 The first line of the imported file must contain the names of data fields. 
If the imported file corresponds to the requirements, click Yes. 
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5. In the subsequently opened dialogue box (the standard Open dialogue box, known from other applications), 
enter the name of the file from which the contents of the user database are to be imported. You can also set 
data file format in the dialogue box: 

 XLS, XLSX (Microsoft Excel);  

 CSV common exchange format for spreadsheet processors - semicolon-delimited text. 

6. Close the dialogue panel by clicking Open. The contents of the file will be imported and appended to the end 
of the data table. Warning: if the data file structure does not match the database, if the file does not contain 
all the required information, or contains incorrect values, it may result in calculation failure, or the results of 
the calculations performed will be incorrect. The user is responsible for the correctness of the data and 
calculations performed on the basis of these data. 

 
Importing a user database from version 2.x 
 

1. We assume that the database explorer is activated and the Custom branch is selected in the database 
structure tree. 

2. Click on the Import user defined database from xSpider version 2.x icon. 
3. A dialogue box with the informative text is displayed: imported items are appended to the end of existing 

user database. To continue, click Yes. 
4. In the subsequently opened dialogue box (standard Search Folder dialogue box, known from other 

applications), select the folder in which you installed xSpider / Spider version 2.x. 
5. Close the dialogue panel by clicking OK. The user database will be imported. 

 
Erasing the contents of a user database 
 

1. We assume that the database explorer is activated and the Custom branch is selected in the database 
structure tree. 

2. Click on the Clear user defined database. 
3. Confirm the function by clicking the Yes button. The contents of the user database will be removed. 

 
Notes: 

 The function to export and import a user database can be used for data backup and data transfer between 
computers. 

10.3 Structure of data tables for the individual component types 
 
The following data must be defined for the individual component types: 
 
Generators 
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Transformers 
 

 
 
Cables 
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Busbar systems 
 

 
 
Motors 
 

 
 
Compensation condensers 
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11. Information about the project, title block 
 
By means of the Information about Project function, you can set the basic information about the processed 
project, which will in turn be shown in the title block (description field) attached to the drawing of the network wiring 
diagram as well as to printed lists. 
 

1. Click on Information About Project icon in the menu on the File tab. 
2. A dialogue panel will open in which you gradually enter data in the respective items.  
3. If you are asked to insert a logo, click on Open file button.  Select the name of data file with the 

logo in the displayed dialogue box. Logo files used can be in DXF format (exported from the CAD 
system, vector graphics) or raster images in JPG or BMP format. 

4. Click on the OK button. The entered information is displayed in the title block appended to the drawing of the 
network wiring diagram.  

 
Notes: 

 The function is called up automatically prior to first saving of a project to file on the hard disk, i.e. prior to first 
activation of the Save function (Chap. 14.1) and prior to every activation of the Save As function (Chap. 14.1). 

 
An example of the title block printed in the bottom right corner of the drawing with the network wiring diagram: 
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12. Printing the results on a printer 
 
The application allows you to print a wiring diagram (topology), including the results of the last calculation made, a 
report on the calculation and the lists of network components.  

12.1 Print preview 
 

1. Click the Print preview in the menu on the File tab (Ctrl+Shift+P keyboard shortcut). 
2. Specify which printer output you wish to display in the preview in the opened dialogue box:  

 Calculation report: Summary report on calculation = list of all elements in the project 
network together with their parameters and the results of the last calculation performed. 

 List of network components with their parameters: This will display a list of all 
components in the network project with their main parameters (project designation, type designation 
and the main electrical parameters defining component). 

 List of cables: This will display a table of cables in the network project with their parameters (start, end, 
length, deposition, type designation). 

 List of network components with calculation results: This will display list of all components in the 
network project with the results of the last calculation performed. 

 Network wiring diagram with calculation results: view of various methods of printing graphics. 
3. Close the dialogue panel by clicking OK. The selected document will be displayed in a separate window. 
4. Close the preview window by clicking on the X in the top right hand corner of the window, or press the Esc 

key. 

12.2 Printing a calculation report  
 

1. Click the Print in the menu on the File tab (Ctrl+P keyboard shortcut). 
2. Specify which printer output you require in the subsequently opened dialogue box. Click on the 

Calculation Report item. 
3. Close the dialogue panel by clicking OK. 
4. An information panel is shown: Before the report is generated, it is advisable to conduct a comprehensive 

check of the entire network. Only then will the results of all calculations will be included in the report. 

 If you need to perform a comprehensive check of the network now, click on the Yes button. This will be 
followed by a comprehensive check of the entire network (see Chap. 8.9). 

 If the last calculation performed was a comprehensive check of the entire network, or if you need the report 
to include only the results of the last calculation made, click No. Information is subsequently provided that 
the report will contain only the results of the last calculation performed. 

5. The application displays a dialogue box with the report preview. You can browse the report and check its 
contents.  

6. To zoom in / zoom out move your mouse cursor over the preview window, press the Ctrl key, hold it down 
and turn the mouse wheel to zoom in / out. 

7. Click Select Printer and select the output device on which to print. 
8. The paper size is set to A4 and a different size for report printing cannot be selected. 
9. Set the print range (all, or only some pages). 
10. Close the dialogue panel by clicking OK. The calculation report will be printed out. 

12.3 Printing lists on a printer 
 
The lists of components cannot be printed directly from the application. They must first be exported to XLS/XLSX 
file format for Microsoft Excel (see Chap. 13.2) and then printed using Microsoft Excel or another spreadsheet 
processor that is able to open files in the XLS/XLSX format (e.g. Open Office etc.). The lists of components are 
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primarily intended as a data source for the information system of the customer, so it is not possible to print them 
directly on a printer from the application environment.  

12.4 Printing wiring diagrams 
 

1. Click the Print in the menu on the File tab (Ctrl+P keyboard shortcut). 
2. Specify which printer output you require in the subsequently opened dialogue box. Click on the 

Network wiring diagram with calculation results item. 
3. Close the dialogue panel by clicking OK. 
4. Set the printing parameters in the subsequently opened dialogue box - like when printing graphics from 

standard CAD systems. The printing output preview is displayed in the left hand side of the dialogue box. 
The preview serves for general graphics layout as will be seen on paper; The preview cannot be zoomed in / 
out. Click Update preview to refresh the preview window. 

5. Click Select Printer and select the output device on which to print. 
6. Set the Paper format on which to print. You can choose from standard formats supported by the selected 

printer, or set a custom format by entering the dimensions. 
7. Set the Paper orientation - landscape or portrait. 
8. Set the Print area: 

 All = the entire drawing area (area filled with a network of dots - grid) – this is a regularly used setting. 

 Window = part of the workspace specified by clicking on the Window button. 
9. Set the Scale for printing: 

 Scaled to fit = the application performs automatic reduction / enlargement so that the drawing area (area 
filled with dotted network - grid) or its part (window), is all plotted on paper of the selected format. This is 
a regularly used setting. 

 You can also set your own fixed scale. 
10. Adjust Colour printing - whether to print in black and white, grayscale or colour. 
11. Click OK to close the dialogue panel for the wiring diagram print. The diagram will be drawn within the 

selected format as shown in the preview window. 
 
Notes: 

 The data to be used in the title block (description field) must be entered prior to starting the print by using the 
Information about Project function (see Chap. 11). 

12.5 Page setup 
 
This function allows you to set the dimensions of the paper, on which the network wiring diagram will be drawn. 
This setup determines the dimensions of the drawing area to be used for the network wiring diagram in the project 
window. 
 

1. Click the Page setup icon in the menu on the File tab. 
2. Set the suitable size of your drawing area in the subsequently opened dialogue box. You can 

choose from standard formats supported by the selected printer, or set a custom format by 
entering the dimensions. 

3. Close the dialogue panel by clicking OK. The drawing area dimensions will be adjusted accordingly. The 
position of components already inserted in the diagram must be then adapted by means of the Move 
function (see Chap. 6.2). 
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13. Data export 
 
The Export function lets you export the lists of data file components in a format suitable for spreadsheet 
processors and a calculation report in a data file in a format suitable for word processors. Graphics are exported in 
DXF format (universal format for CAD systems). All documents can also be exported to PDF file format. 

13.1 Export of a calculation report  
 

1. Click the Export icon in the menu on the File tab (Ctrl+E keyboard shortcut). 
2. Specify which document you need to be exported in the subsequently opened dialogue box. Click 

on the Calculation Report item. 
3. Select the output data file format (DOC for Microsoft Word or another alternate text editor that supports this 

format, or PDF). 

4. Close the dialogue panel by clicking OK. 
5. An information panel is shown: Before the report is generated, it is advisable to conduct a comprehensive 

check of the entire network. Only then will the results of all calculations will be included in the report. 

 If you need to perform a comprehensive check of the network now, click on the Yes button. This will be 
followed by a comprehensive check of the entire network (see Chap. 8.9). 

 If the last calculation carried out was a comprehensive check of the entire network, or if you need the 
report to include only the results of the last calculation made, click No. Information is subsequently 
provided that the report will contain only the results of the last calculation performed. 

6. In the subsequently opened dialogue box (the standard Save dialogue box, known from other applications), 
enter the directory (folder) and the name of the file to which the report will be saved. 

7. Close the dialogue panel by clicking the Save button. The calculation report will be exported. Provided the 
export was executed successfully, the final message appears. 

 

Note: 

 List of variables is a part of report (content of chapter 8.12). Attaching of this list can be enabled or disabled by 
Options… function, Calculation tab. 

13.2 Exporting component lists 
 

1. Click the Export icon in the menu on the File tab (Ctrl+E keyboard shortcut). 
2. Specify which list you need to be exported in the subsequently opened dialogue box. 

 List of network components with their parameters: This will export the list of all components in the 
network project with their main parameters (project designation, type designation and the main electrical 
parameters defining component). 

 List of cables: This will export the table cables in the network project with their parameters (start, end, 
length, deposition, type designation). 

 List of network components with calculation results: This will export the list of all components in the 
network project with the results of the last calculation performed. 

3. Data output file format is set to XLS/XLSX (Microsoft Excel or another alternative spreadsheet processor that 
supports this format) and cannot be changed. 

4. Close the dialogue panel by clicking OK. 
5.  In the subsequently opened dialogue box (the standard Save dialogue box, known from other applications), 

enter the directory (folder) and the name of the file to which the list will be saved. 
6. Close the dialogue panel by clicking the Save button. The selected list will be exported. Provided the export 

was executed successfully, the final message appears. 
 

Note: 

 The information about the project constitutes part of the exported file. These data must be entered prior to 
starting the export procedure using the Information about Project function (see Chap. 11). 
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13.3 Exporting a network connection diagram  
 
xSpider allows you to export graphics to DXF (universal exchangeable format for CAD systems). This also makes 
subsequent import of the network wiring diagram including the calculation results to CAD systems supporting DXF 
format (such as AutoCAD) possible. Graphic breakdown to levels, colours and line types is supported. Tags in the 
wiring diagram are exported as blocks. Basic information about the project is attached. 
 

1. Click the Export icon in the menu on the File tab (Ctrl+E keyboard shortcut). 
2. Specify that you want to export the network wiring diagram in the subsequently opened dialog box. 

Click on the Network wiring diagram with calculation results item. 
3. In the subsequently opened dialogue box (the standard Save dialogue box, known from other 

applications), enter the directory (folder) and the name of the file to which the drawing will be saved. 
4. Close the dialogue panel by clicking the Save button. The graphics will be exported to the data file. Provided 

the export was executed successfully, the final message appears. 
 

Note: 

 The data to be used in the title block (description field) must be entered prior to starting the export by using 
the Information about Project function (see Chap. 11). 
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14. Working with files 
 
A network project can be continuously saved to a data file on your hard disk in order to keep the data for future 
editing. All project information is contained in a single file whose name is specified by the user, with the standard 
extension *.SPIX. All file operations can be performed using functions from the menu on the File tab.  

14.1 Saving your project to a file on the disk 
 
The current state of the network project can be saved to a file located on your hard disk by 
means of the Save and Save As… functions from the menu on the File tab. 
 
When calling up the Save (Ctrl+S keyboard shortcut) function for the first time with no file name 
specified before, the user is required to enter the file name and directory (folder) where the file is to be saved. 
During the second and subsequent call-up of this function, all changes to the design are automatically saved to the 
data file, the name of which was entered during the first function activation. The current name of the edited file is 
shown in the top part of the main window for the application or in the top part of the project window. 
 
Every time the Save As… (Ctrl+Shft+S keyboard shortcut) function is activated, the user is required to enter the 
file name and the directory (folder) where the file is saved. In this manner it is for instance possible to save the 
current design to a file with a different name, thus copying the original design to be used for further editing. The 
current name of the edited file is shown in the top part of the main window for the application or in the top part of 
the project window. 

14.2 Loading (opening) files with projects 
 
Quick access to recently opened files is possible through 
the list below the Open icon in the menu on the File tab. 
The list expands by clicking on the arrow. The Open 
function in the menu on the File tab (activated by clicking 
on the icon or by Ctrl+O keyboard shortcut) loads the 
previously created data file with the network project. In the 
next step, the user is asked for the directory (folder) and 
the file name. The loaded file is opened in a separate 
project window and can be edited in any manner by using 
the application tools. 
 

14.2.1 Loading (opening) demo files 
 
The Open Demo function in the menu on the File tab (Ctrl+Shift+O keyboard shortcut) loads the 
selected demonstration example supplied with the application. Demos can be used as an initial point to 
solve a specific problem. Clicking on the icon will display the same dialogue box as in the Open 
function with the difference that the directory (folder) containing the demonstration examples is always 
set automatically. The loaded demo is opened in a separate project window and can be edited in any 
manner by using the application tools. We recommend that the modified example be saved under a different name 
outside the application directory structure (e.g. In the MY DOCUMENTS directory) using the Save As ... so as to 
maintain the default state of the demonstration example for future use. 
 

 
14.3 Editing a new project 
 
If you want to start editing a new project, use the New Project command from the menu on the File tab 
(Ctrl+N keyboard shortcut). The new project is opened in a separate window and can be edited in any 
manner by using the application tools. The default setting for the new project is given by the Options... 
function (see Chap. 15.1). 
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14.4 Ending the project editing operation 
 
If you want to terminate editing of your project, click on the X in the upper right corner of the project window or use 
the Close Current function from the menu on the View tab. The system first checks whether the project was 
saved. If this is not the case, it will generate a message asking you to save it. To close all open projects, use the 
Close All from the menu on the View tab. 

14.5 Ending the programme session 
 
If you would like to terminate your current session, use the Exit command from the menu on the File tab 
or close the main programme window by clicking on the X in the top right hand corner. First of all, the 
system checks whether all open projects have been saved. If this is not the case, it will generate a 
message asking you to do so. It then closes the programme. 
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15. Options 
 
Options... from the menu on the File tab lets you easily set global variables influencing the behaviour of the 
application as a whole using the dialogue box. The particular setting features defined in the function are recorded in 
the system and maintained until their next change regardless of the edited project.  

15.1 Default settings for new projects 
 

1. Click the Options... icon in the menu on the File tab. 
2. On subsequently opened dialogue box: 

 Click the Project tab. 

 Set the individual parameters that will be used as the default for a new project. Parameters 
used for currently edited project can be set by Information about project function, Information 
about project tab and Network and voltage system tab. 

 Click the Wiring diagram tab. 

 Set the individual parameters that will be used as the default for a new project. Parameters used for 
currently edited project can be set by Information about project function, Wiring diagram tab. 

3. Close the dialogue panel by clicking OK. If change was made to the component selection method, the 
application will require a restart. 

15.2 Default settings for calculation 
 

1. Click the Options... icon in the menu on the File tab. 
2. Click the Calculation tab in the subsequently opened dialogue box. Set the individual parameters that will be 

used as the default for the subsequent calculations. 

 Show the real and the imaginary components... If enabled, then after calculating voltage drops and 
load distribution, the consumption currents in the nodes and currents in the branches are displayed as 
complex numbers. In the opposite case, only the absolute values are shown. This setting also relates to 
display of impedances. 

 Show admittance matrices... When enabled, all calculations will be displayed with admittance 
matrices and other intermediate results of the calculation. In the opposite case, the intermediate results 
will not be shown. 

 Show the short-circuit current waveform... If enabled, then calculation of the 3-phase symmetrical 
short circuit in one selected node will be followed by a display of a chart with the same progress of the 
short-circuit current. In the opposite case, the chart will not be displayed. 

 Highlight unsuitable components in the diagram. When enabled, all the components that do not 
comply with any check will be highlighted in the wiring diagram, in the summary calculation report and 
the list of network components with the calculation results. In the opposite case, the unsuitable 
components will not be highlighted in any way (this setting feature is intended for experts only). 

 Attach “list of variables” to calculation report document. When enabled, content of 8.12 chapter 
“Summary of variables relating to calculations” will be a part of calculation report document. 

 Check coordination between protective device and cable by comparing cable time-current 
heating characteristic and protective device tripping characteristic. When enabled, control of 
allocation of protective devices to the cables will take into account both mandatory conditions 
prescribed by the IEC standard and evaluation will also be performed of allocation of protective 
components to the cables by comparing warming characteristics of the cable and tripping 
characteristics of the circuit breaker (recommended more precise procedure, for more details see the 
theoretical introduction in Chap. 2). In the opposite case, only terms required by the IEC standard will 
be checked. This setting will be used as the default for a new project. Setting used for currently edited 
project can be set by Information about project function, Calculation tab. 

 Model transformer as real device. When enabled, MV/LV transformer is modelled as real device – 
voltage on LV side will depend on transformer load. When disabled, MV/LV transformer is modelled as 
ideal device - voltage on LV side will be the same as network voltage. This setting will be used as the 
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default for a new project. Setting used for currently edited project can be set by Information about 
project function, Calculation tab. 

 Time of fault tripping from source (tripping time) calculation. Safety coefficient which increases 
fault loop impedance while calculation fault tripping time from power source can be set there according 
to local standards. This setting will be used as the default for a new project. Setting used for currently 
edited project can be set by Information about project function, Calculation tab. 

 Comprehensive check of the entire network includes selectivity check. When enabled 
comprehensive check of the entire network includes selectivity check (default behaviour). It is useful to 
switch-off this option if more devices cannot be found in selectivity table. 

 

3. Close the dialogue panel by clicking OK. 

15.3 System settings 
 

1. Click the Options... icon in the menu on the File tab. 
2. Click the System tab in the subsequently opened dialogue box. Set the individual parameters as required: 

 Software language version. The language version of the software application determines the 
language of communication and the language of product description in the project. The value can be 
arbitrarily changed. Modified settings require a restart.  

 Software regional version. Specifies the Eaton-offered range of products available in the selected 
region. Modified settings require a restart. 

 Operating mode. Defines the user interface: 
 Full Mode of operation - complete user interface, all program features available. 
 Curve Select Mode of operation - simplified user interface, only functions for working with tripping 

characteristics are available. 
 Changing the settings requires restarting the program. 

 Server Time Out. Time in milliseconds during which the programme waits for a response from the 
server. If the server does not respond to the call of the programme in a shorter time than the value set, 
it means that the server is unavailable and the application update is terminated. Set a higher value in 
the case of low-speed connection to the Internet, or in the case of thorough virus scans (e.g. In the 
internal networks of large companies as well as the internal Eaton network). 

 Save update LOG file. Saves a file with information about installation progress and application update 
to a user-specified directory. This can be used to solve problems with the automatic update functionality 
of the application. 

 Restore default positions of floating windows. Restores the default position of floating windows can 
be used when the window with the results of the calculation is for example hidden off the screen (useful 
e.g. when switching from dual monitor configuration or from the extended Windows desktop to a 
standard Windows desktop). 

 Restore software default settings. Restores the default settings of the application. An application 
restart is required. 

 

3. Close the dialogue panel by clicking OK. 

15.4 Changing the licence data 
 

1. Click the Options... icon in the menu on the File tab. 
2. Click the Licence tab in the subsequently opened dialogue box.  

 Enter the new licence data. The option to enter the new licence data (user identification, licence 
number and expiration date) using the same dialogue box as when you first start the program. 

 View the licence agreement. Displays the text of the licence agreement for the use of the application. 
 

3. Close the dialogue panel by clicking OK. 
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15.5 Automatic dimensioning - Custom Preferences Setting 
 

1. In the menu on the File tab, click the Options... icon. 
2. Click the Automatic Dimensioning tab in the subsequently opened dialogue box.  
3. Click the Automatic dimensioning parameter settings (user preference settings) button. In the dialog 

box that follows, set the preferred standard (set of regulations and standards defining the product line), the 
mechanical design, the scope of use and other parameters for cables, protective and switching devices that 
will be automatically dimensioned. 

 

4. Close the dialogue panel by clicking OK. 
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16. Help 
 
The Help Topics function (F1 shortcut) starts the Adobe Reader application with an electronic version of this 
manual in PDF format. If you do not have Adobe Reader installed on your computer yet, you can find its setup on 
the installation CD or you can download it from the Internet at www.adobe.com. 
 

 
 

  
 
Self-education videos are released continually on xSpider web site www.eaton.eu/xspider. 
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17. About 
 
The About xSpider... function from the menu on the File tab displays information about the application - xSpider 
System. The function can be used to ascertain licence information.  
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1. xSpider – case studies 
 
The examples below demonstrate the basic principles of working with xSpider. It is presumed that the application 
has been successfully installed by the user and is fully operational. Basic knowledge of operations with applications 
running under Windows (working with the mouse, operations with files etc.) as well as fundamental orientation in 
the issues concerning low-voltage network dimensioning is also presumed. The instructions refer to the relevant 
chapters from the xSpider User’s Manual, part II – program operation, where you can find a more detailed 
explanation. 

1.1 Wiring diagram – creation and editing 
 
In this case, we will show how a new network wiring diagram (network topology) is created and how the basic tools 
for working with graphics are used. At the end, perform a quick check on the created network. The entire 
assignment is resolved in the DEMO-Network.SPI file. You will need approximately 2.0 hours to complete the 
task. 
 
Assignment: design an industrial building power supply in xSpider. Draw the network topology and check the 
components used for suitability.  
 

 
 
 
Parameters of the particular components are specified as follows: 
 
NET1  medium-voltage supply network 22 kV, Sk’’=500MVA 
TR1  SGB oil transformer, 22/0.4 kV, Sr=250kVA, Pk=4.1kW, uk=4% 
W1  line between the transformer and the main distribution board for the technology 

Cable Cu 3x240mm2 + 1x120mm2, 1 parallel branch, installed in air (E) 
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FA1  Main protection 
400A circuit breaker, Eaton brand circuit breaker, Icu=50kA, NZM series, selective with electronic 
release 

Tech1 Technology 1 supply, Pn=40 kW, cosPhi =0,9, 100% utilisation (Ku=1) 
W2 Feed line to technology 1 

Cu 4x25mm2, 50m cable, 1 parallel branch, installed on wall (C) 
FA2 Technology 1 protection 

80A protection, Eaton brand circuit breaker, Icu=25kA, NZM series, circuit protection with 
thermomagnetic release 

Tech2 Technology 2 supply, Pn=80 kW, cosPhi =0,9, 100% utilisation (Ku=1) 
W3 Feed line to technology 2 

Cu 3x70mm2 + 50mm2, 120m cable, 1 parallel branch, installed on wall (C) 
FA3 Technology 2 protection 

160A protection, Eaton brand circuit breaker, Icu=25kA, NZM series, circuit protection with 
thermomagnetic release, overload release set to 85 % (Ir=136A) 

M1 Power supply for the pumping station technology, motor Pn=30 kW, 100% utilisation (Ku=1) 
W4 Feed line to the pumping station 

cable Cu 4x16mm2, 30m, 1 parallel branch, installed in ground (D) 
FA4 Protection for the pumping station technology  

63A protection, Eaton brand circuit breaker, Icu=25kA, NZM series, for motor protection, with 
thermomagnetic release, overload release set to 90 % (Ir=56A) 

 
 
Programme launch and initialisation of a new project 
 

1. Launch the xSpider application (see Chap. 3.1, 3.2).  
2. A new project with default settings is activated automatically at startup.  
3. Set the drawing area - A4 format (see Chap. 12.5). The A4 format is probably set already since it 

is the most frequent case and this format is set as default for new projects as standard. Let’s take a look at 
the setup procedure; this step may be skipped if an identical case is repeated: 

 Click the Page setup icon in the menu on the File tab. 

 Select A4 format from the group of standard formats in the subsequently opened dialogue panel. 

 Close the dialogue panel by clicking OK. The drawing area appearance will be adjusted according to 
the selected format. 

 

4. Set the network type and the voltage system (see Chap. 5.1). In our example, this is the TN 230/400V 
network. This network will probably already be set as this is most frequently solved case and this type is 
usually set as the default for the new projects. Let’s take a look at the setup procedure; this step may be 
skipped if an identical case is repeated: 

 Click on Information About Project icon in the menu on the File tab. 

 Click on the Network and voltage system tab. 

 Set the TN Network Type (by selecting from the options offered) and the 230/400V voltage system (by 
selecting from the offered options). 

 Close the dialogue panel by clicking OK. The selected network type will appear above the title block. 
 

5. Save the newly created project in a data file (see Chap. 14.1). 

 Click the Save... icon in the menu on the File tab. 

 A dialogue box will open in which you enter the information about your project (see Chap. 11). The 
entered data will be written in the title block (description field) and will be used for project identification. 
Fill in the particular items e.g. as follows: 
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 Close the dialogue panel by clicking OK. 

 In the subsequently opened dialogue box (the standard Save dialogue box, known from other 
applications) enter the directory (folder) and the name of the file to which the list will be saved (e.g. 
Documents directory, file name Example0.SPIX). Your screen should look as follows: 

 

 
 
 

Drawing network topology  
 

1. First of all, insert the supply group (supply network, transformer, main protection). 

 In the Tool Box on the left of the screen, click on the Favourites tab (includes a selection of frequently 
used groups and components).  

 If the Tool Box is not visible, then click the View Tool Box in the menu on the View tab. 

 Scroll to the group Power supply from medium-voltage supply network, transformer connected 
with a cable. Move the mouse cursor over the image, the group name appears next to the mouse 
cursor. 

 Note the image: the group includes all the necessary components. The violet cross shows the position 
of the insertion point of the group. 
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 Click on the image of the group. 

 Move the mouse cursor into the graphics area of the window with the project (dotted network area). 
Now drag the shape of the group. 

 Click the left mouse button to determine the position of the group insertion point in the graphics area of 
the project window (in the middle of the upper part of the drawing area - point B1). The group will be 
drawn. 

 

    
 

2. In the previous step, you only inserted the tags; now you must add the electrical parameters of the individual 
components according to the assignment specified in the beginning. 

 Click the Network component (see Chap. 5.2), with the NET1 tag. The selected item will be highlighted 
by grips (blue squares around the tag). 

 On the Property Grid, type values according to the assignment (nominal voltage of the network - 
22000V in this case - and short-circuit power for a 3-phase short circuit - 500MVA in this case).  

 If the Property Grid is not visible, then click the View Property Grid in the menu on the View tab. 

 At the bottom of the Property Grid the application displays comments / instructions for the user 
regarding the property (parameter) currently being edited. 

 

  
  

 Click the Transformer component (see Chap. 5.4) with the TR1 tag.  

 You are required to enter a standard transformer manufactured by SGB, therefore you can use the 
database of components supplied with the programme. 

B1 
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 Click on the line with the Type designation parameter in the Property Grid. 

 Click on the button with dots on the right on the line with parameter in the Property Grid. 

 The database explorer is activated, in this case the transformer database (see Chap. 10.1).  

 Expand branches (click on the + sign or double click on the branch): 

  "SGB Transformers"; 

  "Oil SGB Transformers"; 

 "22 kV". 

 Click on the "22/0.4kV" branch.   

 In the data table, select the type "DOT 250/20 (10) (22/0.4kV)", Sr=250 kVA and click Insert. 

 All the parameters of the transformer will be submitted.  
 Search for the Rated current parameter in the Property Grid at the bottom. Below is the transformer 

rated current In=361A. Remember this value – you will need it when dimensioning the cable and 
entering the circuit-breaker settings. 

  

  
  

 Click the Cable component (see Chap. 5.7) with the W1 tag. 

 In the Property Grid, enter the cable length (5 meters in this case), the number of parallel branches 
(1 in this case) and a maximum voltage drop on this line (5% in this case). Should the voltage drop 
exceed this value, the item will be marked as an error component. 

 In the Property Grid, click on the line with the Define installation parameter. 

 In the Property Grid, click on the button with dots on the right on the line with parameter. In the 
subsequently opened dialogue box, select the installation method "(E) Multi-core cables in free air". 

 In the Property Grid, set the number of additional circuits in the grouping (0 = cable conducted 
separately), ambient temperature (30 °C in this case), the user coefficient will not be used (value 1).  

 You are required to enter a standard Cu cable, therefore you can use the database of components 
supplied with the programme. 

 In the Property Grid, click on the line with the Type designation parameter. 

 In the Property Grid, click on the button with dots on the right on the line with parameter. The 
database explorer is activated, in this case the cable database (see Chap. 10.1). Expand branches 
(click on the + sign or double click on the branch): 

 "Copper conductors (Cu)"; 
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 "Common types (noname)...";  

 "Multicore cables (PVC insulation)...";  

 Click on the branch "4 wires (L1 L2 L3 PEN)". 

 Select the "3x240mm2+1PENx120mm2_PVC/CU" type from the data table (as seen from the other 
columns in the data table, the cross-section of the phase conductor is 240 mm2, the cross-section 
of the PEN conductor is 120mm2, the rated current with installation in air (E, F) is 430 A). 

 Click on the Insert button. 

 All the parameters of the line will be entered.  

 Note: a cable with this cross-section must be used to connect the transformer, although the 
consumption of the currently connected loads will be lower (only 247 A). Components on the 
transformer line must be dimensioned according to the transformer’s nominal current (In=361A) for the 
event of the switchgear being expanded in the future and the transformer being used at full power. 

  

 Click the Circuit-breaker component (see Chap. 5.10) with the FA1 tag. 

 In the Property Grid, set the connected phases: 3-phases (L1,L2,L3); 5s as the maximum tripping 
time (see Chap. 3.7); "On" operation state; dimension for "Ics (Service short-circuit breaking 
capacity)". 

 We want to insert a standard Eaton NZM-series, selective circuit-breaker with electronic release, so 
we will use the component database supplied with the software. 

 Note: We recommend that you use selective circuit-breakers with electronic release to protect the 
transformer due to the simple manner of securing selectivity with the outgoing circuit-breakers of the 
particular outlets. If there is a fault at an outlet, only the circuit-breaker closest to the fault point will trip, 
while the rest of the installation remains in operation. For more details, see Part I, Chap. 6.1 and Part 
II, Chap. 8.5. 

 In the Property Grid, click on the line with the Type designation parameter. 

 In the Property Grid, click on the button with dots on the right on the line with parameter. The 
database explorer is activated, in this case the circuit-breaker database (see Chap. 10.1). Expand the 
following branches: 

 "Moulded case circuit-breakers (MCCB) up to 1600 A"; 

 "Circuit breakers NZM 1,2,3,4 (up to 1600 A)"; 

 "Circuits + generators protection, selective (-VE)"; 

 "Rated current In=Iu=250…630A (NZM3 type)";  

 Click on the "Icu=50kA (415V)" branch.  

 In the data table, select the "NZMN3-VE400" type and click Insert. 

 All circuit-breaker parameters will be entered.  

 In the Property Grid in the section Releases, adjust the thermal release setting Ir to 90% (Ir=360A). 
This is necessary in order to ensure overload protection of the transformer (transformer Sr=250kVA, 
nominal current In=361A). 
  

 Click the Network node component (see Chap. 5.5), project tag NODE1. 

 Change the tag offered to RTH1 in the Property Grid.  

 The voltage in the network node and the connection phases are set automatically. 

 Set the maximum voltage drop at the network node at 5% - if the voltage drop exceeds this value due 
to the power supply voltage, the component will be marked defective. 

 Set the coefficient of simultaneity to 1 - assume that all connected loads will be operated at full power 
output. 

 

3. Use Zoom Window to enlarge the upper half of the drawing area. The texts will be more legible:  

 Click on Zoom Window on the View tab (see Chap. 7.4). 

 Click in the left half of the drawing area with the mouse pointer. Drag a rectangle 
defining the area to be zoomed in. The rectangle must cover the whole image drawn. 
Click the upper right corner of the window. The area will enlarge. 
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 If you failed to perform this operation correctly, you can return to the previous image 
by means of the Zoom Previous function (see Chap. 7.5) or - in case of several 
unsuccessful attempts in a row - you can use the Zoom All function to view the drawing 
area in full (see Chap. 7.6). 

 The Zoom function can also be operated using the mouse wheel:  

 The mouse wheel is rotated to zoom in / out. 

 Moving the mouse while holding the wheel shifts the view. 
 

4. Insert the branch representing the power-supply of technology 1:  

 In the Tool Box, click the Favourites tab (includes a selection of frequently used groups and 
components; other groups of outlets can be found on the Outlet Groups tab) 

 Scroll to the group "General outlet with circuit-breaker (CB)" and click on the image. 

 Left-click the position of the insertion point at the network node group (blue horizontal line near the left 
edge - point B1 in the following figure). The group is drawn. 

 If you fail to make a correct insertion, the group is not connected to the network node. Use Undo (in 
the menu on the Home tab, Ctrl + Z keyboard shortcut) and repeat the process. 

  

  
  

  

5. Adjust the display to make it easy to see the whole drawn diagram: 

 Rotate the mouse wheel to set the appropriate magnification. 

 Press the scroll wheel on your mouse, hold it down and move the mouse pointer to set the appropriate 
view.  

 Alternatively, you can use the functions that are found in the menu on the View tab: Zoom in (see 
Chap. 7.3), or Zoom out (see Chap. 7.3), or Pan (see Chap. 7.2).  

  

6. Enter the electrical parameters of the branch components: 

 Click on the element of the Circuit-breaker component, FA2 tag.  

 In the Property Grid, using the procedure you are already familiar with: set the disconnection 
maximum duration of 5s from the database Eaton circuit breaker type "NZMB1-A80".  

 If you know the exact type designation of the product, you can use the Find function in the dialogue 
box with the database explorer, specify the type designation, locate and insert the product. 

 Click on the element of the Cable component, W2 tag.  

 Enter the cable length - 50m in this case; maximum voltage drop on the line of 5%. 

 Set the installation method "(C) Single-core or multi-core cables on a wall"; the number of 
additional circuits in the group 0, ambient temperature of 30°C, user coefficient 1.  

B1 
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 Select the "4x25mm2_PVC/CU" cable type from the database using the procedure you are already 
familiar with. 

 Click the Load component (see Chap. 5.16) with the LOAD1 tag. Enter the values in the Property 
Grid according to the assignment: 

 "Tech1" tag.  

 The load is defined by the nominal power (40kW), power factor (0.9).  

 We assume that the load will operate continuously at 100% - utilisation factor Ku=1.  

 The maximum voltage drop on the load device with regard to the power supply voltage of 10%. 
Should the voltage drop exceed this value, the item will be marked as an error component. 

  
7. Since the branch representing the power supply for technology 2 has very similar parameters, you can copy 

the branch created previously. 

 Click the Copy icon in the menu on the Home tab (see Chap. 6.3). 

 Select the components of the copied branch. Use the crossing type selection window:  

 Click with your left mouse button in the image so that the selection window is on the right near the 
FA2 circuit breaker. It must not however interfere with the text (point B1 in the image below).  

 If you move the mouse to the left from the clicked point, the selection window is dragged crosswise 
(all objects lying within the window and all objects partially reaching into the window will be 
selected). 

 Click on the opposite corner of the selection box to the left of the load mark Tech1 (point B2 in the 
following figure). The selected components will be highlighted. 

 If you accidentally select another component, press the Shift key, hold it down and click on the 
accidentally selected component. You can also interrupt the function by pressing the Esc key and 
repeat the procedure.  

 If all the components are selected, right click your mouse button to exit selection mode. 

 Click the first point of the shift vector (the point behind which you are going to “carry” the copied 
objects) - the upper end of the FA2 circuit breaker (point B3 in the figure below). 

 Click the second point of the shift vector (where the objects are to be copied) - to the network node to 
the left of the end of the circuit breaker FA1, but not directly beneath it (point B4 in the figure below). 

 Click the right mouse button to exit copying mode. 

 If you fail to make a correct insertion, the group is not connected to the network node. Use Undo (in 
the menu on the Home tab, Ctrl+Z keyboard shortcut) and repeat the process. 
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8. Adjust the electrical parameters of the copied branch (note that the tags were automatically adjusted during 
copying in order to avoid any duplicities): 

 Click on the element of the Circuit-breaker component, FA3 tag. Select the Eaton circuit breaker of 
"NZMB2-A160" type from the database in the manner you are already familiar with from above. Set the 
"Overload release" in the Releases section at 85% (Ir=136A). 

 Click on the element of the Cable component, W3 tag. Adjust the cable length to 120 meters. Select the 
"3x70mm2+1PENx50mm2_PVC/CU" type cable from the database in the manner you are already 
familiar with from above. 

 Click on the element of the Load component, Tech2 tag. Adjust the nominal power input to 80kW. 
  

9. Insert the motor branch representing the pumping station technology. 

 Click on the Favourites tab in the Tool Box.  

 Scroll to the group "Motor outlet with circuit-breaker (CB)" and click on the image. 

 Left-click the position of the insertion point at the network node group (blue horizontal line near the right 
edge - point B1 in the following figure). The group is drawn. 

 If you fail to make a correct insertion, the group is not connected to the network node or it is too close to 
the already inserted components, use the Undo (in the menu on the Home tab, Ctrl + Z keyboard 
shortcut) and repeat the process. 

  

10. Adjust the electrical parameters of the newly inserted branch: 

 Click on the element of the Circuit-breaker component, FA4 tag. Select the Eaton circuit breaker for 
motor protection of "NZMB1-M63" type from the database in the manner you are already familiar with 
from above. Set the "Overload release" in the Releases section at 90% (Ir =56.7A). 

 Click on the element of the Cable component, W4 tag. Enter the cable length - 30 meters in this case. 
Set the installation method "(D2) Single-core or multi-core cables directly in the ground without added 
protection against mechanical damage"; the number of additional circuits in the group 0, ambient 
temperature of 20 °C, user coefficient 1. Connected phases: 3-phase connection, the maximum voltage 
drop in the line is 5%. Select the " 4x16mm2_PVC/CU" type cable from the database in the manner you 
are already familiar with from above. 

 Click the Motor component (see Chap. 5.15) with the M1 tag. Select the standard motor from the 
database in the manner you are already familiar with from above. Utilisation factor Ku=1; we presume 
that the motor will be permanently running at full power. 

  

B1 

B2 

B3 B4 

Before editing: After editing: 
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11. Save the changes you have made in the data file - click the Save icon in the menu on the File tab (Ctrl+S 
keyboard shortcut). 

 

 
 
 

Performing check calculations 
 

1. Prior to commencing the calculations, it is advisable to 
check the connection logic (whether all network 
components are interconnected and whether the rules 
for building wiring diagrams are complied with). 

 Click the arrow next to the Calculation icon in the 
menu on the Home tab (see Chap. 8.1). 

 Select the Check network connection logic 
from the drop down list. 

 The connection logic is checked; in the event of 
an error, an error message appears in the Error list. In such a case, the best thing you can do is delete 
the bad part (the Erase function, see Chap. 6.5) and insert the components again by repeating the 
respective part of these instructions. If everything is OK, the information dialogue is displayed and the 
error list remains empty. 

 

2. Now carry out a complex check on the entire network. This check includes: 

 calculation of voltage drops and load distribution together with the subsequent check on the network 
dimensioning for the rated state and overload protection of cables, 

 calculation of the 3-phase symmetric short circuit in all network nodes one by one, together with the 
subsequent check on short-circuit protection (whether the network components withstand the maximum 
short-circuit current), 

 calculation of the 1-phase asymmetric short circuit in all network nodes one by one, together with the 
subsequent check on the disconnection time of the fault point from the power source (whether the 
protective devices respond sufficiently to the minimum short-circuit current), 

  

 Click the arrow next to the Calculation icon in the menu on the Home tab (see Chap. 8.9). 

 Select the developed Comprehensive check on the entire network.... from the drop down list. 

 Before the short-circuit computations are carried out, you will be asked about the definition of backup 
protection (cascades), i.e. about determination of the incoming protective component at the incomer and 
of the outgoing components at the outgoer (see Chap. 8.4). Since there is only a single node in our 
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example and this is a radial network, cascades will be set automatically. Close the dialogue box by 
pressing Esc key or clicking on the Continue icon. 

 It can be seen that all checks are compliant, the error list remains empty. 

 The calculation results are shown next to the components in the connection diagram. 
 

3. If you want to view and print the results of a particular calculation, you must perform every single calculation 
separately (see Chap. 8.2, 8.3) and then print the wiring scheme with the calculation results (see Chap. 
12.4), or the table - the list of network components with the calculation results (see Chap. 13.2).  
 

4. Adjust the width of the text box to avoid overlapping. 

 Click on the Circuit-breaker component, with FA3 tag (point B1). 

 Click on the grip in the top right hand corner of the text box (point B2). 

 Stretch the text box width and click (point B3). 

 Click on the grip in the top left hand corner of the text box (point B4). 

 Move the text box to the top and click (section B5). 

 Unselect the component by pressing Esc. 
 

   
 

5. Save the changes made to the data file - click the Save icon in the menu on the Home tab. 
 

6. Generate a comprehensive report on the calculation in a PDF file: 

 Click the Export icon in the menu on the File tab (see Chap. 13.1). 

 Select the document for export in the subsequently opened dialogue box: Click on the 
"Project Calculation Report" and for output file format, click on "PDF" file. 

 The application displays information about the need for a comprehensive check on the 
entire network before generating the calculation report with an offer to run this check. Since the last 
executed calculation was a comprehensive check on the entire network, click No. Close the following 
dialogue box by clicking the OK button. 

 In the subsequently opened dialogue box, enter the directory (folder) and the name of the file to which 
the document is to be exported. 

 The document will be exported. To open a file in PDF format, use the appropriate software application, 
such as Adobe Reader. 

 
7. Export the wiring diagram with calculation results to a file in PDF format: 

 In the menu on the File tab, click the Export icon (see Chap. 13.3). 

 Select the document for export in the subsequently opened dialogue box: Click on the "Network wiring 
diagram with calculation results" item and the output file format: click on the "PDF" file. 

 In the subsequently opened dialogue box, enter the directory (folder) and the name of the file to which 
the document is to be exported. 

 The application displays a dialogue box where you can set the output paper size and scale. In this 
simple example, you can keep the default values. Close the dialogue panel by clicking OK.  

 The document will be exported. To open a file in PDF format, use the appropriate software application, 
such as Adobe Reader. 

B2 B3 

B1 

B4 

B5 
Before editing: After editing: 
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8. The example is completed. Close the xSpider application by clicking on the X in the upper right corner of the 
programme window. 
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